Federal Emergency Management Information System (FEMIS)

Installation Guide

for

FEMIS Version 1.4.7

May 26, 2000

Prepared for the U.S. Department of Energy under Contract DE-AC06-76RL01830
Acknowledgment

The FEMIS product is being developed by the Pacific Northwest National Laboratory as part of the U.S. Army's Chemical Stockpile Emergency Preparedness Program (CSEPP).

This software and its documentation were produced with Government support under Contract Number DE-AC06-76RL01830 awarded by the United States Department of Energy. The Government retains a paid-up non-exclusive, irrevocable worldwide license to reproduce, prepare derivative works, perform publicly and display publicly by or for the Government, including the right to distribute to other Government contractors.

Disclaimer

This material was prepared as an account of work sponsored by an agency of the United States Government. Neither the United States Government nor the United States Department of Energy, nor Battelle Memorial Institute, nor any of their employees, MAKES ANY WARRANTY, EXPRESSED OR IMPLIED, OR ASSUMES ANY LEGAL LIABILITY OR RESPONSIBILITY FOR THE ACCURACY, COMPLETENESS, OR USEFULNESS OF ANY INFORMATION, APPARATUS, PRODUCT, SOFTWARE, OR PROCESS DISCLOSED, OR REPRESENTS THAT ITS USE WOULD NOT INFRINGE PRIVATELY OWNED RIGHTS.

References to any specific commercial product, process or service by trade name, trademark, manufacturer, or otherwise does not necessarily constitute or imply endorsement, recommendation, or favoring by the U.S. Army or Battelle.

The software has not been reviewed for export out of the U.S. A license or license exception may be required for export.
Federal Emergency Management Information System (FEMIS)

Installation Guide

for

FEMIS v1.4.7

JA Arp
BJ Anderson
RA Burnett
RJ Carter
TR Downing
JR Dunkle
PM Fangman
PP Gackle
BJ Homer

NA Holter
DM Johnson
RL Johnson
SM Johnson
RM Loveall
AJ Stephan
WD Millard
BM Wood

May 26, 2000

Prepared for
the U.S. Department of Energy
under Contract DE-AC06-76RLO 1830

Pacific Northwest National Laboratory
Richland, Washington 99352
Preface

The Federal Emergency Management System (FEMIS) is an emergency management planning and response tool. The following documents were developed to support system users. The audience for each is identified.

The **FEMIS Installation Guide** provides instructions for installing and configuring the FEMIS software package.

This **FEMIS Data Management Guide** provides the information needed to manage the data used to support the administrative, user-environment, database management, and operational capabilities of FEMIS.

The **FEMIS System Administration Guide** provides information on FEMIS system administrator activities as well as the utilities that are included with FEMIS.

The **FEMIS Release Notes** provide a description of what is new in the release, a list of known problems and workaround suggestions, and any information specific to this release that was not available when other documents were published.

The **FEMIS Bill of Materials** defines FEMIS hardware, software, and communication requirements.

The **FEMIS Online Help System** explains how to use the FEMIS program, which is designed to help civilian emergency management personnel to plan and respond to a Chemical Accident or Incident (CAI) Event at a military chemical stockpile.
Contents

1.0 Overview .......................................................................................................................... 1-1
1.1 Point of Contact ................................................................................................................ 1-1
1.2 Document Organization .................................................................................................... 1-1
1.3 Software Products ............................................................................................................ 1-2
1.4 Installation ...................................................................................................................... 1-2
  1.4.1 Environment ............................................................................................................ 1-2
  1.4.2 Storage Requirements ............................................................................................ 1-3
     1.4.2.1 FEMIS Server ............................................................................................ 1-3
     1.4.2.2 FEMIS PC ............................................................................................... 1-4
  1.4.3 Pre-Installation Issues ............................................................................................ 1-4
1.5 FEMIS Directory Structures ............................................................................................ 1-4

2.0 FEMIS UNIX Installation .................................................................................................. 2-1
2.1 Installing and Configuring the UNIX COTS .................................................................... 2-2
  2.1.1 Installing the Operating System ............................................................................ 2-2
     2.1.1.1 Installing or Upgrading Solaris 7 ................................................................ 2-4
     2.1.1.2 Automounting and FEMIS ...................................................................... 2-8
     2.1.1.3 Creating Users and Groups .................................................................... 2-10
  2.1.2 Upgrading Sun Volume Manager Software ............................................................ 2-13
  2.1.3 Installing and Configuring Samba ........................................................................... 2-15
     2.1.3.1 Installing Samba ................................................................................... 2-16
     2.1.3.2 Configuring Samba ............................................................................... 2-17
  2.1.4 Installing the NFS Authentication Services Daemon ............................................ 2-19
     2.1.4.1 Determining Version of NFS Daemon .................................................. 2-19
     2.1.4.2 Removing Previous NFS Daemon ......................................................... 2-19
     2.1.4.3 Installing Hummingbird NFS Daemon .................................................. 2-19
     2.1.4.4 Installing Sun PC NFS Daemon ............................................................ 2-20
  2.1.5 Installing an E-mail Package .................................................................................... 2-21
  2.1.6 Installing Perl v5.004-04 ......................................................................................... 2-22
     2.1.6.1 Removing the Perl Package .................................................................. 2-22
     2.1.6.2 Installing the Perl Package .................................................................... 2-22
  2.2 Installing the FEMIS UNIX Software ......................................................................... 2-23
     2.2.1 Creating UNIX Accounts on the Server ......................................................... 2-23
     2.2.2 Upgrading the FEMIS Application .................................................................... 2-25
     2.2.3 Installing the FEMIS Package ........................................................................ 2-27
     2.2.4 Installing Network Time Protocol (NTP) ...................................................... 2-29
  2.3 Installing the FEMIS GIS and Database .................................................................... 2-31
     2.3.1 Installing the GIS and Oracle Database ....................................................... 2-31
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.3.2</td>
<td>Database Cleanup Tasks</td>
<td>2-32</td>
</tr>
<tr>
<td>2.3.2.1</td>
<td>Dropping Database Objects and Exporting Data Owners</td>
<td>2-32</td>
</tr>
<tr>
<td>2.3.2.2</td>
<td>Removing Current Oracle Installation</td>
<td>2-33</td>
</tr>
<tr>
<td>2.3.3</td>
<td>Installing Oracle Software or Relinking Oracle</td>
<td>2-34</td>
</tr>
<tr>
<td>2.3.3.1</td>
<td>Creating the UNIX Environment for Oracle</td>
<td>2-35</td>
</tr>
<tr>
<td>2.3.3.2</td>
<td>Installing the Oracle Software</td>
<td>2-39</td>
</tr>
<tr>
<td>2.3.3.3</td>
<td>Installing and Using Oracle Documentation</td>
<td>2-49</td>
</tr>
<tr>
<td>2.3.3.4</td>
<td>Relinking the Oracle Software</td>
<td>2-50</td>
</tr>
<tr>
<td>2.3.3.5</td>
<td>Configuring Existing Oracle for Latest Version of FEMIS</td>
<td>2-51</td>
</tr>
<tr>
<td>2.3.3.6</td>
<td>Modifying the Initialization Parameter</td>
<td>2-52</td>
</tr>
<tr>
<td>2.3.4</td>
<td>Defining the Database Topology</td>
<td>2-53</td>
</tr>
<tr>
<td>2.3.4.1</td>
<td>Running the Build Topology Program</td>
<td>2-54</td>
</tr>
<tr>
<td>2.3.4.2</td>
<td>Setting Up the EOC DBA Directory (as femis)</td>
<td>2-55</td>
</tr>
<tr>
<td>2.3.5</td>
<td>Creating or Updating the FEMIS Database</td>
<td>2-56</td>
</tr>
<tr>
<td>2.3.5.1</td>
<td>Creating the Database Schemas</td>
<td>2-56</td>
</tr>
<tr>
<td>2.3.5.2</td>
<td>Loading Data (as femis)</td>
<td>2-57</td>
</tr>
<tr>
<td>2.3.5.3</td>
<td>Upgrading Database from Previous Versions of FEMIS</td>
<td>2-58</td>
</tr>
<tr>
<td>2.3.5.4</td>
<td>Creating Objects that Share Data (as femis)</td>
<td>2-58</td>
</tr>
<tr>
<td>2.3.5.5</td>
<td>Creating FEMIS Schema Synonyms</td>
<td>2-59</td>
</tr>
<tr>
<td>2.3.5.6</td>
<td>Fixing the EOC Table (as femis)</td>
<td>2-59</td>
</tr>
<tr>
<td>2.3.5.7</td>
<td>Setting Up Oracle Backups</td>
<td>2-60</td>
</tr>
<tr>
<td>2.3.5.8</td>
<td>Starting Replication (as femis)</td>
<td>2-60</td>
</tr>
<tr>
<td>2.3.6</td>
<td>Configuring the FEMIS Files (as root)</td>
<td>2-61</td>
</tr>
<tr>
<td>2.3.7</td>
<td>Copying the files to the /home/femis/user directory</td>
<td>2-62</td>
</tr>
<tr>
<td>2.3.8</td>
<td>Correcting Group Ownership</td>
<td>2-62</td>
</tr>
<tr>
<td>2.3.9</td>
<td>Verifying the Configuration Files (as femis)</td>
<td>2-63</td>
</tr>
<tr>
<td>2.3.10</td>
<td>Setting Up the Command Server Configuration File</td>
<td>2-65</td>
</tr>
<tr>
<td>2.3.11</td>
<td>Setting Up femis_event</td>
<td>2-66</td>
</tr>
<tr>
<td>2.4</td>
<td>Checking the FEMIS Startup</td>
<td>2-67</td>
</tr>
<tr>
<td>2.4.1</td>
<td>Rebooting the Server (as root)</td>
<td>2-67</td>
</tr>
<tr>
<td>2.4.2</td>
<td>Verifying the FEMIS Programs (as femis)</td>
<td>2-67</td>
</tr>
<tr>
<td>2.5</td>
<td>Utility to Add FEMIS Login Account to the Database</td>
<td>2-68</td>
</tr>
<tr>
<td>2.6</td>
<td>FEMIS AutoRecovery System Description and Installation</td>
<td>2-69</td>
</tr>
<tr>
<td>2.6.1</td>
<td>Messaging Service</td>
<td>2-70</td>
</tr>
<tr>
<td>2.6.2</td>
<td>Logging</td>
<td>2-70</td>
</tr>
<tr>
<td>2.6.3</td>
<td>Sending E-mail</td>
<td>2-71</td>
</tr>
<tr>
<td>2.6.4</td>
<td>Running Processes</td>
<td>2-71</td>
</tr>
<tr>
<td>2.6.5</td>
<td>Monitoring Swap and Disk Space</td>
<td>2-72</td>
</tr>
<tr>
<td>2.6.6</td>
<td>Remote Hot Auto-Carve and Auto Insert</td>
<td>2-72</td>
</tr>
<tr>
<td>2.6.7</td>
<td>Remote Process Monitoring</td>
<td>2-73</td>
</tr>
<tr>
<td>2.6.8</td>
<td>AutoRecovery’s WatchDog Timeout Parameter</td>
<td>2-74</td>
</tr>
<tr>
<td>2.6.9</td>
<td>Installing AutoRecovery</td>
<td>2-74</td>
</tr>
<tr>
<td>2.6.10</td>
<td>Configuring AutoRecovery</td>
<td>2-75</td>
</tr>
<tr>
<td>2.7</td>
<td>AutoRecovery Web Reporting Application</td>
<td>2-76</td>
</tr>
<tr>
<td>2.7.1</td>
<td>Software Requirements</td>
<td>2-76</td>
</tr>
</tbody>
</table>
2.7.2 AutoRecovery Web Reporting ................................................................. 2-77
  2.7.2.1 Removing the AutoRecovery Web Reporting Package ................. 2-77
  2.7.2.2 Installing AutoRecovery Web Reporting ........................................ 2-77
2.7.3 Configuring AutoRecovery Web Reporting ............................................. 2-78
2.7.4 Customizing AutoRecovery Web Reporting ............................................. 2-79
  2.7.4.1 Setting the $retainFlag Variable ............................................... 2-79
  2.7.4.2 Changing the Refresh Rate ....................................................... 2-80
  2.7.4.3 Accurate System Time ............................................................... 2-80
  2.7.4.4 Customizing the Apache Web Server .......................................... 2-80

3.0 FEMIS GIS Migration and Configuration .................................................. 3-1
3.1 Migrating the FEMIS GIS from v1.4.6 to v1.4.7 ......................................... 3-1
  3.1.1 Upgrading the femisgis.ini Files to v1.4.7 ........................................ 3-2
  3.1.2 Checking the Upgraded v1.4.7 femisgis.ini Files ............................. 3-3
  3.1.3 Upgrading the Zone Theme ............................................................ 3-3
  3.1.4 Upgrading the General Hazard Zone Theme ..................................... 3-4
  3.1.5 Troubleshooting the Migration .......................................................... 3-5
    3.1.5.1 Checking the v1.4.6 femisgis.ini File ....................................... 3-5
    3.1.5.2 Checking the Zone Theme Upgrade .......................................... 3-7
    3.1.5.3 Checking the General Hazard Zone Theme Upgrade .................... 3-8
    3.1.5.4 Editing the FEMIS.INI File for the GIS Upgrade ......................... 3-9
3.2 Copying v1.4.7 GIS Files to the Other Servers ........................................ 3-10
3.3 Completing the Installation on This PC ................................................... 3-11

4.0 FEMIS PC Installation ................................................................................. 4-1
4.1 Installing the PC COTS .............................................................................. 4-1
  4.1.1 Installing Windows NT v4.0 ......................................................... 4-1
    4.1.1.1 Before Installing Windows NT .................................................. 4-1
    4.1.1.2 Running the Installation Program ............................................ 4-3
    4.1.1.3 Installing Windows NT Service Pack 5 .................................... 4-7
  4.1.2 Installing an NFS System ................................................................. 4-7
    4.1.2.1 Identifying the Maestro Version .............................................. 4-8
    4.1.2.2 Uninstalling NFS Maestro v6.0.1 (or earlier) ............................ 4-8
    4.1.2.3 Installing NFS Maestro v6.2 ................................................... 4-8
    4.1.2.4 Installing NFS Maestro v6.2.0.2 Patch .................................. 4-10
    4.1.2.5 Running the Parmset Configuration Program ............................ 4-11
    4.1.2.6 Installing Solstice NFS Client v3.2 ....................................... 4-11
    4.1.2.7 Configuring Solstice NFS Client v3.2 .................................. 4-12
  4.1.3 Installing Oracle Net8 Client v8.1.5 and ODBC v8.1.5.5 .................... 4-13
    4.1.3.1 Uninstalling Oracle SQL*Net Client v2.3.4 and Oracle7 ODBC Driver ................................................................. 4-13
    4.1.3.2 Installing Oracle Net8 Client v8.1.5 ......................................... 4-14
    4.1.3.3 Installing Oracle ODBC Driver v8.1.5.5 ................................. 4-15
  4.1.4 Installing ArcView GIS v3.1 and v3.1.1 Patch .................................. 4-16
    4.1.4.1 Installing ArcView GIS v3.1 .................................................. 4-16
4.1.4.2 Installing ArcView GIS v3.1.1 Patch ............................................... 4-17
4.1.4.3 Creating the ArcView GIS Icon for All Users................................. 4-18
4.1.5 Installing Microsoft Project 98 Service Release 1 ............................... 4-18
4.1.6 Installing Other COTS  ........................................................................ 4-19
4.2 Configuring the FEMIS Setup Program ................................................... 4-20
  4.2.1 Connecting the Network Install Drive .................................................. 4-20
  4.2.2 Validating \CONFIGD\FSETUP.INI File .................................................... 4-21
  4.2.3 Validating the GIS.INI Files on the Server—Maryland Only.................... 4-22
  4.2.4 Validating \CONFIGD\TNSNAMES.ORA File ......................................... 4-22
  4.2.5 Validating \CONFIGD\ADDODBC.BAT File ............................................. 4-23
  4.2.6 Validating the AUTOEXNT.BAT File .................................................... 4-23
  4.2.7 Validating \CONFIGD\NTP.BAT File ....................................................... 4-23
  4.2.8 Validating \USER Directory ................................................................. 4-24
  4.2.9 Configuring the \PC\FEMTOOLS\FEMIS.DB File ................................. 4-24
  4.2.10 Updating Files on All PCs Using FUPDATE.BAT ................................ 4-26
  4.2.11 Updating the PC HOSTS Files ............................................................. 4-26
4.3 Installing FEMIS Client Software ............................................................... 4-27
  4.3.1 Preparation ......................................................................................... 4-27
  4.3.2 Running the Setup Program ............................................................... 4-28
  4.3.3 Updating the FEMISGIS.INI File ......................................................... 4-29
  4.3.4 Regenerating the FEMIS GIS Dynamic Themes ................................... 4-30
4.4 Configuring the PC ................................................................................... 4-30
  4.4.1 Setting Up FEMIS User Accounts on Windows NT and UNIX ............. 4-30
    4.4.1.1 Adding User Accounts to Windows NT ........................................... 4-31
    4.4.1.2 Adding User Accounts to UNIX .................................................... 4-32
  4.4.2 Running the FEMIS Startup Files ....................................................... 4-32
  4.4.3 Verifying the Temporary Directory and Environment Variables ........... 4-33
  4.4.4 Verifying the Clock Settings and Time Zone Settings ......................... 4-33
  4.4.5 Verifying the Time Synchronization Services ...................................... 4-33
    4.4.5.1 Verifying the AUTOEXNT.BAT File .............................................. 4-34
    4.4.5.2 Verify the AutoExNT Service ....................................................... 4-34
  4.4.6 Verifying the Virtual Memory Setting ............................................... 4-34
  4.4.7 Creating the FEMIS Icon ................................................................... 4-35
  4.4.8 Final Steps for the FEMIS PC Installation and Configuration ............... 4-35
4.5 Configuring FEMIS for All PCs at an EOC ............................................. 4-35
  4.5.1 Verifying the Zone Name Lookup for EMIS PAR .................................. 4-36
  4.5.2 Using FZONES.EXE Tool ................................................................. 4-36
4.6 Validating the FEMIS PC Installation ........................................................ 4-36
  4.6.1 One Time at EACH EOC ................................................................. 4-37
    4.6.1.1 Verify Default D2PC Case Exists ................................................. 4-37
    4.6.1.2 Verify the Evacuation Command Server ....................................... 4-37
    4.6.1.3 Verify FEMIS/EMIS Data Exchange Interface (DEI) ....................... 4-37
    4.6.1.4 Create a Plan for Validation Testing ............................................. 4-38
    4.6.1.5 Test the GIS on the Printer ........................................................... 4-39
4.6.1.6 Verify E-mail ......................................................... 4-40
4.6.1.7 Verify the SEPR Icon Addressee ......................... 4-40

4.6.2 Cleanup AFTER Validation ...................................... 4-40
4.6.2.1 Delete Validation Datasets ................................. 4-40
4.6.2.2 Ensure Exercise #1 Exists ................................. 4-40
4.6.2.3 Remove Extraneous FEMIS UNIX User Accounts ... 4-40

4.6.3 Perform on EVERY PC .............................................. 4-40
4.6.3.1 Ensure FEMIS Login Security ............................ 4-41
4.6.3.2 Verify the PC Configuration .............................. 4-41
4.6.3.3 Verify the PC Clock ............................................ 4-41
4.6.3.4 Verify the Network Time Protocol (NTP) Service ... 4-41
4.6.3.5 Verify Login ...................................................... 4-42
4.6.3.6 Verify Data Manager .......................................... 4-42
4.6.3.7 Verify the System Administration Utility ............. 4-43
4.6.3.8 Verify D2PC ....................................................... 4-43
4.6.3.9 Verify Notification Server ................................. 4-43
4.6.3.10 Verify GIS ...................................................... 4-43
4.6.3.11 Verify Evacuation ............................................ 4-43
4.6.3.12 Verify Electronic Planning (Planning Mode) ...... 4-44
4.6.3.13 Verify Help ..................................................... 4-44
4.6.3.14 Verify Printer .................................................. 4-44
4.6.3.15 Verify E-mail ................................................... 4-44
4.6.3.16 Verify SEPR Icon ........................................... 4-44
4.6.3.17 Verify FEMIS Tools ......................................... 4-44

5.0 Remote Evacuee Registration and Point to Point Protocol ........................................ 5-1
5.1 Remote Evacuee Registration ...................................... 5-1
5.2 Installing Remote Evacuee Registration ...................... 5-1
5.3 Setting Up Dial-Up Networking for Windows NT .......... 5-2
  5.3.1 Verifying Modem Installation ............................... 5-2
  5.3.2 Configuring Dial-Up Networking ......................... 5-2
  5.3.3 Connecting Via Dial-Up ...................................... 5-3
5.4 Verifying Remote Evacuee Registration ....................... 5-4

6.0 Stand-Alone Installation of FEMIS v1.4.7 ......................................................... 6-1
6.1 Stand-Alone PC System Requirements ........................ 6-1
6.2 Location of Oracle .................................................... 6-1
6.3 Stand-Alone PC Installation Process ......................... 6-1
  6.3.1 Removing Existing Stand-Alone Database .............. 6-2
  6.3.2 Installing PC COTS and FEMIS v1.4.7 .................... 6-2
  6.3.3 Installing Oracle8i Server or Personal Oracle8i ....... 6-2
  6.3.4 Configuring Oracle Network Components ............... 6-3
  6.3.5 Building the Database ....................................... 6-4
  6.3.6 Creating Stand-Alone Working Directory .......... 6-6
  6.3.7 Creating FEMIS Database Tablespaces ................. 6-6
6.4 Importing or Changing FEMIS Data ................................................................. 6-7
  6.4.1 Removing Database Data Owners ................................................................. 6-7
  6.4.2 Obtaining FEMIS Database Export ............................................................. 6-8
  6.4.3 Importing FEMIS Data into the Database ................................................. 6-9
6.5 Configuring FEMIS Installation for Stand-Alone Database ....................... 6-10
  6.5.1 Creating a Local USER Share ................................................................... 6-10
  6.5.2 Editing SETSTANDALONE.BAT ............................................................. 6-10
  6.5.3 Running SETSTANDALONE.BAT and SETNETWORKED.BAT .............. 6-10
  6.5.4 Correcting D2PC DOS Environment ......................................................... 6-11
  6.5.5 Testing the Setup ................................................................................ 6-12
6.6 Remote Access Service ................................................................................. 6-12
6.7 Verifying the Stand-Alone Installation ............................................................ 6-13
## Acronyms and Definitions

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANAD</td>
<td>Name of a FEMIS database (Anniston Depot)</td>
</tr>
<tr>
<td>APR</td>
<td>Project file format (ArcView GIS)</td>
</tr>
<tr>
<td>BOM</td>
<td>Bill of Materials</td>
</tr>
<tr>
<td>COTS</td>
<td>Commercial-Off-The-Shelf</td>
</tr>
<tr>
<td>CSEPP</td>
<td>Chemical Stockpile Emergency Preparedness Program</td>
</tr>
<tr>
<td>CTOO</td>
<td>Name of a FEMIS database (Tooele County)</td>
</tr>
<tr>
<td>D2PC</td>
<td>Chemical wind dispersion model used in FEMIS</td>
</tr>
<tr>
<td>DAI</td>
<td>Data Acknowledgment Interface</td>
</tr>
<tr>
<td>DBMS</td>
<td>database management system</td>
</tr>
<tr>
<td>DEI</td>
<td>Data Exchange Interface</td>
</tr>
<tr>
<td>DNS</td>
<td>Domain Name Services</td>
</tr>
<tr>
<td>E-mail</td>
<td>electronic mail</td>
</tr>
<tr>
<td>EMIS</td>
<td>Emergency Management Information System</td>
</tr>
<tr>
<td>EOC</td>
<td>Emergency Operations Center</td>
</tr>
<tr>
<td>ESIM</td>
<td>Evacuation SIMulation, part of Oak Ridge Evacuation Modeling System (OREMS)</td>
</tr>
<tr>
<td>ESRI</td>
<td>Environmental Systems Research Institute, Inc.</td>
</tr>
<tr>
<td>FEMIS</td>
<td>Federal Emergency Management Information System</td>
</tr>
<tr>
<td>GB</td>
<td>gigabyte–billion bytes</td>
</tr>
<tr>
<td>GID</td>
<td>Group Identification number</td>
</tr>
<tr>
<td>GIS</td>
<td>geographic information system</td>
</tr>
<tr>
<td>GMT</td>
<td>Greenwich Mean Time</td>
</tr>
<tr>
<td>HCL</td>
<td>Hardware Compatibility List</td>
</tr>
<tr>
<td>ICG</td>
<td>Oracle7 Installation &amp; Configuration Guide Release 7.3.3</td>
</tr>
<tr>
<td>IBS</td>
<td>Integrated Baseline System</td>
</tr>
<tr>
<td>IDYNEV</td>
<td>Interactive DYNamic EVacuation</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>KB</td>
<td>kilobyte–thousand bytes</td>
</tr>
<tr>
<td>LAN</td>
<td>local area network</td>
</tr>
<tr>
<td>MB</td>
<td>megabyte–million bytes</td>
</tr>
<tr>
<td>Met</td>
<td>meteorological</td>
</tr>
<tr>
<td>NFS</td>
<td>Network File System</td>
</tr>
<tr>
<td>NTP</td>
<td>Network Time Protocol</td>
</tr>
<tr>
<td>ODBC</td>
<td>Open Data Base Connectivity</td>
</tr>
<tr>
<td>OREMS</td>
<td>Oak Ridge Evacuation Modeling System</td>
</tr>
<tr>
<td>PC</td>
<td>personal computer</td>
</tr>
<tr>
<td>PPP</td>
<td>Point to Point Protocol</td>
</tr>
<tr>
<td>PNNL</td>
<td>Pacific Northwest National Laboratory</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RDBMS</td>
<td>relational database management system</td>
</tr>
<tr>
<td>SBCCOM</td>
<td>U.S. Army Soldier and Biological Chemical Command</td>
</tr>
<tr>
<td>SMTP</td>
<td>Simple Mail Transfer Protocol</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>SQL</td>
<td>Structured Query Language</td>
</tr>
<tr>
<td>SQL script</td>
<td>Sequence of SQL statements that perform database operations</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>TEAD</td>
<td>Name of a FEMIS database (Army Depot) and Tooele Army Depot</td>
</tr>
<tr>
<td>TNS</td>
<td>Transparent Network Substrate</td>
</tr>
<tr>
<td>UID</td>
<td>User Identification number</td>
</tr>
<tr>
<td>UNIX</td>
<td>Generic name for the Server Operating System</td>
</tr>
<tr>
<td>UTST</td>
<td>Name of a FEMIS database (Utah State)</td>
</tr>
<tr>
<td>WAN</td>
<td>wide area network</td>
</tr>
<tr>
<td>WINS</td>
<td>Windows Internet Name Service</td>
</tr>
<tr>
<td>Windows NT</td>
<td>Microsoft Network Operating System for Workstations</td>
</tr>
</tbody>
</table>
1.0 Overview

The Federal Emergency Management Information System (FEMIS©)(a) is an emergency management planning and response tool that was developed by the Pacific Northwest National Laboratory(b) (PNNL) under the direction of the U.S. Army Soldier and Biological Chemical Command (SBCCOM). The FEMIS Installation Guide provides instructions for installing the FEMIS software package as well as the Commercial-Off-The-Shelf (COTS) software applications that are necessary for FEMIS to operate.

1.1 Point of Contact

We encourage you to contact us with suggestions or to ask questions. You can contact us by mail, telephone, fax, or E-mail:

Ranata L. Johnson
Pacific Northwest National Laboratory
P.O. Box 999, MS K7-28
Richland, WA  99352
Telephone:  (509) 375-6311
Fax Number:  (509) 375-3641
E-Mail address:  ranata.johnson@pnl.gov

1.2 Document Organization

This document is organized into three sections and two appendices, which include details on the installation and configuration of FEMIS.

Section 1.0 – Overview – describes the point of contact, acknowledgment, document organization, software products, installation environment and storage requirements, and FEMIS directory structures.

Section 2.0 – FEMIS UNIX Installation – describes installing the UNIX operating system, the UNIX-based COTS software, installing the FEMIS UNIX software, and creating the FEMIS database.

Section 3.0 – FEMIS GIS Migration and Configuration – discusses the installation and configuration for upgrading the FEMIS GIS from v1.4.5 to v1.4.6.

Section 4.0 – FEMIS PC Installation – discusses the installation, configuration, and validation of the FEMIS application on client PCs.

(a) FEMIS software was copyrighted in 1995 by Battelle Memorial Institute.
(b) Pacific Northwest National Laboratory is operated for the U.S. Department of Energy by Battelle Memorial Institute under Contract DE-AC06-76RLO 1830.
Section 5.0 – Remote Evacuee Registration and Point-to-Point Protocol – discusses the Remote Evacuee Registration feature and establishing and setting up the Point-to Point (PPP)

Section 6.0 – Stand-Alone Installation of FEMIS v1.4.6 – discusses the installation configuration, and validation of the FEMIS Stand-Alone application.

1.3 Software Products

FEMIS integrates the following COTS software products.

<table>
<thead>
<tr>
<th>Software Application</th>
<th>Software Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArcView GIS</td>
<td>Environmental Systems Research Institute, Inc. (ESRI)</td>
</tr>
<tr>
<td>NFS Maestro</td>
<td>Hummingbird Communications Ltd.</td>
</tr>
<tr>
<td>Solstice NFS Client</td>
<td>Sun Microsystems, Inc.</td>
</tr>
<tr>
<td>Microsoft Windows NT Workstation</td>
<td>Microsoft Corporation</td>
</tr>
<tr>
<td>Microsoft Project for Windows</td>
<td>Microsoft Corporation</td>
</tr>
<tr>
<td>Oracle</td>
<td>Oracle Corporation</td>
</tr>
<tr>
<td>SQL*Net, TCP/IP Adapter, and ODBC Driver</td>
<td>Oracle Corporation</td>
</tr>
<tr>
<td>Solaris</td>
<td>Sun Microsystems, Inc.</td>
</tr>
</tbody>
</table>

FEMIS integrates the following government-furnished software products.

<table>
<thead>
<tr>
<th>Software Application</th>
<th>Software Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>D2PC (February 2000)</td>
<td>U.S. Army Soldier and Biological Chemical Command (SBCCOM)</td>
</tr>
<tr>
<td>PARDOS v3.1 (May 1997)</td>
<td>U.S. Army SBCCOM</td>
</tr>
<tr>
<td>Evacuation SIMulation Model (ESIM v2.1f13)</td>
<td>Oak Ridge National Laboratory</td>
</tr>
</tbody>
</table>

The following software products are optional.

<table>
<thead>
<tr>
<th>Software Application</th>
<th>Software Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARC/INFO</td>
<td>Environmental Systems Research Institute, Inc.</td>
</tr>
<tr>
<td>Corel WordPerfect</td>
<td>Corel Corporation</td>
</tr>
<tr>
<td>Microsoft Office</td>
<td>Microsoft Corporation</td>
</tr>
</tbody>
</table>

1.4 Installation

This section discusses the FEMIS environment and storage requirements.

1.4.1 Environment

For FEMIS to operate correctly, the first step is to install all of the COTS software, including Oracle v8.1.6 on your UNIX system. FEMIS will not operate correctly if versions of the COTS software other than those specified in the FEMIS Bill of Material (BOM) are installed.
FEMIS uses SAMBA, NFS Maestro (a Hummingbird Communications Ltd. product), or Solstice NFS Client (a Sun Microsystems product) as its Network File System for PC network communications. The NFS Maestro client, Solstice NFS Client, and SAMBA have been tested by PNNL and are compatible with FEMIS requirements.

Although other vendors may claim to offer a fully standard NFS, or Service Message Block (SMB) emulation, PNNL has not verified and tested any other NFS/SMB configurations for PCs, and thus, cannot endorse such installations.

### 1.4.2 Storage Requirements

The FEMIS application requires disk space on both the client and server machines. PNNL has estimated the disk space requirements for each.

#### 1.4.2.1 FEMIS Server

Disk space on the FEMIS server is used for:

- Server software (such as, the RDBMS [relational database management system] and the evacuation model).

- FEMIS application.

- FEMIS server utilities (notification, database monitor, replication).

- EOC databases (including archived and historic data).

- Storage of the FEMIS COTS software and the original GIS maps.

The above items can require 15+GB of storage to properly support FEMIS.

There are two sources of disk space associated with a FEMIS server as defined by the *FEMIS Bill of Materials (BOM)*:

1. System disk(s) resident in the Sun Server.

2. Sun SPARCstorage Array connected to the Sun Server.

As stated in the *FEMIS Bill of Materials (BOM)*, PNNL recommends that the FEMIS storage requirement be fulfilled by using arrayed storage disks (StorEdge Array, or an array-like cage system) to ensure that speed and reliability are provided to the FEMIS operational system. PNNL expects the FEMIS application to be placed in its entirety on the arrayed storage disks, which will enable the System Administrators (and PNNL) to better manage the FEMIS product and the EOC databases. PNNL expects the Sun SPARCstorage Array to be reserved solely for FEMIS use.
The system disks are not directly used by FEMIS. The disks are used for the operating system and the supporting applications. PNNL estimates that approximately 2GB of system disk space will be used for the operating system and swap space. Additional system disk space should be used at the System Administrator’s discretion.

1.4.2.2 FEMIS PC

Disk space on the client PC is required for the following:

- COTS software needed for FEMIS (Windows NT, ArcView GIS, Microsoft Project, Oracle Net8, and other supporting applications).
- FEMIS application.
- Site specific GIS maps.

The amount of space required by the FEMIS application and supporting software will vary depending on the size of the GIS the user chooses to install. A FEMIS with a medium size GIS installation requires approximately 900MB of disk space, COTS included.

1.4.3 Pre-installation Issues

Before you proceed with the installation of FEMIS v1.4.7, the following are pre-installation issues that should be addressed.

- Remove obsolete data such as unneeded exercises and obsolete user accounts.
- Make sure your system has been backed up.
- Remove obsolete D2PC archive cases.
- Clean up any obsolete server data such as obsolete versions FEMIS packages.
- If a general hazard zone theme has not already been added, the general hazard zone must be added in v1.4.6, prior to the installation of FEMIS COTS and FEMIS in v1.4.7. Existing General Hazard functionality is supported in FEMIS v1.4.7; however, the scripts to add a general hazard zone theme are not supported in v1.4.7. If you will be adding the County Zone layer, see the v1.4.6 FEMIS Installation Guide, Section 5.0, Adding General Hazard Zones to the FEMIS Database.

1.5 FEMIS Directory Structures

The following figures illustrate the FEMIS directory structure on the UNIX server and the directory structure for an emergency management PC workstation.
UNIX Server FEMIS Directory Structure

```
/home/femis

gis configd data database etc install bin man pc lib user log
<site>
<site>_apr
viewmark
d2-emis evac dba eocdba exports proc schema upd
V1.4.6_V1.4.7
backup_template dotfiles femis_template
configd etc
inet init.d oracle_template
man1 man5 femmain femmisc femtools setup system watcheye xntp
user
<site>
viewmark
gis
<site>
viewmark
evlog
<site>
gis
viewmark
```
Emergency Management Workstation

- C:
  - MSOFFICE
  - ORANT
  - NETWORK
  - ADMIN
    - SQLNET.ORA
    - TNSNAMES.ORA
  - GIS
    - FEMPTY.APR will be installed on C:\FEMIS\GIS
  - NT_USERS
  - PATCHES
  - TOOLS
    - FMONPC.EXE
    - FWATCH.EXE
    - WS_WATCH.EXE
  - USER
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV
  - FEMIS
    - FEMIS Executable Files
    - FEMIS Help Files
    - PFEMIS.MDB
    - REMEVA.MDB
    - PNNLRAS.DLL
    - DIALDLL.INI
    - D2PC.BAT
    - PARDOS.BAT
    - FEMIS.INI
    - FEMISDB.INI
    - FEMISUSR.INI
    - FEMISVER.INI
    - FEMISWIN.INI
    - ODBC.INI
    - NTP_CONF
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - SYSTEM 32
    - System DLLs
    - System OCXs
    - AUTOEXEC.BAT
    - AUTOEXEC.EXE
    - FNOTIFSV.EXE
  - SCRIPTS
    - FSTARTUP.EXE
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV
  - FEMIS
    - FEMIS Executable Files
    - FEMIS Help Files
    - PFEMIS.MDB
    - REMEVA.MDB
    - PNNLRAS.DLL
    - DIALDLL.INI
    - D2PC.BAT
    - PARDOS.BAT
    - FEMIS.INI
    - FEMISDB.INI
    - FEMISUSR.INI
    - FEMISVER.INI
    - FEMISWIN.INI
    - ODBC.INI
    - NTP_CONF
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV
  - FEMIS
    - FEMIS Executable Files
    - FEMIS Help Files
    - PFEMIS.MDB
    - REMEVA.MDB
    - PNNLRAS.DLL
    - DIALDLL.INI
    - D2PC.BAT
    - PARDOS.BAT
    - FEMIS.INI
    - FEMISDB.INI
    - FEMISUSR.INI
    - FEMISVER.INI
    - FEMISWIN.INI
    - ODBC.INI
    - NTP_CONF
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV
  - FEMIS
    - FEMIS Executable Files
    - FEMIS Help Files
    - PFEMIS.MDB
    - REMEVA.MDB
    - PNNLRAS.DLL
    - DIALDLL.INI
    - D2PC.BAT
    - PARDOS.BAT
    - FEMIS.INI
    - FEMISDB.INI
    - FEMISUSR.INI
    - FEMISVER.INI
    - FEMISWIN.INI
    - ODBC.INI
    - NTP_CONF
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV
  - FEMIS
    - FEMIS Executable Files
    - FEMIS Help Files
    - PFEMIS.MDB
    - REMEVA.MDB
    - PNNLRAS.DLL
    - DIALDLL.INI
    - D2PC.BAT
    - PARDOS.BAT
    - FEMIS.INI
    - FEMISDB.INI
    - FEMISUSR.INI
    - FEMISVER.INI
    - FEMISWIN.INI
    - ODBC.INI
    - NTP_CONF
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV
  - FEMIS
    - FEMIS Executable Files
    - FEMIS Help Files
    - PFEMIS.MDB
    - REMEVA.MDB
    - PNNLRAS.DLL
    - DIALDLL.INI
    - D2PC.BAT
    - PARDOS.BAT
    - FEMIS.INI
    - FEMISDB.INI
    - FEMISUSR.INI
    - FEMISVER.INI
    - FEMISWIN.INI
    - ODBC.INI
    - NTP_CONF
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV
  - FEMIS
    - FEMIS Executable Files
    - FEMIS Help Files
    - PFEMIS.MDB
    - REMEVA.MDB
    - PNNLRAS.DLL
    - DIALDLL.INI
    - D2PC.BAT
    - PARDOS.BAT
    - FEMIS.INI
    - FEMISDB.INI
    - FEMISUSR.INI
    - FEMISVER.INI
    - FEMISWIN.INI
    - ODBC.INI
    - NTP_CONF
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV
  - FEMIS
    - FEMIS Executable Files
    - FEMIS Help Files
    - PFEMIS.MDB
    - REMEVA.MDB
    - PNNLRAS.DLL
    - DIALDLL.INI
    - D2PC.BAT
    - PARDOS.BAT
    - FEMIS.INI
    - FEMISDB.INI
    - FEMISUSR.INI
    - FEMISVER.INI
    - FEMISWIN.INI
    - ODBC.INI
    - NTP_CONF
  - PATCHES
    - D2PC.BAT
    - PARDOS.BAT
  - WINNT
    - SYSTEM 32
      - REPLY
      - IMPORT
      - ETC
      - HOSTS
  - WINPROJ
    - GLOBAL.MPT
    - GLOBAL.SAV

FEMISGIS.APR will be installed on C:\FEMIS\GIS

FEMISGIS.APR
FEMISGIS.INI
and multiple theme directories and files can be installed on a different drive and/or directory.
2.0 FEMIS UNIX Installation

The UNIX server is the primary data and information storage and distribution component. Its primary software elements consist of the Oracle database management system (DBMS); the Evacuation SIMulation (ESIM) model with supporting processes; the Notification Service; the command server; the meteorology (Met) data receiver; the FEMIS/EMIS Data Exchange Interface (DEI); and the sockets communications service.

The programs discussed require the UNIX environment on a Sun computer running Solaris 7(a) and utilizing standard Berkeley or Berkley-like Sockets.

The FEMIS UNIX software installation consists of six major parts:

- Installing the UNIX Commercial-Off-The-Shelf (COTS)
- Installing the FEMIS UNIX Software
- Installing the FEMIS GIS and Database
- Checking the FEMIS Startup
- Utility to Add FEMIS User Account to the Database
- FEMIS AutoRecovery System.

The release media consists of files distributed on CDs, 8mm cartridge tapes, and on occasion, floppy disks. The release material contains the necessary scripts and data to perform an initial installation or to upgrade existing FEMIS software to the current version. The Release Notes should be read before proceeding with the UNIX installation.

The FEMIS package consists of the following:

- COTS CD
- FEMIS application tape
- Suite of FEMIS documentation.

In addition to the FEMIS package, the Sun Solaris 7 (SunOs 5.7) and Oracle media are necessary to complete the UNIX installation of FEMIS.

This guide is written assuming that your EOC is using local host network files. If your EOC is using some other facility, i.e., NIS/NIS+, then those facility-specific commands must be used.

---

(a) Per Sun’s Release Notes (5/99), Solaris has changed the name of their latest release to Solaris 7 (SunOs 5.7) instead of Solaris 2.7. The FEMIS Bill of Materials (BOM), released on March 3, 2000, listed Solaris v2.7 as required server software. For more information, see Sun’s web site – http://docs.sun.com:80/ab2/coll.385.1/@Ab2CollView?Ab2Lang=C&Ab2Enc=iso-8859-1
2.1 Installing and Configuring the UNIX COTS

It is important to coordinate the UNIX group numbers between FEMIS and other software applications that are administered with NIS+. Possible conflicts may result in the FEMIS /etc/group file. To see which group numbers are currently used for NIS+, use the following command while logged in as root:

```
niscat group.org_dir
```

If you are installing from a pre-existing NT account, then the corresponding UNIX account must be a member of the UNIX femisrun group on the server. Also, when using the NIS/NIS+ dB, be sure the /etc/nsswitch.conf file is properly configured to consult files as well as NIS. FEMIS may still have portions that expect entries in the host files. Primarily, these are FEMIS specific entries in the /etc/passwd file and its components (shadow). The /etc/group file is not specifically consulted, but any group membership changes done for the current install user need to be done according to how the nsswitch.conf is configured.

The following sections describe the installation of the UNIX COTS.

2.1.1 Installing the Operating System

STOP

Those sites using the Sun Volume Manager or Disksuite software to manage disk arrays, that wish to maintain array configuration and data throughout the Operating System (OS) upgrade, may need to follow special instructions PRIOR to upgrading Solaris.

For upgrading the Volume Manager Software to the current VERITAS Volume Manager, specific instructions have been provided in Section 2.1.2, Upgrading Sun Volume Manager Software.

For Sun Disksuite, consult your vendor supplied documentation prior to the OS upgrade.

For installation or upgrade instructions, see the documentation provided with the operating system. Additional installation information is available on the FEMIS Web site at http://www.pnl.gov/femis under the Technical and User Support section.

Follow the instructions included with the Solaris 7 documentation. Section 2.1.1.1, Installing or Upgrading Solaris 7, provides additional information regarding the Solaris 7 installation process. If the quantity of server customizations is considered large, the upgrade option is recommended. If server clean up is preferred, then the new install option can be taken instead of upgrading an existing installation.

Note: Installing operating system patches will require relinking the Oracle software. See Section 2.3.3.4, Relinking the Oracle Software.
Solaris Versions, Maintenance Updates, and Patch Clusters

FEMIS was tested on a Solaris 7 5/99 release with patch cluster updates noted below. Solaris 7 field installations are encouraged to be the 5/99 release or later.

FEMIS was not tested on any particular Maintenance Update of Solaris 7. If a site desires to install a current stable Maintenance Update, conflicts with Solaris Maintenance Updates and FEMIS are not anticipated.

We have tested FEMIS v1.4.7 using the March 2000 patch cluster. Because all operating systems require patches to improve security and fix bugs, PNNL strongly recommends installing Sun’s Solaris 7 patch cluster. The Solaris 7 patch cluster does not always include all patches that may be preferred for complete system functionality. Individual patch README files contain additional information regarding related patches that may be desired for complete fixes to reported problems. Additionally, certain hardware platforms may require specific patches that are not included in the patch cluster. Please consult Sun Solaris documentation, specifically installation release notes and Solaris™ 7 … Release Notes Supplement for Sun™ Hardware and/or Sun’s Web site http://sunsolve.sun.com for further information. The patch cluster is strongly recommended as a minimum patch set for each system. This cluster is typically updated twice a month by Sun Microsystems. Refresh installations of the patch cluster are recommended on a periodic basis particularly for security enhancements.

If the patch cluster is not available, the following five patches must be installed for FEMIS v1.4.7. Use showrev –p to list your existing patches.

- Kernel patch – 106541-10 or greater (requires quiescent system – see README)
- Patchadd/patchrm patch – 107171-05
- Cron patch – 107451-02
- fsck patch – 107544-03
- X Input & Output Method patch - 107636-03 or greater

Note: Check our web site (www.pnl.gov/femis/) for updates on patches that we have tested.

Volume Manager/Storage Array Firmware

PNNL is currently using VERITAS Volume Manager v3.0.2.

VERITAS Volume Manager v3.0.2 requires the Sun libthread patch 106980-05 (-10 is the latest at the time this was written) and the Sun kernel patch 106541 (-10 is the latest at the time this was written). The 106980 patch must be downloaded and installed separately after the cluster upgrade is completed as it is not part of the Solaris 7 patch cluster.

Solaris 7 requires SPARC Storage Array (SSA) firmware to be at v3.12. To verify your current version, use ssadaim display <controller> (where <controller> is the controller number, such as c1).
If the SSA firmware is not at v3.12, it must be upgraded. This can be accomplished during the Solaris 7 upgrade process, after the upgrade is complete, but before rebooting the new Solaris 7 kernel.

If the boot disk is a SSA disk, see the Solaris 7 … Sun™ Hardware Platform Guide section titled “Installing the Solaris Operating Environment With the SPARCstorage Array” for further information.

To upgrade the SSA firmware,

1. Enter the following command:

   ssaadm download –f /usr/lib/firmware/ssa/ssafirmware <controller>)

   where <controller> is the controller number, such as c1)

   **Note:** DO NOT INTERRUPT THE ABOVE COMMAND FOR ANY REASON!

2. Halt the system with /usr/sbin/init 0.

3. Click the SYS OK button on the back of the SSA(s) to reset.

4. Wait for the SSA to complete POST.

5. Boot the system by typing boot at the system ok prompt.

**Patch Locations**

Those patches discussed above and other patches are available from SunSolve Online at http://sunsolve.sun.com/ or the SunService Public Patch Page at ftp://metalab.unc.edu/pub/sun-info/sun-patches.

### 2.1.1.1 Installing or Upgrading Solaris 7

For those sites desiring to do new installs of Solaris 7, rather than upgrading the existing Solaris v2.6, and upgrading the current FEMIS installation, rather than doing a new FEMIS install, several steps must be taken prior to the Operating System Installation to allow the upgrading of FEMIS later.

To accomplish the FEMIS upgrade, the FEMIS and various other packages must be removed prior to the Operating System upgrade. The skeleton directories left must be preserved prior to the Solaris 7 new install, and then restored to the system after the Solaris 7 install so that the FEMIS upgrade can be completed.

AutoRecovery and AutoRecovery Web reporting (if installed) must be removed. You may wish to save the /opt/local/bin/femis_watch.conf file for configuration of the new AutoRecovery package later. If the /opt/local/bin/femis_watch.conf is saved for later, please be aware that it is not a drop-in replacement for the femis_watch.conf file in the new package. It is to be used for reference only.
To remove AutoRecovery, complete the following steps.

1. Login as root, and enter the following command.

   # pkgrm FEMISar

To remove AutoRecovery Web Reporting, see Section 2.7.2.1 Removing the AutoRecovery Web Reporting Package.

To continue preparing your system for a new installation of Solaris 7 and the upgrading of your current version of FEMIS, complete the following steps.

1. Complete only Section 2.2.2, Upgrading the FEMIS Application. Make sure the <backupdir> created in this step will be in an area or on a device unaffected by the Operating System installation.

2. Save what is left of the /home/femis directory tree to another disk or device that will be unaffected by the Operating System installation. Use tar or ufsdump to save the image so file times are preserved.

3. Remove the Perl package. See Section 2.1.6.1 Removing the Perl Package.

4. Save the /var/opt/oracle directory tree to another disk or device that will be unaffected by the Operating System installation. You may wish to preserve the /apps/oracle tree (minus the product directory) if it is on a partition that may be affected by the Operating System installation.

5. Complete the new Solaris 7 per the vendor’s documentation.

6. Restore the trees saved in Steps 3 and 5 above as appropriate.

For those sites where an Operating System upgrade will occur, rather than a new installation of Solaris 7, PNNL recommends the following method for disk partitioning and preserving data while running the installation/upgrade program for Solaris 7.

1. Use ufsdump to backup your file systems relating to the Operating System prior to upgrading.

2. Edit the /etc/vfstab file and comment out any entries relating to swap files (not swap partitions) and storage array file systems.

3. Boot the Solaris 7 CD-ROM which launches the interactive installer.

4. Follow the prompts and/or instructions to install/upgrade. Select no network unless you are upgrading from a remote install/jumpstart server or booting from the network, then the server needs to be considered networked.
5. Check if the 64-bit button has been selected. If so, this indicates your system can support running the 64-bit kernel. It will not be selected on systems where greater performance may not be realized, and it will be grayed out (not selectable) on systems where the 64-bit kernel can not be run at all. Selection, as allowed, is up to the installer.

Selecting the 64-bit support only means that the 64-bit support (i.e., for 64-bit application development) will be installed. Even with 64-bit kernel support installed, the default kernel booted will be the one supported by your hardware (as determined by the bootstrap software).

If the current partitions are sized correctly for Solaris 7 and the requested packages, then the installation will complete without interruption.

If disk partitions are not large enough according to the interactive installer program’s calculations, then the More Space Needed window will display.

1. Select the Auto-layout button, and allow it to calculate the necessary new sizes. If Auto-layout requires constraints to be changed, continue using it as a tool to plan the correct layout and sizes.

   **Note:** Do not allow Auto-layout to make partition backups and new layouts.

2. Make a note of the current partition size(s) and recommended new size(s). Exit the interactive installation program at this time.

3. Open a command window and dismount the affected volumes that were mounted by installation program.

4. Repartition and resize the disk layout or partitions using the command-line format tool (see the man page on `format`) as recommended by the previously suggested sizes in Step 1.

5. Adjustment the swap partition, if desired.

6. Create new file systems on the affected partitions and remount the new partitions back on to the installation file system.

7. Use `ufsrestore -rf <dumpfile>` to restore the affected file systems (backup previously created) onto the new disk partitions.

8. Mount or go to the partition containing the actual system’s root file system. Edit the `vfstab` file to reflect any device changes made in Steps 3–6.

9. Remove any `restoresymtable` files created by `ufsrestore`, and dismount all file systems under the `/a` path.
9. Right click in the background workspace area, and select Restart Install. Proceed through the installation process as prompted. You may have to start from the beginning again, however, if disk space partitions were correctly assigned, the upgrade should continue without error.

**Partitioning**

Separate partitions are not absolutely necessary for /, /usr, /var, and /opt. They can be combined into one / partition or split into various subsets. The /usr is static and does not usually contain dynamic data; /var is used for logging and temporary areas, so it grow considerably; and /opt is for optional software package installations, so its size depends on the planned usage of the server.

The following packages are not functionally required in case of space limitations:

- Packages pertaining to manuals, especially developer manuals and/or software.
- DHCP server if not used by clients.
- developer profiled libraries
- Unnecessary device drivers (this may not be easily determined, use discretion).
- Documentation tools
- International locale and font support
- Font server software (if not used)
- NIS support (if not used – basic packages can not be deselected)
- demos (binaries and software)
- PCMCIA support (if not used)
- Point-to-point protocol (if not used)
- Power management utilities (if not used)
- Programming tools and libraries
- WEBNFS (if not used)
- others (site dependant and based on Installer experience)

All packages not installed at upgrade time can be installed later if desired using a variety of package management tools/software.

**Patching and Patching Order (see Array notes above)**

The following patches must be installed.

- 106541 — requires quiescent system
- 107171-05 — is necessary to correct certain patch order problems when installing cluster patches.
32/64-bit Kernel and Firmware Updates

Flash Prom updates apply only to the following systems (output from `uname –i`):

- SUNW, Ultra-1
- SUNW, Ultra-2
- SUNW, Ultra-4
- SUNW, Ultra-Enterprise

Prom version level can be determined with `prtconf –V`.

If a Flash Prom update is required, Solaris 7 will prompt you upon boot-up. Special steps to write-enable the Flash Prom are required, and the procedure to do this differs between hardware platforms. In the Solaris 7 documentation, Solaris 7 … Sun™ Hardware Platform Guide, see the section entitled “Updating the Flash Prom on the Ultra 1, Ultra 2, Ultra 450, and Sun Enterprise 450 Systems” (Chapter 4 in 5/99 release documentation).

Utilities

Solaris 7 now incorporates traceroute and zip as bundled utilities. traceroute used to be added to the system during installation. The PC utility called PK-Zip was re-written and released for multi-platform usage. All patches for Solaris 7+ will be shipped in Zip archive format.

2.1.1.2 Automounting and FEMIS

Note: Using the automounter is optional, but strongly recommended by PNNL.

If FEMIS v1.4.5 or higher has successfully been installed, then the automount points should have been set up. Review this section to verify they were set up correctly.

This section is intended to be an overview of automounting. Specific automounting instructions are located in the following sections.

FEMIS uses the automounter scheme to automatically and transparently mount file system resources for both home and application directories. The automounter uses a series of maps to define the file resources to be mounted. Setting up the automounter consists of defining the maps and starting the automounter program.

Master Map

The master map is located at /etc/auto_master. This file provides a list of all maps on the system. It is read by the automounter daemon at system startup. The map for FEMIS looks similar to the following.
Indirect Maps

Indirect maps are used to mount file resources under a common directory. FEMIS needs two indirect maps for automounting:  1) /etc/auto_apps and 2) /etc/auto_home. The map, /etc/auto_home, contains the entries of the UNIX user login accounts to be mounted under /home. The indirect map for /etc/auto_home must look similar to the following.

```
Note: The current site map should list users and directory paths at your site. Remember to replace system# with the name of your server. The hostname localhost may also be used as the server name for directory structures collocated on the same server.
```

```
femis -intr,rw,nosuid system1:/files3/home:&
femx -intr,rw,nosuid system1:/files3/home:&
usera -intr,rw,nosuid system1:/files5/home:&
userb -intr,rw,nosuid system1:/files5/home:&
userc -intr,rw,nosuid system1:/files5/home:&
userd -intr,rw,nosuid system1:/files5/home:&
usere -intr,rw,nosuid system2:/files5/home:&
```

The /etc/auto_home map gives us a consistent view of home directories across a network. All home directories, whether remote or local, are mounted under each server’s /home directory. As an example, a UNIX account for usere, which has a directory on system2 on partition /files5/home/usere, is mounted at /home/usere on the current system.

The indirect map for /etc/auto_apps should look similar to following.

```
oracle -intr,rw,nosuid system1:/files2/app:&
```

Automounter Map Availability

Changes to indirect maps are available right away. Changes to the /etc/auto_master are effective only by restarting the automount daemon.

```
# /etc/init.d/autofs stop
# /etc/init.d/autofs start
```

(*) The term localhost must be used carefully when the automount map is distributed via NIS/NIS+ in a multiple server configuration, or where PC clients can interpret NIS automount map information.
**Note:** Automount cannot reflect new file systems in cases where the currently automounted file system is moved out from underneath an actively automounted file system in lieu of a replacement file system. To replace a mapped automount file system, make sure no processes are active in the automount tree by using `fuser -nc <auto_mount_path>`, and that automount has released the mount point before changing an automounted file system.

**FEMIS Users**

**Note:** Actual UNIX user accounts are created as needed. Steps are provided to create accounts for Oracle and the FEMIS application in their respective installation sections.

If the automounter is being used, an entry is necessary in `/etc/auto_home`, for each new FEMIS user added to the system. See Indirect Maps section above for more information. For additional information on automounting and automount maps, see the man page on `automount` and the Solaris documentation.

### 2.1.1.3 Creating Users and Groups

This section provides an overview on guidelines and instructions for creating FEMIS UNIX user accounts and groups on your server. Specific instructions are supplied in the Section 2.2.1, Creating UNIX Accounts on the Server.

The following information is required to create a UNIX user account:

- Username
- User Identification Number
- Group Identification Number or Name
- User’s home directory location (usually `/home/<user>`)  
  Preferred user shell (usually `/bin/csh`)  
  Password

**Usernames**

**Note:** The UNIX username **must be the same** as the corresponding Windows NT username.

Usernames, or login names, will allow the user to access the server with the appropriate access privileges. A username should be

- Unique within the organization
- Contain two to eight letters or digits
- One character must be lower case
- First character must be a letter
- May not contain a space or a new line (`\n`).
User Identification Numbers

A user identification (UID) number is assigned to each username. It identifies the user to the system and controls access to files and directories. UIDs have several requirements:

- UIDs must be unique for each user.
- UIDs must be whole numbers between 100 and MAXUID (defined in /sys/param.h).

Since many employers assign employees with unique employee numbers, System Administrators can use or manipulate employee numbers to get unique UIDs in the appropriate range. UIDs, along with the rest of the username data, is stored in the /etc/passwd file.

Password

**Note:** PNNL recommends that the UNIX password be the same as the corresponding Windows NT password if NFS Maestro or SUNWpcnfld are being used at your site. This is not a requirement if Samba is being used on the UNIX server, and it is authenticating to the same domain/NT server as the PC (assuming domain and/or Windows NT server authentication is in use).

Each username must be assigned a password. Passwords have a big impact on systems security so follow these minimum conventions when creating passwords. Passwords should

- Be six to eight characters in length
- Include at least one digit or special character such as $, &, #
- Differ from the user login name
- Be changed often
- Avoid proper nouns, or any word a person could guess by knowing you
- Avoid words found in the dictionary
- Avoid Social Security numbers, phone numbers, and car license numbers.

Group Identification Numbers

A group is a collection of users who share files and other resources. Each group has a group name, a group identification (GID) number, and a list of usernames that belong to the group. A primary group is the group the operating system will assign to files created by the user. Each user belongs to one primary group. The primary group must already exist when adding a new user.

User Home Directory

The user’s home directory is the space on the disk that is allocated for a user. Use the full path name or see Section 2.1.1.2, Automounting and FEMIS, if automounting home directories.
Creating FEMIS User Accounts

All FEMIS accounts must be members of the UNIX group femisrun. The femisrun should already exist prior to adding users. See Section 12.1, Operating System Security, in the FEMIS System Administration Guide for more information.

**Note:** The user ID listed below is an example only. Select a user ID that is unique for your EOC.

1. Create the UNIX user account.

   ```
   # /usr/sbin/useradd -u NEWUID -g femisrun -c "A Name" -d login_directory_path -s /bin/csh login_name
   ```

   Example:

   ```
   # /usr/sbin/useradd -u 4000 -g femisrun -c "John Doe" -d /files1/home/jdoe -s /bin/csh jdoe
   ```

   If automounting, the login directory path should be /home/login-name.

2. Create the appropriate home directories for the newly created accounts.

   ```
   # mkdir -p login_directory_path
   # chown login_name:femisrun login_directory_path
   ```

3. Set the account password.

   ```
   # passwd login_name
   ```

   If you are using the automounter, make the appropriate entry in the /etc/auto_home file. See Section 2.1.1.2, Automounting and FEMIS, for more information.

For additional information on UNIX user accounts and groups, see the man pages on `useradd`, `groupadd`, and `passwd`, as well as the Solaris documentation.

---

**STOP**

If AutoRecovery has previously been installed on the server and FEMIS, Oracle, or UNIX COTS software will be installed or upgraded, AutoRecovery MUST be stopped until the UNIX installation is complete.

To stop AutoRecovery, edit the root crontab file and comment out the lines pertaining to AutoRecovery.

1. Login as root.
2. Enter the following:

crontab -e

3. Comment out the lines following ##FEMISar.

Example:

##FEMISar
#0 * * * * LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/files2/app/oracle/product/8.1.6/lib; export
LD_LIBRARY_PATH:/opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar

#30 * * * 1-5 LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/files2/app/oracle/product/8.1.6/lib; export
LD_LIBRARY_PATH:/opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar

#10,20,40,50 7-18 * * 1-5
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/files2/app/oracle/product/8.1.6/lib; export
LD_LIBRARY_PATH:/opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar

#0 0 * * * sh /opt/local/bin/logit > /dev/null 2>&1 #FEMISar

When you have completed the UNIX installation process (upgrade or fresh install), be sure the lines in the crontab file are uncommented and updated according to new paths. AutoRecovery is the last UNIX item to be installed/upgraded. Installation and upgrading instructions for AutoRecovery are in Section 2.6, FEMIS AutoRecovery System Description and Installation.

2.1.2 Upgrading Sun Volume Manager Software

Note: Start the process of obtaining licensing (lead-time up to 5 working days). Current Sun Volume Manager 2.5 license should move across, but a hardcopy version of the license is prudent in case the system needs to ever be rebuilt from scratch. See instructions in VERITAS Volume Manager for Solaris Installation Guide section titled “Obtaining a License Key” for further information. The VERITAS product information (software serial number) is packaged separately in a sealed envelope.

This section only includes instructions for upgrading Sun Volume Manager v2.5 software on Solaris v2.6 to VERITAS Volume Manager v3.0.2 on Solaris 7. For new installations and setup of the VERITAS software or differing Operating System requirements, see the documentation and licensing supplied with VERITAS.

Note: The instructions below must also be done prior to upgrading from Solaris v2.6 to Solaris 7.

To upgrade Sun Volume Manager v2.5 software on Solaris v2.6 to VERITAS Volume Manger v3.0.2 on Solaris 7, complete the following steps.
1. Backup the data on your system in single user mode, particularly the data located on the Storage Array and /usr/lib.

2. Backing up the complete system using ufsdump to preserve file times.

3. Make sure that at least one plex for each of these volumes (if any of the file systems /, /usr, /var, or /opt are defined on volumes) is formed from a single subdisk that begins on a cylinder boundary. See VERITAS Volume Manager for Solaris Installation Guide section titled “Upgrading to VxVM 3.0.X and Solaris 2.5.1/2.6/7” for further information.

4. Load and mount the CD-ROM installation media. SPARC1000 (and possibly other older) server CD-ROM drives may not read the VERITAS v3.0.2 CD. In these cases it may be necessary to read and dump the installation CD to some other medium (network or removable) from a system with a newer CD-ROM drive, which is done to gain access to the installation software.

5. Run the upgrade_start script to prepare the previous release of the Volume Manager for removal. upgrade_start is locate at <installation software path>/scripts/upgrade_start.

6. Change directories to /var/sadm/patch. Using the ls command, determine if you have any versions of patch number 105463-xx are installed on the system. If they have been installed, they must be removed. If multiple versions of the same patch exist, they must all be removed. Remove the highest numbered revision first, then the next, and so on.

7. Reboot to single user mode using the command init S.

8. Remove the following packages, if they are installed:

   SUNWassa, SUNWvmman, , SUNWvxvm, SUNWvmdev, SUNWasevm

   This can be accomplished on a single pkgrm line:

   # pkgrm SUNWassa SUNWvmman SUNWvxvm SUNWvmdev SUNWasevm

9. Edit the /etc/vfstab file, and comment out any storage array lines under Volume Management control.

10. Reboot to the Solaris 7 installation media, and proceed with the Solaris 7 installation/upgrade.

11. Reboot to single user mode using the command init S.

12. Access/mount the VERITAS installation software, and add the VxVM 3.0.2 package:

   # pkgadd –d <installation software path>/<OS_version>/pkgs VRTSvxvm

   If this returns warnings that include the string /etc/vx, ignore them and continue.
13. Complete the upgrade by entering:

```
# <installation software path>/scripts/upgrade_finish
```

14. Edit the `/etc/vfstab` file, and uncomment the previously commented lines from Step 9.

15. Reboot to multi-user mode. Note any errors during reboot regarding `drv/attf` and `drv/ses`. If any errors occur, edit the `/etc/system` file once the system is booted, and comment the lines at the end of the file regarding the drivers that had errors. In `/etc/system`, a comment line begins with an asterisk (*). Be sure to comment only those lines in the file relating to the force load errors recorded during boot. These devices may be necessary for functionality beyond the scope of this section that is added and configured at a later date. If this situation is planned, the lines can be uncommented later, or left as is until the VERITAS configuration is complete.

16. Using `pkgadd`, install any or all of the additional packages `VRTSvmsa`, `VRTSvmdoc`, `VRTSvmman`, and `VRTSvmdev`.

   **Note:** Importing a pre-3.x Volume Manager disk group does not automatically upgrade the disk group version to the VxVM 3.x level. You may need to manually upgrade each of your disk groups following a VxVM upgrade. See the section on disk tasks in the *VERITAS Command Line Interface Administrator’s Guide* for information on how to upgrade a disk group.

17. Follow the instructions in the *VERITAS Volume Manager for Solaris Installation Guide* for “Setting Up and Starting the Storage Administrator”.

### 2.1.3 Installing and Configuring Samba

**Note:** Disable and/or remove any previous versions of Samba from the system. Save the old configuration file for reference.

Samba may exist on a system in one of two forms.

- It can be launched in a stand-alone mode in which case it is initially started by `/etc/init.d` startup scripts. To disable in this case, simply remove or rename the Samba startup scripts, and kill all `smbd` and `nmbd` processes.

- The other form is launched from the `inetd` daemon. In this case, the startup lines must be temporarily commented out of the `/etc/inetd.conf` file, and `inetd` signaled to reread its configuration file with a `kill -HUP <inetd pid>`. Then kill all `smbd` and `nmbd` processes on the system to disable.
The location of the original configuration file can then be determined either from the startup scripts or the `inetd.conf` file. The `smbd` and `nmbd` binaries usually reside in a `bin` directory under the Samba main installation root. The old configuration file will be typically located under the `lib` portion of this tree and is called `smb.conf`. There may be additional information worth saving in the `lib` branch, so saving this entire directory for future reference is recommended.

Be sure to create an automount location entry for `/apps/samba`. For example: in `/etc/auto_apps`:

```
  samba     -intr,rw,nosuid localhost:/vol02/app: &
```

**Note:** Be sure `/vol02/app/samba` exists. Create it, if necessary.

### 2.1.3.1 Installing Samba

**Note:** When installing a FEMIS package from the spool directory, it is possible to receive a Sun Package installation error, `Broken Pipe`. This error happens when the last package in the list is not selected for installation. This error will not cause any problems with the FEMIS installation. Continue with the installation.

To install Samba v2.0.6, complete the following steps.

1. Login as root, and insert the FEMIS application tape into the tape drive.

2. Create a temporary spool directory.

   ```
   # mkdir /<dir>/spool
   # chmod 755 /<dir>/spool
   ```

3. Spool the installation package from the 8mm tape using the Solaris software installation utility.

   ```
   # pkgadd -s /<dir>/spool -d /dev/rmt/??
   ```

   where ?? is the device number of the tape drive. Select the packages desired and run the `pkgadd` utility to install the FEMIS package.

   ```
   # pkgadd -d /<dir>/spool
   ```

4. Select the Samba application for installation.

5. Answer the questions as prompted:

   - The source is the original Samba source tree (unconfigured).
• The Windows NT Domain will only apply to those sites using NT Domain services. Enter anything if your site is not using this capability.

• The WINS address is an IP address of a WINS server. Enter d if you are not using this capability at your site.

• Enter the actual absolute path name for the automounted location of /apps/samba. For example: /vol02/app/samba as taken from the automount entry example above.

6. Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

7. Select q to quit after installing the Samba package.

8. Use pkgchk to verify the package was installed correctly.

   # pkgchk -n SAMBA

   If you only see the above output or get a prompt with no output, the package installed successfully. Continue with the installation by configuring Samba.

2.1.3.2 Configuring Samba

Samba configuration can get quite complex because of the flexibility the software offers. Please refer to the man page on smbd.conf for other options and combinations. A template configuration file is provided by the package installation which will set up basic parameters and define basic FEMIS shares. However, manual configuration is inevitable in order to bring the prior version’s definitions into place for compatibility.

1. View the /etc/samba/smb.conf file. Edit the template as necessary according to your site specific requirements. If you need to bring in configuration from a previous version of Samba, do that here. Pay particular attention to the values for the following parameters:

   • hosts allow is set according to your site’s subnet configuration.

   • security and password server are set according to the authentication method in use at your site (domain, NT server, local smbpasswd, or UNIX). Edits done at this time will override entries requested by the package install scripts. This will allow EOC customization beyond what the default package installation deals with.

   • Uncomment the interfaces line if you are running more than one interface on your server (machine is a router) if you want Samba to present itself on all interfaces. The device designation le0…n is assumed, but can be changed to hme0…n (hme*) for those sites so configured.
• Be sure the share entries for femis, femis_user, and user reflect the correct path for your site. The rest of the configuration for these entries is recommended to remain as shipped.

2. Test the configuration by running the Samba testparm program.

This program will report on the currently defined configuration. It will point out any configuration errors, and report assumed default values for the whole configuration. If this program does not return errors, proceed to the next step. If it does, review and correct the configuration file and re-run testparm.

# /apps/samba/bin/testparm
Load smb config files from /etc/samba/smb.conf
Processing section "[homes]"
Processing section "[printers]"
Processing section "[femis]"
Processing section "[femis_user]"
Processing section "[user]"
Loaded services file OK.
WARNING: You have some share names that are longer than 8 chars
These may give errors while browsing or may not be accessible
to some older clients
Press enter to see a dump of your service definitions

3. Join your Windows NT domain (if applicable):

To join an existing NT domain, an entry containing the NetBIOS name of the server must be added to the NT domain on the Primary Domain Controller using Server Manager for Domains.

Once the above is complete, enter the following command on the Samba server:

/apps/samba/bin/smbpasswd –j <domain_name> -r <primary domain controller>

You should receive the following response:

<date/time stamp>: change_trust_account_password: Changed password for domain <domain_name>.
Joined domain <domain_name>.

4. Enable Samba via the /etc/inetd.conf configuration file. The package installation will have added new lines to the /etc/inetd.conf file which specifies the Samba daemon startup. Signal inetd to reread its configuration file to launch Samba.

# ps –ef | grep inetd
# kill –HUP <inetd pid>
5. Verify client connectivity by attempting to connect to one of the default new shares defined in the `smb.conf` file from a PC.

Samba source files are distributed with this installation and are located at `/apps/samba/source` if installed. Under `/apps/samba/source/docs` is useful information regarding Samba operation and use, especially in integrating with Microsoft Windows environments. In addition, Samba provides detailed UNIX manual pages on its primary components which are included with the package and are located under the default path `/apps/samba/man`. Further information and up-to-date news regarding Samba can be obtained from the Samba Web site: `http://www.samba.org/` (locate a close mirror site from there).

### 2.1.4 Installing the NFS Authentication Services Daemon

For FEMIS v1.4.7, either NFS Maestro v 6.1 or Sun PC NFS v1.2 can be installed as the authentication service daemon. The following sections provide installation instructions for both NFS packages.

**Note:** If you have an older version of the NFS Maestro or Sun PC NFS package on your server, you must remove it. If the NFS software was installed manually (no packages were used), determine from the entries in `/etc/init.d` the location of the software and remove it along with its start/stop scripts in `/etc/init.d` and/or `/etc/rd#.d` directories.

#### 2.1.4.1 Determining Version of NFS Daemon

If you do not know if NFS Maestro or Sun PC NFS has been installed as a package on your server, enter the following commands:

```bash
# pkginfo -l HCLNFS
# pkginfo -l SUNWpcnfd
```

#### 2.1.4.2 Removing Previous NFS Daemon

To remove the old version of the NFS Maestro or Sun PC NFS package, enter the following commands:

```bash
# pkgrm HCLNFS
# pkgrm SUNWpcnfd
```

#### 2.1.4.3 Installing Hummingbird NFS Daemon

**Note:** When installing the FEMIS package from the spool directory, it is possible to receive a Sun Package installation error, `Broken Pipe`. This error happens when the last package in the list is not selected for installation. This error will not cause any problems with the FEMIS installation. Continue with the installation.

The Hummingbird NFS Daemon (NFS Maestro v6.1) has been included with FEMIS v1.4.7. To install the NFS Daemon, complete the following steps.
1. Login as root, and insert the FEMIS application tape into the tape drive.

2. Create a temporary spool directory.

   # mkdir /<dir>/spool
   # chmod 755 /<dir>/spool

   Spool the installation package from the 8mm tape using the Solaris software installation utility.

   # pkgadd -s /<dir>/spool -d /dev/rmt/??
   where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd utility to install the FEMIS package.

   # pkgadd -d /<dir>/spool

3. Select the HCLNFS application for installation.

4. Select y to continue when the following prompt displays: “This package contains scripts which will be executed with super-user permission during the process of installing this package.”

5. Select q to quit after installing the HCLNFS package.

6. Use pkgchk to verify the package was installed correctly.

   # pkgchk -n HCLNFS

7. Ignore the following errors:

   ERROR: /etc/init.d/hclnfs
   Permission <0755> expected <0744> actual
   Group name <other> expected <sys> actual

   If you only see the above output, or you get a prompt with no output, the package installed successfully.

8. Enter the following command to start the Hummingbird NFS daemon:

   # sh /etc/init.d/hclnfs start

**2.1.4.4 Installing Sun PC NFS Daemon**

The Sun PC NFS Daemon (SUNWpcnfd) has been included with FEMIS v1.4.7. To install the Sun PC NFS Daemon, complete the following steps.

1. Login as root, and insert the FEMIS application tape into the tape drive.
2. Create a temporary spool directory.

```
# mkdir /<dir>/spool
# chmod 755 /<dir>/spool
```

Spool the installation package from the 8mm tape using the Solaris software installation utility.

```
# pkgadd -s /<dir>/spool -d /dev/rmt/??
```

where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd utility to install the FEMIS package.

```
# pkgadd -d /<dir>/spool
```

3. Select the SUNWpcnfd application for installation.

4. Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

5. Select q to quit after installing the SUNWpcnfd package.

6. Use pkgchk to verify the package was installed correctly.

```
# pkgchk -n SUNWpcnfd
```

7. Ignore errors like the following:

```
ERROR: /etc/init.d/SUNWpcnfd
Permission <0755> expected <0744> actual
Group name <other> expected <sys> actual
```

If you only see the above output, or you get a prompt with no output, the package installed successfully.

8. Enter the following command to start the Solstice NFS daemon:

```
# sh /etc/init.d/SUNWpcnfd start
```

### 2.1.5 Installing an E-mail Package

Install your E-mail package according to documentation provided by the vendor.
2.1.6 Installing Perl v5.004-04

If you are upgrading FEMIS, you will have a previous version of the Perl package that must be removed, prior to installing Perl v5.004-04.

2.1.6.1 Removing the Perl Package

1. Login as root.

2. Enter the following

   # pkgrm Perl

3. Select y to continue when the following prompt displays: Do you want to remove this package?

4. Also select y for this prompt: Removing installed package instance <Perl>. This package contains scripts that will be executed with super-user permission during the process of removing this package. Do you want to continue with the removal of this package [y,n,?,q].

5. Verify that the package was removed successfully.

2.1.6.2 Installing the Perl Package

The Perl application will require 15MB of disk space for a spool directory. To install Perl, which has been included with FEMIS v1.4.7, complete the following steps.

1. Login as root, and insert the FEMIS application tape into the tape drive.

2. Create a temporary spool directory.

   # mkdir /<dir>/spool
   # chmod 755 /<dir>/spool

3. Spool the installation package from the 8mm tape using the Solaris software installation utility.

   # pkgadd -s /<dir>/spool -d /dev/rmt/??

   where ?? is the device number of the tape drive.

4. Run the pkgadd utility to install the Perl package.

   # pkgadd -d /<dir>/spool

5. Select the Perl application for installation.
6. Select y to continue when the following prompt displays: The following files are already installed on the system and are being used by another package: /opt/local/bin <attribute change only> * - conflict with a file which does not belong to any package. Do you want to install these conflicting files.

7. Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

8. Select q to quit after installing the Perl package.

9. Use pkgchk to verify that Perl installed correctly.

   # pkgchk -n Perl

   **Note:** The packages installed successfully if no error output is displayed. Report any errors to PNNL.

10. Remove the spool directory.

    # rm -r /<dir>/spool

11. Logout.

### 2.2 Installing the FEMIS UNIX Software

Before configuring the FEMIS UNIX software on the server, you **must determine** the FEMIS home directory

   Example: /home/femis

Using the Solaris software installation utility, pkgadd, the FEMIS application and support files will be installed to the Sun server.

#### 2.2.1 Creating UNIX Accounts on the Server

   **Note:** If you have successfully installed FEMIS v1.4.5 or higher, then skip this section.

You will need to create several new UNIX accounts on the server to prepare for the FEMIS package installation.

1. Login as root.

2. Create the following accounts (numeric IDs are for example only):

   # /usr/sbin/groupadd -g 30510 femisrun
   # /usr/sbin/useradd -u 30508 -g femisrun -c “FEMIS Account” -d /home/femis -s /bin/csh femis
If you are running DEI, create the following account **only on the onpost server**:

```bash
#/usr/sbin/useradd -u 30509 -g femisrun -c “FEMX Account” -d /home/femx -s /bin/csh femx
```

3. Create the appropriate home directories for the newly created accounts. Make sure each directory has the correct owner and group.

```bash
# mkdir -p /<file system>/home/femis
# chown femis:femisrun /<file system>/home/femis

**Note:** Creating the femx directory should only be done on the onpost server.

```bash
# mkdir -p /<file system>/home/femx
# chown femx:femisrun /<file system>/home/femx
```

4. Set the account password.

```bash
# passwd femis

**Note:** Setting the femx password should only be done for the onpost server.

```bash
# passwd femx
```

5. Edit `/etc/auto_home` and add entries for both the femis and femx accounts, if your system uses automount maps. The entries must look similar to the following:

```
femis -intr,rw,nosuid systemname:path: &
femx -intr,rw,nosuid systemname:path: &
```

Example:

```
femis -intr,rw,nosuid mysystem:/<file system>/home: &
femx -intr,rw,nosuid mysystem:/<file system>/home: &
```

The colon and ampersand (`: &`) in the above examples may also have a `/<map_key>` instead. Either method of map specification is fine.

See Section 2.1.1.2, Automounting and FEMIS, for more information.

6. Add the following line to the `/etc/dfs/dfstab` file, unless Samba is being exclusively used for FEMIS:

```bash
share -F nfs -o rw /<disk>/home/femis
```

where `<disk>` is whichever device `/home/femis` is on.
**Note:** To restrict NFS access, see the man pages on `share` and `share_nfs` in your Solaris documentation.

If you do not have any other entries in the `dfstab` file, you will need to start the NFS server process. If you do not start the NFS server process, you will see errors like “RPC: Program not registered” when entering the `shareall` command (see below). To start the NFS server process, type the following:

```bash
# /etc/init.d/nfs.server start
```

To make the `/<disk>/home/femis` directory available to NFS authentication services (daemon) type

```
# shareall
```

To check that the directory is available to NFS Maestro type

```
# share
```

You should see output similar to the following:

```
# -   /<disk>/home/femis rw ""
```

### 2.2.2 Upgrading the FEMIS Application

**Note:** If you are doing a new install of FEMIS, then skip this section. If you have successfully installed FEMIS v1.4.6 or higher, then you **must complete** this section.

To prepare for the new version (an upgrade) of FEMIS, check for the existence of required user accounts, backup the FEMIS directory, and remove the old FEMIS installation.

1. Login as root.

2. Copy the site-specific directories to another location using the following commands:

   **Note:** The `<backup>` directory in the following represents a file system of your choice on this server where you can save a copy of the files. You will need to restore the `/home/femis/user` directory at the end of the Section 2.2.3, Installing the FEMIS Package.
   The `configd` and `etc` directories are backed up in this step for redundancy only.

   ```bash
   # mkdir <backupdir>
   # cd /home/femis
   # tar cf - user configd etc pc/femtools/femis.db | (cd <backupdir>; tar xf -)
   
   Use these files to reference site-specific information, as needed.
   ```
3. Make sure both the femis and femisrun accounts exist, if you are installing on the onpost server. Otherwise, only the femis account needs to exist.

    # logins -m -l femis

    Your output should look similar to the following:

    femis          30508   femisrun       30510   FEMIS Account

    If your output is blank, you need to add the femis and femisrun accounts. See Section 2.2.1, Creating UNIX Accounts on the Server, to add these accounts.

    If you are running DEI, the femx account should exist.

    # logins -m -l femx
    Your output should look similar to the following:

    femx          30509   femisrun      30510   FEMIX Account

    **Note:** Some systems may show femx having supplemental group membership in the femis group. The femis group, as of v1.4.7, is obsolete and may be removed from the system as long as any files having femis as the group owner are changed to femisrun (or match whatever the femis account’s primary group is). The exception is those deemed sensitive for security reasons, such as /home/femis/etc/cmdserv.conf which should have group ownership set to noaccess (see Section 12.1.6 No Access Files in the FEMIS System Administration Guide).

    If your output is blank, you will need to add the femx account. See Section 2.2.1, Creating UNIX Accounts on the Server, to add this account.

4. Stop all FEMIS processes, such as DEI and Notification, before removing the FEMIS package.

    Login as femis.

    On all servers

    % stopnotify   This will stop Notification.

    **Onpost Only**

    % femisdei -kill
    % stopdai.sh

5. Remove the FEMIS application.
Login as root.

# pkgrm FEMIS

You will most likely see warning messages about package dependencies similar to the following:

## Verifying package dependencies.

WARNING:
The <FEMISgs> package depends on the package currently being removed.

WARNING:
The <FEMISdb> package depends on the package currently being removed.

Dependency checking failed.

Do you want to continue with the removal of this package [y,n,?,q]

If this message appears, answer Yes by typing a y and pressing Enter.

6. Delete the site-specific directories that you backed up in Step 2.

   # rm -r /home/femis/user
   # rm -r /home/femis/configd
   # rm -r /home/femis/etc

2.2.3 Installing the FEMIS Package

   Note: When installing the FEMIS package from the spool directory, it is possible to receive a Sun Package installation error, Broken Pipe. This error happens when the last package in the list is not selected for installation. This error will not cause any problems with the FEMIS installation. Continue with the installation.

You will copy the FEMIS package(s) to a spool directory and install FEMIS by completing the following steps. The FEMIS application will require 82MB of disk space for a spool directory.

1. Login as root, insert the FEMIS application tape into the tape drive.

2. Enter the following command to mount the FEMIS installation directory, if you are using the automounter.

   cd /home/femis

3. Create a temporary spool directory.

   # mkdir /<dir>/spool
   # chmod 755 /<dir>/spool
4. Spool the installation package from the 8mm tape using the Solaris software installation utility.

   # pkgadd -s /<dir>/spool -d /dev/rmt/??

   where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd utility to install the FEMIS package.

5. Run the following command again if exited above:

   # pkgadd -d /<dir>/spool

6. Select the FEMIS application for installation.

   Ignore any warning messages about disk space.
   If the femx account was created prior to the installation, you will be asked if you want to install DEI.
   If the server will be running the FEMIS DEI, select y to install the DEI options.

   Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

7. Select q to quit, after the FEMIS application has been installed.

8. Use pkgchk to verify the FEMIS package has installed correctly.

   #pkgchk -n FEMIS

   Ignore the following errors:

   ERROR: /etc/init.d/femis
   permissions <0644> expected <0744> actual group name <other> expected <sys> actual
   ERROR: /home/femis
   permissions <0755> expected <0775> actual owner name <femis> expected <femx> actual

   If you only see the above output, or you get a prompt with no output, the package installed successfully.

9. Remove the spool directory, unless you will be installing AutoRecovery or AutoRecovery Web.

   # rm -r /<dir>/spool

10. Restore only the FEMIS application user directories in the /home/femis/user directory and the femis.db file from the backup you made in Section 2.2.2, Upgrading the FEMIS Application (Step 2), if you are upgrading the FEMIS application.
# cd /home/femis/pc/femtools
# mv femis.db femis_orig.db
# cp –p <backupdir>/pc/femtools/femis.db .
# cd <backupdir>/user
# tar cf – `find . –type d  \!  -name . –prune` | (cd /home/femis/user; tar xf -)

11. Set the setgid bit for the /home/femis/user directory.

    # find /home/femis/user –type d –exec chmod g+xs {} \\;

12. Remove the FEMIS application tape from the drive.

### 2.2.4 Installing Network Time Protocol (NTP)

This section describes the steps required to remove the Network Time Protocol (NTP) package bundled with previous versions of FEMIS, and it steps you through configuring the NTP software bundled with the Solaris operating system.

If you have any version of the FEMIS NTP package on your server, you will need to remove it. If you do not know if NTP is installed as a package on your server, enter the following command:

    # pkginfo | grep XNTPD

A result similar to the following means the NTP package is installed on your server.

    application   XNTPD    Network Time Protocol

**Note:** If you do not received a response to the above command, skip to Configuring NTP below.

If you know you are already running the bundled Solaris NTP, proceed to Step4 under Configuring NTP.

### Removing the Old Version of NTP

1. Stop the NTP daemon.

    # sh /etc/init.d/ntp stop

2. Save the old ntp.conf file for reference.

    # cp /etc/ntp.conf /etc/ntp.conf.old

3. Enter the following command to remove the old version of the NTP package.

    # pkgrm XNTPD
4. Select y to continue when the following prompt displays: “Do you want to remove this package?”

5. Also select y for this prompt: “Removing installed package instance <XNTPD>. This package contains scripts that will be executed with super-user permission during the process of removing this package. Do you want to continue with the removal of this package [y,n,?,q]”

**Configuring NTP**

*Note:* You do not need to configure NTP if you already have the Solaris version of NTP configured.

NTP is included with the Solaris operating system. To configure NTP complete the following steps.

1. Login as root.

2. Enter the following:

   cd /home/femis/install

3. Run the following script to configure an ntp.conf file in the /etc/inet directory and start the NTP daemon (xntpd). You may need information from the ntp.conf.old file in the /etc directory before running this script. Then you may remove the ntp.conf.old file.

   sh ntp_config

   The installation will ask if the server will get time from another server; select y if yes, otherwise select n.

   If you selected y above, the installation will prompt for the NTP server’s Internet Protocol (IP) address. Make sure the NTP server is accessible (available on the network) as the installation will attempt to ping the NTP server.

   The message: “/etc/inet/ntp.conf already exists. It will not be reconfigured,” means the script found an existing /etc/inet/ntp.conf file and exited without making any changes to the /etc/inet/ntp.conf file.

4. Check your NTP configuration.

   ntptrace <servername>

   It may take awhile before your output shows a traceback other than a “timeout”. Once the traceback information displays correctly, NTP is configured.

For additional information on NTP see the Section 11.0, Server Network Time Protocol (NTP) Set Up, in the *FEMIS System Administration Guide*. 

2-30
2.3 Installing the FEMIS GIS and Database

If this is a new installation of FEMIS, you will need to install both the Oracle software (v8.1.6) and the FEMIS GIS and database packages.

If you are upgrading to a new version of FEMIS, you will have to upgrade Oracle to v8.1.6 and install the appropriate FEMIS GIS and database package from the tape, if FEMIS v1.4.6 has not previously been installed.

In FEMIS, database topologies are defined either as NxN or NxM, which are number pairs that indicate the number of EOC databases and the number of servers. For example, a 3x3 (or NxN) configuration indicates three EOCs on three servers. Likewise, an 8x4 (or NxM) configuration represents eight EOCs on four servers.

On each server, Oracle schemas are created to store the EOC data. The schemas are broken into two groups: 1) data owner schema or 2) snapshot owner schema. A data owner schema has the database tables that store the data for an EOC. A snapshot owner schema has a set of specialized snapshot tables that are created to support the replication of data.

On every NxN configuration, there is exactly one data owner and N-1 snapshot owners per server. By definition, NxM configurations have more than one data owner on at least one of the M servers in the configuration.

The terms data owner and snapshot owner will be used frequently throughout this section and as the installation is performed. You will need to know which server has which data owner within your configuration.

To properly complete the installation for your site, follow the instructions in the Section 2.3.1, Installing the GIS and Oracle Database through Section 2.3.5.7, Setting Up the Oracle Backups.

2.3.1 Installing the GIS and Oracle Database

Note: Complete this section only if you are installing a new FEMIS GIS and database package. If you are upgrading the existing database skip to the next section.

Oracle Release v8.1.6 requires a minimum of 128MB of RAM; if you do not have this much memory installed, do not attempt to install Oracle v8.1.6. To check the amount of memory available, issue the following command:

```
# /usr/sbin/pprtconf | grep size
```
To install the GIS and database package, complete the following steps.

1. Insert the GIS and database tape into the tape drive.
   
   This installation may require considerable disk space for a spool directory. To create a temporary spool directory, run the following commands but only if you did not create the spool when you installed the FEMIS package.
   
   ```
   # mkdir /<dir>/spool
   ```
   
   Spool the installation package from the 8mm tape using the Solaris software installation utility.
   
   ```
   # pkgadd -s /<dir>/spool -d /dev/rmt/??
   ```
   
   where ?? is the device number of the tape drive. Select the packages desired, and run the pkgadd utility to install the GIS and database package.
   
   ```
   # pkgadd -d /<dir>/spool
   ```

2. Select the numbers corresponding to your site’s GIS and database using commas as separators.

3. Select q to quit, after the GIS and database have been installed.

4. Use pkgchk to verify the packages were installed correctly.
   
   ```
   #pkgchk -n <package name>
   ```
   
   No output is expected as a result of this command.

5. Remove the spool directory.
   
   ```
   # rm -r /<dir>/spool
   ```

6. Remove the tape from the drive.

### 2.3.2 Database Cleanup Tasks

The following tasks describe how to prepare your existing database for an upgrade. Check each subsection to see if it pertains to your site.

#### 2.3.2.1 Dropping Database Objects and Exporting Data Owners

**Note:** Complete this section only if you have a previous version of FEMIS installed. If you do not have a previous version installed, skip this section and go to Section 2.3.2.2, Removing Current Oracle Installation.
1. Drop all the non-table objects. If you are upgrading on an NxM or NxN system, the master drop script will drop objects from all servers in the configuration and only needs to be performed on one server.

As oracle user:

% svrmgrl
SVRMGR>connect internal
SVRMGR>shutdown immediate
SVRMGR>startup
SVRMGR>exit

As femis user:

% cd /home/femis/database/eocdba
% sqlplus /nologin
SQL> @master_dr

Watch the progress of the master_dr.sql script. If you do not have any problems, press Enter after each Pause statement is encountered.

2. Perform an export of all FEMIS data owners on each server. The export files created in this step will be re-imported later if you need to reinstall Oracle. If you are not going to reinstall or upgrade Oracle, then export this data as a safety precaution.

Note: To determine the “data owner” schemas, review the /home/femis/etc/eoclist.dat file. The first column lists all EOCs for your site. The third column lists the server where the EOC is a data owner. Perform an export for every EOC whose server matches your server.

% cd $/home/femis/database/exports/<site name>
% exp userid=<EOC_name>/<data owner password> file=<EOC_name>_<date (yyyymmdd)}.dmp
log=<EOC_name>_<date>.log

3. Repeat this export command for each data owner schema that resides on this server. For example, if you have eight EOCs at your site but only three EOC databases reside on this server, then you will make three database exports on this server. You must then export the remaining data owners from each of the other servers in the configuration.

2.3.2.2 Removing Current Oracle Installation

Note: The following tasks are only required if you are upgrading to Oracle v8.1.6. If you are installing Oracle for the first time or if you already have Oracle v8.1.6 installed, then skip this section.
1. Login as oracle user and enter the following to shutdown the old database, shutdown the listener, and delete the old Oracle files.

   % svrmgrl
   SVRMGR>connect internal
   SVRMGR>shutdown immediate
   SVRMGR>exit
   % lsnrctl
   LSNRCTL>stop
   LSNRCTL>exit

   **Note:** Before removing the Oracle Product directory, confirm that all Oracle Instances (some facilities have multiple instances running) have been shutdown. Use the `ps` and `grep` commands to identify the Oracle processes. For example `ps -ef |grep oracle | sort`.

2. Identify the location of the Oracle data and log files, and delete them.

   % cd
   % ls */app/oracle/oradata/*
   % rm -rf */app/oracle/oradata/fi<#>/*
   % cd $ORACLE_HOME
   % cd ..
   % rm -rf <oracle_directory>

   The `oracle_directory` is named after the version number, for example, for Oracle v7.3.3 the directory is named 7.3.3. To confirm the removal of this directory, enter

   `ls`

3. Save the current configuration files in `/var/opt/oracle`.

   % cd /var/opt/oracle
   % mkdir bkp
   % cp *.ora ./bkp

4. Comment out all database instances in the `/var/opt/oracle/oratab` file. This is important; otherwise you will have difficulty in creating a new instance with the same name as the old one.

2.3.3 **Installing Oracle Software or Relinking Oracle**

   **Note:** If you do not have Oracle v8.1.6 (the version required for FEMIS v1.4.7) installed, carefully review each of the following sections and determine which sections pertain to your site.
If you already have the Oracle v8.1.6 installed, you may need to relink the Oracle software. To determine if relinking is necessary, go to Section 2.3.3.4, Relinking the Oracle Software, and skip Sections 2.3.3.1, 2.3.3.2, and 2.3.3.3.

Before beginning the Oracle v8.1.6 installation, you should review the installation guide provided by Oracle, Oracle8i Installation Guide Release 2 (8.1.6) for Sun SPARC Solaris. The following steps are required to install Oracle and identify specific parameter settings required by FEMIS.

2.3.3.1 Creating the UNIX Environment for Oracle

**Note:** Numeric IDs in this section are for example only.

To create the UNIX environment for Oracle v8.1.6, complete the following steps.

1. Select a drive on which to install Oracle (this will be referred to as `<install_drive>`). The drive must have a minimum of 1000MB available. Select two additional drives on which to locate the FEMIS database files (these will be referred to as `<driveA>` and `<driveB>`). Each of these drives should have a minimum of 500MB available. It is recommended that all drives used are RAID volumes. For complete information on server drives, see the FEMIS Bill of Materials (BOM) or on the FEMIS web site at http://www.pnl.gov/femis. The following command will allow you to view the drives and their available storage space.

   ```bash
   % df –k –F ufs
   ```

2. Login in as root.

   Check if there is a group named dba and a group named oinstall in the `/etc/group` file, and also determine if oracle is a member of the dba and the oinstall group.

   ```bash
   # egrep '^dba|^oinstall' /etc/group
   ```

   Verify that output from the above command resembles the following:

   ```
   dba:*:26001:oracle
   oinstall::26002:oracle
   ```

   If you do not get the output above, use the following command to add a dba and/or an oinstall group, as necessary:

   ```bash
   # /usr/sbin/groupadd -g 26001 dba
   # /usr/sbin/groupadd -g 26002 oinstall
   ```
Note: You may select any number for your group identification (GID) number that is not currently being used. Be sure to check for the existence of a GID in both the /etc/group file and NIS+ (if your site uses NIS+).

Edit the /etc/group file, and add oracle to the group oinstall, as necessary.

3. Check if an oracle account already exists.

   # logins –m –l oracle

   The following is an example of output from the above command.

   oracle   300   dba   26001   Oracle Account
            oinstall 26002

   If the line does not exist, use the following command to add the oracle user assigned to the dba group:

   # /usr/sbin/useradd -u 300 -g dba -c "Oracle Account" -d /<install_drive>/app/oracle -s /bin/csh oracle

   Set the Oracle password to your desired value using the UNIX passwd process.

   #passwd oracle

   If an Oracle account already exists, verify that the login directory is correct. Change the password, if desired.

4. Create the following directories, if they do not already exist.

   % su -
   # mkdir -p /<install_drive>/app/oracle
   # chown oracle:dba /<install_drive>/app/oracle
   # chmod 755 /<install_drive>/app/oracle
   # mkdir -p /<driveA>/app/oracle
   # chown oracle:dba /<driveA>/app/oracle
   # chmod 755 /<driveA>/app/oracle
   # mkdir -p /<driveB>/app/oracle
   # chown oracle:dba /<driveB>/app/oracle
   # chmod 755 /<driveB>/app/oracle

5. Set up the automount map. If your system uses automount maps, edit /etc/auto_apps and add the following line:

   oracle   -intr,rw,nosuid   systemname:path
Example:

    oracle -intr,rw,nosuid Mysystem:<install_drive>/app/oracle

See Section 2.1.1.2, Automounting and FEMIS, for more information.

6. Make sure there is adequate shared memory. Examine the following parameters in the /etc/system file.

```
set shmsys:shminfo_shmmax=4294967295
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=400
set shmsys:shminfo_shmseg=36
set semsys:seminfo_semmni=256
set semsys:seminfo_semmsl=600
set semsys:seminfo_semmns=1800
set semsys:seminfo_semopm=100
set semsys:seminfo_semvmx=32767
```

If there are no parameters, copy them from the template. As root, set them to the recommended values shown above or as high as possible for the operating system.

A copy of the recommended values can be found in

```
/home/femis/install/oracle_template/kernel_parms.dat
```

**Note:** If any of these parameters are changed, you must reboot the server (as root, use the init 6 command to reboot) before proceeding.

7. Verify there is at least two times (preferably three) as much swap space as physical RAM (a minimum of 400MB is recommended). If additional swap space is required, see your System Administrator.

To determine how much physical RAM you have, enter the following command:

```
# prtconf | grep size
```

**Note:** At least 128MB of RAM are required for Oracle v8.1.6 installation.

To determine the available swap space, enter the following command:

```
# /usr/sbin/swap –s
```
8. Verify that the necessary Solaris 7 patches and packages are installed prior to installing Oracle.

Solaris 7          107636-01

  #> showrev -p | grep 107636

Packages

  #> pkginfo -i SUNWarc SUNWbtool SUNWhea SUNWlibm SUNWlibms SUNWsprot SUNWtoo

If any of the patches and/or packages above are not displayed as installed, then install them.

9. Verify there is a local bin directory /usr/local/bin. If the directory does not exist, then it should be created as root.

10. Create the /var/opt/oracle directory, if it does not exist.

  #> mkdir -p /var/opt/oracle
  #> chown -R oracle /var/opt/oracle
  #> chgrp -R dba /var/opt/oracle
  #> chmod -R 755 /var/opt/oracle

11. Log completely off and back onto the server as oracle.

12. Copy the template files to the admin directory.

  % cp -r /home/femis/install/oracle_template/* /<install_drive>/app/oracle/admin
  % chown -R oracle /<install_drive>/app/oracle/admin
  % chgrp -R dba /<install_drive>/app/oracle/admin
  % chmod -R 755 /<install_drive>/app/oracle/admin

13. Create the product directories, if they do not exist.

  % mkdir -p /<install_drive>/app/oracle/product/8.1.6
  % chown -R oracle /<install_drive>/app/oracle/product
  % chgrp -R dba /<install_drive>/app/oracle/product
  % chmod -R 755 /<install_drive>/app/oracle/product

14. Copy the new Oracle UNIX setup file to the installation directory.

   **Note:** If you previously had FEMIS installed, you should compare your existing configuration files with the new ones. If your existing files have been customized, then do not overwrite them but perform Step 14 to make sure the values are still correct for this server.
15. Make sure the following environment variables are correct in .oraclerc file.

```
ORACLE_TERM (set it to match the xterm for the given keyboard: xsun or xsun5)
ORACLE_BASE = /<install_drive>/app/oracle
ORACLE_HOME = /$ORACLE_BASE/product/8.1.6
PATH includes:
    $ORACLE_HOME/bin
    /etc
    /usr/local/bin
    /bin
    /usr/bin
    /usr/ccs/bin
ORACLE_SID = fi<x>
ORACLE_DOC = $ORACLE_BASE/doc
CLASSPATH = $ORACLE_HOME/JRE:$ORACLE_HOME/jlib
LD_LIBRARY_PATH = /usr/lib:/usr/dt/lib:/usr/ucblib:/usr/openwin/lib:$ORACLE_HOME/lib
ORACLE_EXPORT = /<driveA>/app/oracle/admin/fi<x>/exp
ORACLE_LOGS  = /<driveA>/app/oracle/admin/fi<x>/logs
ORACLE_FULL  = /<driveB>/app/oracle/admin/fi<x>/full
ORACLE_COLD  = /<driveB>/app/oracle/admin/fi<x>/cold
```

16. Create the directories that Oracle uses for database backups.

```
% source .oraclerc
% cd /<install_drive>/app/oracle/admin
% ./dbbackup_setup
```

This executable will check on needed environment variables and then create directories. If any errors are reported, correct them and then rerun the setup process.

17. Patch the dbstart script with the following commands (assumes you are still in
  /<install_drive>/app/oracle/admin):

```
% cp dbstart $ORACLE_HOME/bin
```

### 2.3.3.2 Installing the Oracle Software

Complete the following steps to install the Oracle v8.1.6 software.
1. Log completely off and back onto the server as oracle with the group set to oinstall.

   % newgrp oinstall
   % id should return something like uid=26000(oracle) gid=26002(oinstall)

2. Insert the Oracle8 Server v8.1.6 CD into the CD drive.

3. Mount the CD

   $ cd /cdrom/oracle8i

4. Run the installer.

   ./runInstaller &

5. Install the Oracle products. After the Universal Installer comes up, perform the following operations at the indicated windows.

   WELCOME — Click Next.

   FILE LOCATIONS — Verify Destination path settings, then click Next.

   UNIX GROUP NAME — Type in oinstall in the space provided. (This window may not display.)

   AVAILABLE PRODUCTS — Select the Oracle 8i Enterprise Edition 8.1.6.0.0, then click Next.

   INSTALLATION TYPES — Select Custom, then click Next.

   AVAILABLE PRODUCTS COMPONENTS — Select the following components (a check mark indicates a selected product); the plus (+) and minus (−) signs expand or contract the upper level menus:

   −☑ Oracle 8i Enterprise Edition 8.1.6.0.0
     −Product Options
     −☑ Oracle 8i Server 8.1.6.0.0
     −Optional
     ☑ Oracle Database Configuration Assistant 8.1.6.0.0
     ☑ Oracle Data Migration Assistant 8.1.6.0.0
     ☑ Oracle Database Demos 8.1.6.0.0
     ☑ Advanced Replication 8.1.6.0.0
     ☑ Legato Storage Manager 8.1.6.0.0
     ☑ Migration Utility 8.1.6.0.0
     ☑ Oracle Intelligent Agent 8.1.6.0.0
     ☑ Oracle Partitioning 8.1.6.0.0
     ☑ Heterogeneous Services ODBC Connectivity 8.1.6.0.0
Oracle Product Options 8.1.6.0.0
- Oracle Time Series 8.1.6.0.0
- Oracle Visual Information Retrieval 8.1.6.0.0
- Oracle Spatial 8.1.6.0.0
  + Optional
- Oracle Advanced Security 8.1.6.0.0
- Oracle interMedia 8.1.6.0.0
  + Optional

Net 8 Products 8.1.6.0.0
- Net 8 Client 8.1.6.0.0
- Net 8 Server 8.1.6.0.0
- Oracle Names 8.1.6.0.0
- Oracle Connection Manager 8.1.6.0.0
- External Naming: NIS 8.1.6.0.0
- Oracle Protocol Support 8.1.6.0.0

Oracle Utilities 8.1.6.0.0
- Oracle Database Utilities 8.1.6.0.0
- SQL*Plus 8.1.6.0.0

Oracle Configuration Assistants 8.1.6.0.0
- Oracle Database Migration Assist 8.1.6.0.0
- Oracle Database Configuration Assistant 8.1.6.0.0

Development Tools 8.1.6.0.0
- Oracle Call Interface (OCI) 8.1.6.0.0
- Object Type Translator 8.1.6.0.0

Oracle Java Products 8.1.6.0.0
- Oracle JDBC Drivers 8.1.6.0.0
  - Oracle JDBC/OCI Driver for JDK 1.18.1.6.0.0
  - Oracle JDBC/OCI Driver for JDK 1.28.1.6.0.0
  - Oracle Thin Driver for JDK 1.18.1.6.0.0
  - Oracle Thin Driver for JDK 1.28.1.6.0.0
- Oracle SQLJ 8.1.6.0.0
- Oracle Java Tools 8.1.6.0.0

Oracle Enterprise Manager Products 8.1.6.0.0

Oracle Installation Products 8.1.6.0.0
- Oracle Universal Installer 1.7.0.18.0A
- Solaris Documentation 8.1.6.0.0

Click Next.

COMPONENT LOCATIONS — Click Next.

PRIVILEGED OPERATING SYSTEM GROUPS (change to dba) — Click Next.

CREATE DATABASE — Select NO, then click Next.
ORACLE PROTOCOL SUPPORT — Click Next.

SUMMARY — Review your selections. You will probably see more products than you selected (some are required to support your selections), but as a minimum, you should see the products that were originally selected. Click the Install button if your selections are correct. If they need to be revised, then click on the Previous button and revise selections.

Edit the root.sh file. Comment with a # any lines containing the text “$CHOWN root” and “$CHMOD 6???” or “4???” (where ?? = three permission digits).

As root, execute the root.sh. When prompted by the following: Enter the full pathname of the local bin directory, accept the default path. When prompted, dismiss the Setup Privileges window.

CONFIGURATION TOOLS — auto-defaults to NET8 CONFIGURATION ASSISTANT — Click Cancel and confirm Yes.

ERROR (Triggered from the previous step – ignore) — Click OK.

CONFIGURATION TOOLS — Click Next, then Exit, and confirm Yes.

6. Create the database using the Database Creation Assistant.

At the O/S prompt, verify that you are part of the dba group by typing id and enter.

```
% newgrp dba
% id should return uid=26000(oracle) gid=26001(dba)
```

Then change directory to the new ORACLE_HOME and run the Database Creation Assistant.

```
cd $ORACLE_HOME/bin
./dbassist &
```

7. After the Database Creation Assistant comes up, perform the following operations at the indicated windows:

**ORACLE DATABASE CONFIGURATION ASSISTANT**

Select Create a database, and click Next.
Select Custom, and click Next.
Select Multipurpose, and click Next.
Change Concurrently connected users to 35, and click Next.
Select Dedicated Server Mode, and click Next.
Verify a box is checked for each of the following: Oracle JServer, Advanced Replication, SQL*Plus Help
Click Next to continue.
Enter the Global Database Name, and click Next.
Example: fi1

**Note:** If an Alert window regarding an instance is already in use, choose another instance name. Acknowledge the Alert by clicking OK. Edit the /var/opt/oracle/oratab file to remove the offending instance line, and click Next. Then, you may get the Alert window described below.

If an Oracle Database Configuration Assistant Alert window appears, click the Yes button and proceed. This removes the old folder with the same instance name in the $ORACLE_BASE/admin directory allowing the same instance name to be recreated.

Change the ControlFiles so that each control file has a different number in the /filesX line whereX = 0....n.

Example: /files0, /files1, /files2

Click Next.

Create tablespaces, for each tabbed tablespace input the following parameters (Create file locations based on your best judgement of space available and disk usage).

**SYSTEM**
- Size (MB): 400
- File: (Verify the File Location)
- Autoextend: YES
- Next (KB): 1000
- Min Extent (KB): 1000
- % Increase: 0
- Initial (KB): 100
- Next (KB): 100
- Min: 1
- Max: Check “Unlimited”

**TOOLS**
- Size (MB): 50
- File: (Verify the File Location)
- Autoextend: YES
- Next (KB): 1000
- Min Extent (KB): 1000
- % Increase: 0
- Initial (KB): 100
- Next (KB): 100
- Min: 1
- Max: Check “Unlimited”
USERS
Size (MB): 5
File: (Verify the File Location)
Autoextend: OFF
Min Extent (KB): 1000
% Increase: 0
Initial (KB): 100
Next (KB): 100
Min: 1
Max: Check “Unlimited”

ROLLBACK
Size (MB): 200
File: (Verify the File Location)
Autoextend: OFF
Min Extent (KB): 1000
Initial (KB): 1000
Next (KB): 1000
Min: 2
Max: Check “Unlimited”

INDEX
Size (MB): (Accept the default)
File: (Accept the default)
Autoextend: (Accept the default)
Next (KB): (Accept the default)
Min Extent (KB): (Accept the default)
% Increase: (Accept the default)
Initial (KB): (Accept the default)
Next (KB): (Accept the default)
Min: (Accept the default)
Max: (Accept the default)

TEMPORARY
Size (MB): 50
File: (Verify the File Location)
Autoextend: OFF
Min Extent (KB): 1000
Initial (KB): 500
Next (KB): 500

Note: SYSTEM, ROLLBACK, and TEMPORARY should be on different disk devices to distribute I/O.

Click Next.

Ignore the Redo Log settings (these will be updated by post-generation modifications.), and click Next.
Ignore the Checkpoint settings, leave the Enable Archive Log box unchecked, and click Next.

Change the following parameters as indicated:

- Block Buffers: 8192
- Processes: 300
- Block Size: 4096

Click Next.

Leave the Trace File Directory settings intact and click Next.

Select the Save information to a shell script setting, and click Finish. In the popup window, accept the default location and enter the file in the format of <sid>master.sh (Example: fi1master.sh). Click OK to save the file. Acknowledge the alert windows that indicate the status of the file creations.

8. Change directory to the location of the saved scripts generated in the previous step:

   % cd $ORACLE_HOME/assistants/dbca
   % ls -l fi*.sh

   This should produce a listing of scripts as per the example below:

   % ls -la fi*.sh
   -rwxr-xr-x   1 oracle   dba          214 Feb 10 20:22 fi1alterTablespace.sh
   -rwxr-xr-x   1 oracle   dba          639 Feb 10 20:22 fi1java.sh
   -rwxr-xr-x   1 oracle   dba          548 Feb 10 20:22 fi1master.sh
   -rwxr-xr-x   1 oracle   dba          253 Feb 10 20:22 fi1replicate.sh
   -rwxr-xr-x   1 oracle   dba          682 Feb 10 20:22 fi1run.sh
   -rwxr-xr-x   1 oracle   dba          4004 Feb 10 20:22 fi1run1.sh
   -rwxr-xr-x   1 oracle   dba          452 Feb 10 20:22 fi1run2.sh
   -rwxr-xr-x   1 oracle   dba          188 Feb 10 20:22 fi1sqlplus.sh

9. Review and edit the scripts that are displayed in Step 8 above; make changes as indicated below to the named scripts:

   - fi*run.sh

   Add the following under maxlogfiles 32.

   maxlogmembers 4

   Add the following text MAXSIZE 800M to the end of the line DATAFILE ‘<file>’ SIZE 400M AUTOEXTEND ON NEXT 1000K.
Replace the LOGFILE component with the following change, editing for the correct file and instance names.

logfile
  GROUP 1 ('/<install_drive>/app/oracle/oradata/fi9/redo01a.log',
            '/<driveA:>/app/oracle/oradata/fi9/redo01b.log',
            '/<driveB:>/app/oracle/oradata/fi9/redo01c.log') SIZE 10M,
  GROUP 2
            ('/<install_drive>/app/oracle/oradata/fi9/redo02a.log',
            '/<driveA:>/app/oracle/oradata/fi9/redo02b.log',
            '/<driveB:>/app/oracle/oradata/fi9/redo02c.log') SIZE 10M;

- fi*run1.sh

Make the following changes to the fi*run1.sh file:

1) Add the following text “MAXSIZE 200M” to the end of the line “CREATE TABLESPACE TOOLS
DATAFILE '<file>' SIZE 50M REUSE AUTOEXTEND ON NEXT 1000K”.
2) Limit rollback segments to 6 (RBS0 - RBS5); delete others

10. Verify the ORACLE_SID entry. If it is not set, set it appropriately (instance name), change directory to the pfile directory for the instance and review/change the init.ora script, as per the example below.

% setenv ORACLE_SID  <fi#>
% cd $ORACLE_BASE/admin/$ORACLE_SID/pfile
% mv init<SID#>.ora init<SID#>.org

Then copy the sample init.ora file and edit per the following example:

% cp /<install_drive>/app/oracle/admin/initfix.ora ./init<SID#>.ora
% vi init<SID#>.ora

where <SID#> is the instance number.

Edit the init.ora file to replace instance, and file specific values that are different from the original file. Verify that rollback segment, and control file names and locations are correct. Update the path for the log_archive_dest_1 parameter (it should match $ORACLE_LOGS/arch).

Note: The control file disk spindles in the init.ora file must match the ones that were specified in the Database Creation Assistant (dbassist). To verify they match, check the init<SID#>.org file that you created above.

11. Verify that all database file directories exist before executing the database creation script.

% ls -la /*/app/oracle/oradata/$ORACLE_SID
% ls -la $ORACLE_BASE/admin/$ORACLE_SID (check for bdump, cdump, udump)
12. Change directory to the location of the database creation scripts and execute the master script, as per the example below:

Note: This is a time consuming task and may take up to several hours, depending upon the speed of your system. You may see many ORA-04132 errors regarding nonexistent objects. These will be created and are normal output.

% cd $ORACLE_HOME/assistants/dbca
% ./<SID>master.sh

Note: If during the process of creating the database, the orapwd file is corrupt or missing it will need to be recreated. To recreate the orapwd file, enter the following commands:

cd $ORACLE_HOME/dbs
orapwd file=orapw<SID> password=<create a password> entries=<a number>

You will have to re-execute the master script at the beginning of Step 12.

13. Review database creation log files for errors.

% cd $ORACLE_BASE/admin/$ORACLE_SID/create
% ls -lat *.log
% grep ORA- *.log | more

14. Change the password for the SYS and SYSTEM accounts, via svrmgrl, as per the example below:

SVRMGR> connect internal
SVRMGR> alter user sys identified by dba<SID#>; (for example for fi6 use dba6)
SVRMGR> alter user system identified by dba<SID#>; (for example for fi6 use dba6)

15. Create an oracle user account to permit scheduled exports, using svrmgrl, by copying and pasting the following text into the svrmgrl session:

SVRMGR> connect internal
SVRMGR> CREATE USER "ORACLE" PROFILE "DEFAULT"
 2> IDENTIFIED EXTERNALLY
 3> DEFAULT TABLESPACE "USERS"
 4> TEMPORARY TABLESPACE "TEMP"
 5> QUOTA UNLIMITED ON TEMP
 6> QUOTA UNLIMITED ON USERS
 7> ACCOUNT UNLOCK;
SVRMGR > GRANT "CONNECT" TO "ORACLE";
SVRMGR > GRANT "EXP_FULL_DATABASE" TO "ORACLE";
SVRMGR > ALTER USER "ORACLE" DEFAULT ROLE ALL;
16. Edit the `oratab`, as `oracle`, in `/var/opt/oracle` and change the third field from `no (N)` to `yes (Y)` so that the database is brought up when the server is rebooted. Also make sure that the path is preceded by `ORACLE_SID` parameter followed by a colon as shown below (the example is for a database instance with `ORACLE_SID = fi1`).

```
fi1: /<install_drive>/app/oracle/product/8.1.6:Y
```

17. Login in as `root` and copy a file named `dbora` into the `/etc/init.d` directory, if it does not already exist.

```
# cp /<install_drive>/app/oracle/admin/dbora /etc/init.d/dbora
# ls -la /etc/init.d/dbora
```

18. Link `dbora` by entering the following:

```
% ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora
% ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora
```

19. Remove any previous versions of Oracle startup scripts by completing the following:

```
# cd /etc/init.d
# rm oracle
# cd ..
# rm -i rc?.d/[KS]*oracle
```

20. Reserve a port for the Net8 listener by making the following entry in the `/etc/services` file (insert this in port number sequence).

```
listener_name 1521/tcp # Net8 listener
```

21. Copy the original SQL*Net files (`sqlnet.ora`, `listener.ora`, `tnsnames.ora`) from `/var/opt/oracle` to the `$ORACLE_HOME/network/admin` directory (they are compatible with Net8).

```
% cd $ORACLE_HOME/network/admin
% cp /var/opt/oracle/*.ora .
```

Change the hostname, instance name, and `$ORACLE_HOME` path to the correct identity for the server that you are working on.

If the copy command above fails, enter the following commands:

```
% cd /<install_drive>/app/oracle/admin
% cp -p listener.ora tnsnames.ora sqlnet.ora $ORACLE_HOME/network/admin
```

Modify the files in the destination path to match your site’s server and database instance names. Be sure to include listener definitions for the whole site in the `tnsnames.ora` file.
22. Verify the listener status.

% lsnrctl
LSNRCTL>status

If the response to the status command lists a summary of approximately 10 parameters, and one of these is uptime, then the listener is running. Exit by typing:

lsnrctl>exit

If the listener is not working, then start it by typing:

lsnrctl>start

23. Switch user to femis and link the oracle environment parameter file to the femis home directory to preserve environment file setting integrity.

% su - femis
% ln –s ~oracle/.oraclerc

24. Switch user to oracle, and put the database in archive mode.

% su - oracle
% svrmgrl
  SVRMGR> connect internal
  SVRMGR> shutdown immediate
  SVRMGR> startup mount;
  SVRMGR> alter database archivelog;
  SVRMGR> archive log list;
  SVRMGR> shutdown immediate
  SVRMGR> startup
  SVRMGR> exit

2.3.3.3 Installing and Using Oracle Documentation

Note: The following application are required to view the Oracle documentation:

  HTML: Netscape Navigator 3.0 (or higher) or Microsoft Internet Explorer 3.0 (or higher).
  PDF: Acrobat Reader 3.0 (or higher) or PDFViewer Web browser plug-in 1.0 (or higher).

Complete the following steps to install the Oracle v8.1.6 software.

1. Log completely off and back onto the server as oracle with the group set to oinstall.

  % id should return something like uid=26000(oracle) gid=26002(oinstall)
2. Insert the Oracle8i On-Line Generic Documentation CD into the CD drive.

3. Mount the CD

$ cd /cdrom/816_docs

4. Run the installer. Click Next on the Welcome window.

runInstaller &

5. Select a product to install, when prompted by the installer, navigate to the CD-ROM, and locate the file /INSTALL/docs_816.jar. Select this file as your source.

Install the documentation into the $ORACLE_DOCS directory that exists if a previous version of Oracle has been installed. If the directory does not exist, see Step 3 in Section 2.3.3.5, Configuring Existing Oracle for Latest Version of FEMIS. If $ORACLE_DOCS is set, the documentation will be installed there regardless of the destination setting specified in this window.

Click Next to verify the product list is correct.

Click Install on the Verification window.

To view the HTML and PDF documentation from a local installation or from the CD-ROM, follow these steps:

1. Use your browser to open the top-level index.htm file within the installed documentation directory.

   **Note:** If you do not wish to launch the Information Navigator Java applet, open the file products.htm instead of index.htm.

2. Click on the category of documentation you wish to view (Server and Data Warehousing, Application Development, Networking and Security, Parallel Server, interMedia, Java, or WebDB).

3. Click on the HTML or PDF link, on the resulting product-level index file, corresponding to the book you wish to view. Clicking the HTML link takes you to the table of contents for that book; clicking the PDF link displays the appropriate document using your installed Acrobat products or your browser's Acrobat plug-in.

**2.3.3.4 Relinking the Oracle Software**

**Note:** If you have Oracle v8.1.6 installed but were required to install, upgrade, or patch the operating system, then complete this section to relink the Oracle software.

If you just completed the steps in Section 2.3.3.2, Installing the Oracle Software, then skip this section because Oracle has already been relinked.
1. Shutdown Oracle by logging in to UNIX as the oracle user and complete the following:

   % svrmgrl
   SVRMGR>connect internal
   SVRMGR>shutdown immediate
   SVRMGR>exit

2. Relink the Oracle software.

   % cd $ORACLE_HOME/bin
   % relink all

   This process may take several minutes to complete. It will produce a large amount of output, which is normal. Some error output will occur regarding portions of Oracle that are not installed, which is normal. As long as the last messages prior to link completion do not indicate fatal errors, you can assume the link was successful.

3. Restart Oracle.

   % svrmgrl
   SVRMGR>connect internal
   SVRMGR>startup
   SVRMGR>exit

2.3.3.5 Configuring Existing Oracle for Latest Version of FEMIS

   Note: If you already had Oracle v8.1.6 installed and are upgrading FEMIS, then you must complete this section.

   If you have just installed Oracle per the steps in Section 2.3.3, Installing Oracle or Relinking Oracle, then skip this section, and go to Section 2.3.4, Defining the Database Topology.

1. Copy the template files to the admin directory.

   % cp -r /home/femis/install/oracle_template/* /<install_drive>/app/oracle/admin
   % chown -R oracle /<install_drive>/app/oracle/admin
   % chgrp -R dba /<install_drive>/app/oracle/admin
   % chmod -R 755 /<install_drive>/app/oracle/admin

2. Copy the new Oracle UNIX setup files to the installation directory.

   Note: If you previously had FEMIS installed, you should compare your existing configuration files with the new ones. If your existing files have been customized, then do not overwrite them but complete Step 3 to make sure the values are still correct for this server.


% cd /<install_drive>/app/oracle/admin
% cp -p oracle.mycshrc /<install_drive>/app/oracle/.mycshrc
% cp -p oracle.cshrc /<install_drive>/app/oracle/.cshrc
% cp -p oracle.oraclerc /<install_drive>/app/oracle/.oraclerc
% cp -p oracle.login /<install_drive>/app/oracle/.login

3. Make sure the following environment variables are correct. Also make sure that all directories specified by the parameters exist and have their owner, group owner, and mode set to oracle, dba, and 755 respectively. These can be set using the chown, chgrp, and chmod commands.

ORACLE_TERM (set it to match the xterm for the given keyboard: xsun or xsun5)
ORACLE_BASE = /<install_drive>/app/oracle
ORACLE_HOME = /$ORACLE_BASE/product/8.1.6
PATH includes:
    $ORACLE_HOME/bin
    /usr/local/bin
    /bin
    /usr/bin
    /usr/ccs/bin
ORACLE_SID = fi<x>
ORACLE_DOC = $ORACLE_HOME/doc
LD_LIBRARY_PATH=/usr/lib:/usr/dt/lib:/usr/ucblib:/usr/openwin/lib:/$ORACLE_HOME/lib
    /usr/openwin/lib:
ORACLE_EXPORT = /<driveA>/app/oracle/fix<x>/export
ORACLE_LOGS = /<driveA>/app/oracle/fix<x>/logs
ORACLE_FULL = /<driveB>/app/oracle/fix<x>/full
ORACLE_COLD = /<driveB>/app/oracle/fix<x>/cold
CLASSPATH = $ORACLE_HOME/JRE:$ORACLE_HOME/jlib

4. Switch user to femis and copy the oracle environment parameter file to the femis home directory.

% su - femis
% cd ~oracle
% cp .oraclerc /home/femis/.oraclerc

2.3.3.6 Modifying the Initialization Parameter

Due to changes in FEMIS, one of the Oracle initialization parameters may need updating. To determine if changes are necessary, log into UNIX as the oracle user and check the following:

% su - oracle
% cd $ORACLE_BASE/admin/$ORACLE_SID/pfile
% vi initfix<ORACLE_SID>.ora

Look for an entry in this file, e.g., initfix2.ora, like open_cursors = 800. If this line is not present, add it; or if the line exists but the number is less than 800, change the value to 800. If changes are made, the database must be shutdown and restarted (using the following commands) to make the change active.
% svrmgrl
SVRMGR> connect internal
SVRMGR> shutdown immediate    Wait until the database is down, then:
SVRMGR> startup
SVRMGR> exit

2.3.4 Defining the Database Topology

Note:  This section must be completed regardless if this is a new or upgrade installation of FEMIS.

Six configuration files are used to define a topology:

- /home/femis/etc/eoclist.dat: EOC List general topology
- /home/femis/etc/grplist.dat: Group List snapshot groups
- /home/femis/etc/seqlist.dat: Sequence List sequence IDs
- /home/femis/etc/tablist.dat: Table List Table privileges
- /home/femis/etc/vuelist.dat: View List Views
- /home/femis/etc/eocnum.dat: EOC Numbers for this site

The primary configuration file is the EOC List file, ./etc/eoclist.dat, which is used by many of the FEMIS shell scripts. The other configuration files are used only by the Make Configuration (makecfg.sh) code generator.

The EOC List file consists of one record for each EOC database. Each record consists of eight space-separated columns. Except for the Yes/No flag in column five, nothing should be uppercase.

1: EOC name   name of the EOC and Oracle user account
2: Password   initial password for the Oracle user account
3: Server     server where the data is located
4: Listener   Oracle listener name for the account
5: Onpost     Y=onpost database, N=offpost database
6: EOC #      EOC number used for sequence IDs
7: Port       FEMIS notification port
8: Other EOCs Comma-separated list of other EOCs on this server, w/o white space. If none, then 0 is used.
9: Remote EOCs Comma-separated list of remote EOCs, w/o white space. If none, then 0 is used.

The Group List file is used to define the database replication setup. It indicates which tables go in which replication groups, plus which tables must have what kind of snapshots. It contains N major sections, the first one normally for just the one onpost EOC (e.g., tead), and the remaining ones for the offpost EOCs (e.g., ctoo and utst). The onpost section is different from the offpost sections, which are alike except for the EOC name in the first column.

The Sequence List file is used to define the Oracle sequence IDs in the database, which are used to generate unique keys when inserting records into the database.
The `tablist.dat` file controls table privileges for database users. It has one row for each table in the database. It is possible to modify this file at the time of this installation but extreme care must be taken. See Section 4.5, Security Provisions, in the *FEMIS Data Management Guide* for a description of the format of this file.

The `View List` file is used to define which views are created on which tables. The views combine data from other EOCs into a site-wide version of shared tables. For example, the `S_FACILITY` view is a combination of the Facility tables in each of the EOC databases.

The `eocnum.dat` file is the basic file that determines the names of the EOCs at a site and assigns an EOC number to each. This file is used by the Build Topology Program, `bldtopo.sh` and is placed into the `/home/femis/etc` directory as part of the initial installation of a site’s database package. It is preserved throughout the installation of the FEMIS package (Section 2.2.2, Upgrading the FEMIS Application, Step 2).

### 2.3.4.1 Running the Build Topology Program

To define a topology, you must create the configuration files and put them in a standard location using the Build Topology program.

1. Login as `femis`.
2. Copy the `eocnum.dat` file if you have never installed a database package.
   ```bash
   % cp /home/femis/database/exports/<site name>/eocnum.dat /home/femis/etc
   ``
3. Create the configuration files, and place the files in a standard location.
   ```bash
   % cd ~femis/etc
   % ~femis/database/dba/bldtopo.sh
   ``

   The Build Topology program prompts you for information to define the general topology—the EOC List file. If at any point you do not specify something, the program will exit.

   How many servers? =>

   Enter the number of servers in the topology. For example, for a 3x1, enter 1; for a 6x6, enter 6; or for a 8x4 enter 4.

   The build topology program reads the `eocnum.dat` file and displays the information back to the window.

   Enter server name for `<eoc_name>` =>
Each time you get this prompt, you must enter the name of the Sun server where the FEMIS database for the EOC that is listed will reside. For example, for the CTOO database, enter tcemsun.

Enter listener for <eoc_name> ==> 

Enter the Oracle listener name for that server. For example, fi3.

The loop then repeats, asking for the next server and listener until you have supplied all of them. If you have specified an Nx1 topology, then the script will ask you for the server and listener name only once.

After you answer all the prompts, the Build Topology program creates the remaining topology files automatically.

2.3.4.2 Setting Up the EOC DBA Directory (as femis)

As released, FEMIS contains a ~femis/database directory that has a number of subdirectories, none of which should be changed. However, for your own use, you need a working copy of some of the files. Plus, you need to generate brand new SQL scripts that are specific to your database topology. When you have completed the following steps, you will have your own ~femis/database/eocdba directory with all the scripts you will need to manage your FEMIS database.

1. Login as femis.

2. Create a working directory, eocdba, for your own use.

   % cd ~femis/database/dba
   % mkeocdba.sh

3. Generate the scripts used to load the stored procedures.

   % cd ~femis/database/eocdba
   % makeproc.sh

This shell script creates the driver scripts to create (master_cr_procedures.sql) and drop (master_dr_procedures.sql) the stored procedures in all the FEMIS EOC database schemas. The shell script also creates all the actual server-specific files, cr_procedures_SERVER.sql and dr_procedures_SERVER.sql.

4. Generate the scripts used to manage and control the database.

   % cd ~femis/database/eocdba
   % makecfg.sh

This shell script creates a very large number of SQL scripts.
Note: It is essential that all FEMIS servers use the same database topology. Be sure to copy the eocdba and etc directories to all servers in the configuration since every server needs the same files.

2.3.5 Creating or Updating the FEMIS Database

Complete the following sections to create or update the FEMIS database.

2.3.5.1 Creating the Database Schemas

The following steps must be completed on each server in the site configuration. Verify that the files in both the /home/femis/etc and /home/femis/database/eocdba directories were copied to all servers (See Section 2.3.4.1, Running the Build Topology Program). Complete the following steps to create the database schemas.

1. Login as femis.

2. Change to the ~femis/database/eocdba directory.

   % cd ~femis/database/eocdba

3. Skip this step if you are updating the database; the tablespaces already exist.

   To place the files in the desired directory(s), edit the cr_db_ts_<server name>.sql file. If possible, place the fmain and findex tablespaces on different disk drives. Place the fsnapshot and fsnaplog tablespaces on different disk drives as well. For example:

   fmain.dbf /<driveA>/app/oracle/oradata/fi<x> 300M
   findex.dbf /<driveB>/app/oracle/oradata/fi<x> 400M
   fsnapshot.dbf /<driveA>/app/oracle/oradata/fi<x> 500M
   fsnaplog.dbf /<driveB>/app/oracle/oradata/fi<x> 200M

Note: An Nx1 configuration will not have the last two snapshot definition lines above.

4. Run the Master Create Database script for either a new installation or an update.

   Note: Before continuing, this script must be executed at each server in the configuration while logged onto the server locally as femis.

This script creates the new tablespaces and schemas. If you are performing an update, then you will receive error messages stating that the tablespaces and some of the data schemas already exist. Disregard these messages during the update.
Note: In FEMIS v1.4.7, Oracle’s sys schema is required to run the master_cr_db script.
In some previous versions, the system schema was required to run this script.

% sqlplus /nologin
SQL> @master_cr_db_<server name>.sql

Enter <Sys Password> when prompted.

2.3.5.2 Loading Data (as femis)

Note: Depending on what installation steps you have previously completed, you will either update the data in your database, or import data from one of two places and perform the update. Please review this section carefully.

If you installed Oracle v8.1.6 and had a previous version of FEMIS installed, then you will want to import the data that was exported in Step 2 of Section 2.3.2.1, Dropping Database Objects and Exporting Data Owners.

If you did not have a previous version of FEMIS and have installed the GIS and database package (Section 2.3.1, Installing the GIS and Oracle Database), then you will want to import the data found in the /home/femis/database/exports/<site name> directory.

Note: Remember that you need to know where each of the N data owners are for your NxN or NxM database configuration. You will import the data for each data owner exactly one time across all the servers at your site. If you have an NxN configuration, you will perform one import on each server; but for an NxM configuration, some servers will have more than one data owner. You will not import any data into any of the snapshot owners.

1. Login as femis.

2. Complete the Oracle import function.

   % cd /home/femis/database/exports/<site name>
   % imp <USER1>/<PASSWORD> file=<EOC_name>_<EOC_date>.dmp log=<USER1_today’s date>.log
   % imp <USER2>/<PASSWORD> file=<EOC_name>_<EOC_date>.dmp log=<USER2_today’s date>.log
   ...and so on

The actual name of the .dmp files will be specific for your site and may contain a date stamp, e.g., anad_19961210.dmp.

The following is an example for an 8x8 Alabama configuration on a server with the ANAD data owner schema and seven snapshot owner schemas.

   % imp anad/anad file=anad_19961210.dmp log=anad_<today’s date>.log
2.3.5.3 Upgrading Database from Previous Versions of FEMIS

STOP

Before continuing, make sure that the imports for all EOCs have been completed.

Note: Perform the following upgrade only if you had FEMIS v1.4.6 installed, and you are upgrading to v1.4.7. When these upgrade scripts are executed the database structure will be modified for all EOCs at your site. Therefore this upgrade process only needs to be performed once at one EOC.

1. Run the update structure/data scripts to update all the owner schemas and create the scripts for the upgrade from FEMIS v1.4.6 to v1.4.7. All databases must be up and available during this operation.

   % su - femis
   % cd /home/femis/database/upd/V1.4.6_V1.4.7
   % makerun.sh

   Note: If you prefer to run the update in its entirety and review it later for errors, then you can use the makerun_nopause.sh script to create the update scripts without any pause statements.

2. Run the master_run.sql script when you are sure the makerun.sh script executed successfully. The update scripts will now be run one at a time. There are pause statements scattered liberally throughout the scripts. Watch closely for errors as each script is run.

   % sqlplus /nologin
   SQL> @master_run

   Note: If you used the nopause shell script and find errors, you may have to start your build process over from the time of the imports.

2.3.5.4 Creating Objects that Share Data (as femis)

STOP

Before continuing, make sure all servers are online, and the databases for all EOCs are configured for FEMIS v1.4.7.

At this point, you should have schemas on all servers and have loaded the data. You are now ready to create views, snapshots, synonyms, and other replication-support items.

Note: This create process needs to be performed once, but it must be done on the server that hosts the onpost EOC.
The Master Create SQL script (master_cr.sql) runs scripts that create the following:

- sequence numbers (All)
- alternate views (All)
- snapshot logs (NxN, NxM)
- snapshots (NxN, NxM)
- snapshot groups (NxN, NxM)
- synonyms for onpost tables (All)
- site views (All)
- replication tables and code (NxN, NxM)

To run the Master Create SQL script, which can take hours to complete on a multi-server configuration, complete the following:

1. Login as femis.

   % cd ~femis/database/eocdba
   % sqlplus /nologin @master_cr.sql

   You need to watch its progress and occasionally press Enter when prompted. If errors occur, use Ctrl-C to stop the script so you can determine what caused the errors.

2.3.5.5 Creating FEMIS Schema Synonyms

The Oracle FEMIS schema at each instance in the database configuration requires a set of synonyms. Upon the successful running of the master_cr.sql script in the previous section, these synonyms have been created for the onpost server only. For each of the offpost servers, complete the following instructions once for each server.

1. Login as femis.

   % cd ~femis/database/eocdba
   %sqlplus /
   SQL> @cr_femis_<eoc code>_syn.sql
   SQL> exit

   where the <eoc code> is any one of the data owners located at the server being used.

2.3.5.6 Fixing the EOC Table (as femis)

Run the following script once for all EOCs. It will change the Notify port, the UNIX port, the Server name, and EOC number to match the EOC List file. This process needs to be performed once at one EOC to change the EOC data for all EOCs.
1. Login as femis.

   % cd ~femis/database/eocdba
   % fixeoc.sh -fix

2.3.5.7 Setting Up the Oracle Backups

    Note: The following needs to be performed once on all servers.

To set up the crontabs to perform automatic database backups and exports, complete Steps 1 and 2. To perform a full cold backup, complete Step 3.

1. Switch to the femis user, and enter the following:

    su – femis
    % cd ~oracle/admin
    % crontab femis.crontab

   Edit the crontab to replace $HOME with /apps/oracle.

2. Switch to the oracle user.

    su - oracle
    % cd ~oracle/admin
    % crontab oracle.crontab

3. Perform a full backup to another directory by entering the following commands:

    % cd /<install_drive>/app/oracle/admin
    % dbbackup_cold

For more information on the Oracle backups, see Section 13.0, Backup Strategy for FEMIS, in the FEMIS System Administration Guide.

2.3.5.8 Starting Replication (as femis)

Since neither an NxN nor an NxM configuration store data for all EOCs on each server, the data must be replicated by Oracle to make all of the data accessible to all servers. The following script starts the replication process for your configuration.

If you have an Nx1 database configuration, then skip this step.

    Note: The following only needs to be performed once at one EOC.
          Do not start replication until all the FEMIS databases have been installed and configured on all servers at the site.
To start replication, run the Master Start Replication script.

1. Login as femis

   % cd ~/femis/database/eocdba
   % sqlplus /nologin
   SQL> @master_rep_start.sql

### 2.3.6 Configuring the FEMIS Files (as root)

**Note:** The following **needs to be performed once** on all servers.

This section explains how to configure the FEMIS files to accommodate the database topology by running the FEMIS configuration script. Before you run this script, you will need to determine some site-specific values.

Determine the Oracle settings

- `ORACLE_SID`  
  (Example: fi4)
- `ORACLE_BASE`  
  (Example: /files1/app/oracle)
- `ORACLE_HOME`  
  (Example: /files1/app/oracle/product/8.1.6)

The above values can be determined from the Oracle account environment file `/apps/oracle/.oraclerc`, or by logging into the Oracle account briefly and running the `env` command.

If DEI was installed, decide upon the following items

- **FEMX Home Directory**  
  (Default: /home/femx)
- **EMIS Host Computer**  
  (Example: teadsun)
- **EMIS User-Name**  
  (Default: femx)
- **EMIS Password**  
  (Example: femxfer)

The FEMIS configuration script uses the `/home/femis/etc/eoclist.dat`, system settings, the `/home/femis/instaall/femis_info` file, and Oracle database settings to create the FEMIS configuration files, which will be placed in the `/home/femis/etc` and `/home/femis/configd` directories.

**Note:** Before configuring FEMIS files, you **must know** the EOC name, the EMIS transfer account password, and your UNIX server netmask.

To configure the FEMIS files:

1. Login as root.

2. Change the directory to the FEMIS install directory, usually `/home/femis/install`. 
3. Edit the femis_info file so the values match the system setup.

   The Oracle environment variables should be set to match the values given in the ~oracle/.oraclerc file.

   **Note:** You must include the explicit file path for the Oracle directories listed in this file. Automount points will not work in this context.

   The FEMIS DEI variables only need to be set, if the server will be running DEI.

   EMIS_HOST should be set to the server name and the EMIS_USER **must be set to emisx**.

4. Change the directory to /home/femis/install/femis_template/etc.

5. Edit the femisdei.cfg file. Remove or comment out (by placing a “#” character at the beginning of the line) the line that starts with ORACLE_USER.

6. Change the directory back to /home/femis/install.

7. Execute the ./configure_files.sh script. Follow the install prompts for EOC name(s), EMIS transfer account password, UNIX server netmask, and whether Samba paths are generated instead of NFS file paths.

### 2.3.7 Copying files to the /home/femis/user directory

Several files located on the shared directory that PCs map to the M:\ drive are used to patch files and update the Oracle data sources on each PC.

To set this up, you must copy the following files from /home/femis/configd to /home/femis/user.

   fupdate.tpl

Also, you must copy the following files from /home/femis/pc/femmisc to /home/femis/user.

   odbcsub.vbs
   pfemis.vbs

Rename fupdate.tpl to fupdate.bat. When logging in, the FEMIS startup script will execute the FUPDATE.BAT batch file. FUPDATE.BAT can be used to update any file(s) on all FEMIS PCs such as the HOST file or GIS data files. View FUPDATE.BAT for specific instructions.

### 2.3.8 Correcting Group Ownership

Verify the group ownership is correct on the /home/femis, /home/femis/user, and /home/femis/pc/femtools and that they are in the femisrun group. If it is not correct, enter the following command at the UNIX prompt logged in as root.


```
# chgrp femisrun /home/femis /home/femis/user /home/femis/pc/femtools
```

Verify user account directories group membership with the following command.

```
# find /home/femis/user ! -group femisrun -ls | more
```

Typically, this command should not return anything. If it does, then the return will be a list of files and directories that do not have femisrun group membership. This situation may be occurring by design to protect data in certain accounts. Consult the local administrator to determine if this is the case. If this situation was not intended, then correct with the following command.

```
# find /home/femis/user ! -group femisrun -exec chgrp femisrun {} 
```

To correct individual users or groups of users use an argument list and/or wildcard notation for the directory list argument(s) to find. For example, to just correct files belonging to the FEMIS users info and train, the following command would work.

```
# find /home/femis/user/info /home/femis/user/train ! -group femisrun -exec chgrp femisrun {} 
```

### 2.3.9 Verifying the Configuration Files (as femis)

Having run the FEMIS configuration script (Section 2.3.6, Configuring the FEMIS Files), you must now verify whether the configuration files it created are correct.

1. Login as femis.

2. Check that the femis account is setup correctly.

```
% env
    USER=femis
    HOME=/home/femis
    SHELL=/bin/csh
    FEMIS_HOME=<full path>
    LD_LIBRARY_PATH=/usr/lib:$FEMIS_HOME/lib:/usr/ucblib
```

**Note:** Because of the integration of the contents of .oracerc file into the femis environment, some paths may be duplicated in LD_LIBRARY_PATH, or PATH (below). The duplication does not cause any known problems and can be left as is. What is critical is that the /usr/lib path be before any /usr/ucb/lib paths, particularly in the LD_LIBRARY_PATH environment variable.

The ORACLE_SID and ORACLE_HOME environment variables must be set. The values for these are site/server dependent. The ORACLE_SID should be set to the string “fi” followed by a server-specific number. The ORACLE_HOME environment variable will point to the home directory of your Oracle installation.
The PATH environment variable, as a minimum, includes the following:

```
.:/home/femis:/bin:/usr/bin:/usr/sbin:/ORACLE_HOME/bin:/etc:/usr/ccs/bin:$FEMIS_HOME/bin:$FEMIS_HOME/database/dba
```

**Note:** The PATH variable may include /usr/local/bin on those sites where this directory exists so that remote Secure Shell utilities will work for the femis UNIX account.

3. Verify you have the following files if this is an onpost installation.

   /home/femis/etc/femisdei.cfg
   /home/femis/etc/femisdei.prf

4. Validate the /home/femis/configd/hosts file: The HOSTS file should be configured with the correct host names and IP addresses. This file should be a copy of /etc/hosts on the UNIX system.

5. Validate the /home/femis/configd/addodbc.bat file: FEMIS uses the home/femis/configd/addodbc.bat batch file to add all the necessary ODBC (Open Data Base Connectivity) values. Verify that the mapping from EOC code to listener ID is correct in each line. Copy good version of addodbc.bat to /home/femis/user.

   See Section 4.2.8, Validating I:\USER Directory, for instructions on copying this file so that all the FEMIS PCs are setup with the correct ODBC values.

6. Validate the /home/femis/pc/xntp/ntp.conf file: the ntp.conf file should be configured with the correct IP address for the time server.

   The line beginning with “server” must have the correct IP address of the NTP server, which should be one of the UNIX servers on the WAN.

7. Check the system files to verify the FEMIS entries were added.

   /etc/services
   /etc/inetd.conf

   In the /etc/services file, you should see a service named femis setup for port 1776. In the /etc/inetd.conf file, you should see a femis entry pointing at the full file path of the femisd executable.

8. Check the FEMIS startup/shutdown script.

   /etc/init.d/femis

9. Check the FEMIS dot files.

   /home/femis/.femisrc
   /home/femis/.oraclerc
2.3.10 Setting Up the Command Server Configuration File

The access block in the command server configuration file needs to be set up. This set up is **not done automatically** during installation and needs to be set up manually. If this step is not performed and completed correctly, FEMIS Evacuation and any other program needing the command server will terminate with an *Access Denied* error.

During FEMIS UNIX installation, the command server configuration file `cmdserv.conf` is copied to `/home/femis/etc`. Verify that this file exists.

In the `cmdserv.conf` file, locate the access block. This block begins with `[ACCESS]` and ends with `[END]`. The required directives within the access block are deny and allow. Each directive can contain an IP address and an IP subnet mask. These arguments define the range of IP addresses that are to be allowed or denied access to the command server. Also refer to Section 4.0, FEMIS Command Server, in the *FEMIS System Administration Guide* for details on command server syntax.

The correct set up is to deny access by clients on all IP addresses except the ones that specifically are to be allowed. To accomplish this, the first directive should be `deny 0.0.0.0`, and the remaining directives should be combinations of allow and deny to establish the allowed IP address ranges.

The installer needs to obtain the IP address and subnet mask of the LAN on which the UNIX server was installed, along with the same information for all other LANs on the Wide Area Network (WAN).

As an example, the following block is valid for the Oregon/Washington network:

```
[ACCESS]
Deny 0.0.0.0 # deny all except
Allow 198.176.0.0 255.255.248.0 # oregon
Allow 199.233.108.0 255.255.255.0 # benton county
Allow 199.47.32.0 255.255.255.0 # washington
Allow 131.92.39.0 255.255.255.0 # umcd
[END]
```

The above example access block is used on all six Oregon/Washington WAN servers.

To allow additional ranges of IP address to access the command server, simply add the appropriate allow directives in the access block.

Do not copy this file from host-to-host, as the file contains host/site dependent fields, such as host name, site name, Oracle instance name, and full Oracle path. Instead, edit each `cmdserv.conf` file on each host one at a time.
2.3.11 Setting Up femis_event

Note: If all of the UNIX hosts in your WAN have one and only one IP address, then this section can be disregarded. However, if any of the UNIX hosts have dual ethernet interfaces (i.e., they perform router functions, or have multiple IP addresses), then pay special attention to the following workaround.

Interconnections between notification servers are accomplished by including the service port and UNIX host name on the startup command line, e.g., `A> femis_event -c 9020@B 9020@C` where A, B, and C are names of UNIX hosts. For this example of setting up femis_event, assume that host B has multiple IP addresses, and that all such addresses are included in the `/etc/hosts` files on A and other nodes on the network.

First determine which IP addresses for B, and all multiple IP address hosts in the network, is the primary IP address for host B. Log into B’s femis account, and run femis_event with only the `-i` option. You should get a response such as the following:

```
B% femis_event -i
Last build .......... Thu Oct 17 11:54:08 PST 1996
Host name is ..... B
IP address is ..... 111.111.111.111
Port number is ... 9020
```

Next, on all nodes where notification servers are to be executed, ensure there is a unique name in the `/etc/hosts` which resolves to the IP address reported above. For example:

```
A% grep B /etc/hosts
111.111.111.111 B
111.111.222.222 B
```

Be sure to substitute the actual host names for A, B, and C. Edit and modify the host’s file, adding a host, e.g., BB, name which resolves to a unique IP address. For example:

```
A% grep BB /etc/hosts
111.111.111.111 BB
```

From this step forward, you should always refer to the server with multiple IP addresses by the unique name associated with the IP address found in the femis_event-i command. In this example, BB is the IP address name.

Note: Failing to implement the above workaround for UNIX hosts having multiple IP addresses can have disastrous results. Under some conditions, a femis_event process can terminate with a bus error after running out of file descriptors if this workaround is not implemented as described.
2.4 Checking the FEMIS Startup

To check the FEMIS startup, you will need to reboot the server and verify the FEMIS programs are running.

2.4.1 Rebooting the Server (as root)

To activate some of the system-level changes that the FEMIS UNIX Installation script makes, complete the following steps to reboot the server.

**Note:** If you have an Nx1 database configuration, then skip Steps 1 and 4.

1. Login as `femis`, and stop master replication.

   ```
   % cd /home/femis/database/eocdba
   % sqlplus /nologin @master_rep_stop.sql
   ```

2. Login as `root`.

3. Enter the following on a Solaris machine:

   ```
   # /etc/init 6
   ```

   As the server reboots, note the status messages during the startup of the FEMIS processes.

4. Login as `femis`, and start replication.

   ```
   % cd /home/femis/database/eocdba
   % sqlplus /nologin @master_rep_start.sql
   ```

2.4.2 Verifying the FEMIS Programs (as femis)

After the server has rebooted, verify that the FEMIS programs are running.

Login as `femis`.

For an NxN configuration, there should be one FEMIS Notification Server process running. For an Nx1 configuration, there should be N of them running. For an NxM, there should be one FEMIS Notification Server process for each EOC per server in the configuration.

```
% ps -ef | grep femis_event
```
If it is not running, restart it with logging turned on.

    % startnotify -log

Then use the Show Notify utility.

    % shownotify aux

Refer to Section 3.0, FEMIS Notification Service, in the *FEMIS System Administration Guide* for more information.

If DEI should be running, check it also.

    % ps -ef | grep femisdei

If it is not running, check the log file /home/femis/log/femisdei.log, to see what happened. The most common problem occurs when DEI cannot connect to Oracle. Check the configuration file, /home/femis/etc/femisdei.cfg, and restart DEI by typing femisdei. Refer to Section 7.0, FEMIS Data Exchange Interface (DEI), in the *FEMIS System Administration Guide* for more information.

### 2.5 Utility to Add FEMIS Login Account to the Database

The `adduser` utility enables you to add a FEMIS login account for a FEMIS user to the database. To use the utility, follow the procedure in the example, substituting the new login account name for `wayne`.

**Note:** The `adduser.sh` script will try to add an account to each database specified using the database password found in `/home/femis/etc/eoclist.dat`. The second column in this file is the password column. If the database password has been changed for security or other reasons, then this file is kept deliberately out of date. If you need to run `adduser.sh` against a particular database that has changed its password, temporarily update the `/home/femis/etc/eoclist.dat` file to contain the proper database password in the second column before actually running the `adduser.sh` script. After running the script, restore the `/home/femis/etc/eoclist.dat` to its original condition.

To create a FEMIS login account for `wayne`, complete the following steps.

1. Login as `femis`.

2. Run the `adduser.sh` script with the appropriate command line parameters.

   To add a login account for a specific EOC, run

   ```
   % adduser.sh -user wayne -eoc <eocname> -run
   
   where <eocname> must be in lower case.
   ```
or

To add a login account on all EOCs in the configuration, run

% adduser.sh -user wayne -all -run

This script will create and run an SQL script to add the user to the database and give the new user all privileges. It takes a long time to run.

The script does the following:

- Adds a mostly empty record for the user to the PERSON table.
- Adds a record to the FEMIS_USER table.
- Adds many records (>200) to the USER_MODE_PRIV table.

You should then be able to login to FEMIS on the PC as the new user (wayne) with the password femis.

### 2.6 FEMIS AutoRecovery System Description and Installation

**Note:** You must have the FEMIS Perl package installed to use AutoRecovery, see Section 2.1.6, Installing Perl v5.004-04.

The FEMIS AutoRecovery system is used to monitor the FEMIS server and application.

The following files are used, generated, or they indirectly affect the FEMIS AutoRecovery system:

/opt/local/bin/femis_watch
/opt/local/bin/femis_watch.conf (typical path)
/opt/local/bin/logit
/var/log/femislog[1-7]
/tmp/auto.debug
/tmp/autorecovery.pid
/var/tmp/autorecovery.run
/home/femis/etc/eoclist.dat
/etc/syslog.conf

The two files, femis_watch and femis_watch.conf, are Perl scripts that comprise the heart of the FEMIS AutoRecovery system.
The FEMIS AutoRecovery system is run by cron. The run schedule is set in the root crontab. The default schedule is

Mon thru Fri
7:00a to 6:00p - run AutoRecovery every ten minutes
6:00p to 7:00a - run AutoRecovery every half hour
Sat & Sun - run AutoRecovery hourly

To change the run schedule, edit the root crontab. See the UNIX man page on `crontab` before proceeding.

% su -
# crontab -e

### 2.6.1 Messaging Service

The AutoRecovery system uses three messaging services: logging, E-mail, and FEMIS Notification Service. By default the three messaging services are enabled.

To disable any of the messaging services, comment out the appropriate line in the file:

```
/opt/local/bin/femis_watch.conf
```

For example, to disable syslog messages, comment out the following line:

```
$syslog_it = 1;
```

To disable E-mail messages, comment out the following line:

```
$mail_it = 1;
```

To disable notification through the FEMIS Notification Service, comment out the following line:

```
$notify_it = 1;
```

### 2.6.2 Logging

AutoRecovery logging is performed through syslog and can be configured with the following levels:

- `warn` – log only warning messages
- `notice` – log warning messages and restart messages
- `info` – log all reported messages

The default log level is `info`. 
To log both warning and restart messages, complete the following steps.

1. Edit `/etc/syslog.conf` and change:

   `local7.info` to: `local7.notice`

   Log archiving is performed by the script `/opt/local/bin/logit`. This script is run nightly from the root crontab. The default number of logs archived is 7 days. The number of days archived can be configured by changing the value for `NUM_OF_DAYS_TO_ARCHIVE` in the `/opt/local/bin/logit` script.

   The log file is set in `/etc/syslog.conf`. The default log file is `/var/log/femislog`. The log file can be changed by editing `/etc/syslog.conf` and `/opt/local/bin/logit`.

2. Restart `syslogd`.

   ```
   % su -
   # sh /etc/init.d/syslog stop
   # sh /etc/init.d/syslog start
   ```

2.6.3 Sending E-mail

AutoRecovery sends all warning messages via E-mail to the root user by default. This configuration can be changed or added to by editing the file `/opt/local/bin/femis_watch.conf` and changing or adding E-mail addresses to the `$Custodian` line. A **single space** separates each E-mail address. See the example below for clarification:

   ```
   $Custodian = 'root femis admin@smtp.foo.com';
   ```

   E-mail can be sent to any valid SMTP recipient. For instance, addresses can be to real users, local and remote server aliases, other mail gateways, and to files and/or programs for filtering. For syntax, and mail configurations to support expanded E-mail capability, consult your site’s mail server documentation.

2.6.4 Running Processes

AutoRecovery verifies certain processes are running. The processes are defined in `/opt/local/bin/femis_watch.conf`. The format is as follows: daemon name, minimum number of processes, maximum number of processes, time value, restartable flag, and restart command.

The following line is the default configuration for the syslog daemon. The line defines the syslog daemon process `syslogd`. A minimum of one process is to be running, and not more than three. Also, the time value specifies a one second wait before attempting to verify that a restart of the daemon was successful. The daemon is restartable, and the restart command is "sh /etc/init.d/syslog start".

   ```
   [ "syslogd", 1, 3, 1, "sh /etc/init.d/syslog start" ],
   ```
The following line is the default configuration for only one NFS Maestro daemon, and it will restart the daemon if the number of processes is less than one.

```
[ "hclnfsd",1, 1, 1, 1, "sh /etc/init.d/hclnfs stop; sh /etc/init.d/hclnfs start" ],
```

**Note:** To effectively disable process monitoring (which we do not recommend), set min to 0, and max to a high number, such as 500.

The time value, mentioned above did not have functionality in previous versions of FEMIS (formerly known as the status flag). In this version the value specifies a time to wait (in seconds) before verification of a process restart is attempted. This applies to all so-defined restartable processes.

### 2.6.5 Monitoring Swap and Disk Space

AutoRecovery monitors used disk and swap space. The thresholds are defined in `/opt/local/bin/femis_watch.conf` and can be customized for each server.

The following are two examples of configuration changes.

1. Complete the following steps to change the swap space monitoring to report 60% full instead of 80% full:

   Edit `/opt/local/bin/femis_watch.conf`

   Change `$swap = 80;` to `$swap = 60;`

2. Complete the following steps to change the disk space monitoring to report when `/` (root file system) is 90% full:

   Edit `/opt/local/bin/femis_watch.conf`

   Look for the `"@disks = ( "` section.

   Edit the line by changing `[ "/"          , 80 ],` to `[ "/"          , 90 ],`

### 2.6.6 Remote Host Auto-Carve and Auto-Insert

The database design in FEMIS version 1.4.7 now allows AutoRecovery to dynamically remove and reinsert remote servers in a site configuration on the fly. This insertion and deletion primarily affects replicated database data, but also affects messages that AutoRecovery sends out. Four parameters in `femis_watch.conf` control how these functions behave. They are
auto_carve and auto_insert define whether each respective feature is enabled. This is controlled with a zero (disabled) or one (greater than zero - enabled) value. The threshold values define the number of AutoRecovery runs required before the specific action occurs, and are defined in terms of AutoRecovery runs. Zero can be valid values for either threshold, although it is not highly recommended to use this value. Generally, the values shown are recommended.

auto_carve will remove a host from database push replication if the host is down (not reachable, or experiences listener and/or database process errors) for the number defined in $ac_threshold of AutoRecovery runs. For example, on the sixth consecutive failed run with the above set definitions, AutoRecovery will remove the problem server from push replication.

Conversely, as soon as the host becomes available again, on the second successful run of good status, it will be reinserted back into the database replication push configuration.

Please refer to Section 2.1, AutoRecovery, in the FEMIS System Administration Guide for further information.

2.6.7 Remote Process Monitoring

Previous versions of AutoRecovery did not allow any configuration to determination if a remote system was good or bad based on the processes running on that system. This version now has a section in the femis_watch.conf file which defines thresholds and values of processes on remote systems for determining if a remote system is “good” or not. The definition table is called @femismon_proc. This table must not have the entry order changed, nor any entries removed. Ignoring a particular process altogether is accomplished with an ignore flag which is set or cleared in the array definition. The table columns are defined as follows:

<descriptive daemon name>, ignore_flag, min, max
To ignore an entry, set ignore_flag to != 0.

For example:
[ "OraArch", 1, 1, 1 ],

defines the eighth row in the @femismon_proc array. The ignore flag is greater than zero, so this value will be ignored when determining if a remote server is “good” or not. If it were not ignored, an error would be generated if there were less than, or greater than, one remote OraArch processes, and...
the remote server would not have been considered available. The string “OraArch” has no bearing in this array on how the remote search is conducted. It is merely just a descriptive string name for output in the error message.

2.6.8 AutoRecovery’s WatchDog Timeout Parameter

AutoRecovery now has a configurable timeout value. In the event that AutoRecovery were to hang because of problems completing a command or spawned process, it will now force itself to abort processing if it is active for longer than the value defined in

\[
$\text{watchdog\_timeout} = 480; \quad \# \frac{480}{60} = 8 \text{ minutes}
\]

where the value is defined in seconds.

**Note:** Setting the timeout value to something greater than the smallest cron tab interval is an acceptable practice; however, subsequent AutoRecovery runs will complain about a previous run of AutoRecovery not completing and will exit if a run gets stuck. This will continue until the hung AutoRecovery process times out as defined. PNNL recommends that to avoid confusion, the value **be set less** than the smallest cron interval.

2.6.9 Installing AutoRecovery

Remove the previous version of the AutoRecovery package.

```
# pkgrm FEMISar
```

The FEMIS AutoRecovery system has been included with the FEMIS software distribution. FEMIS AutoRecovery requires the FEMIS packaged Perl version 5.004 to run. To install, see Section 2.1.6, Installing Perl v5.004-04. To install FEMIS AutoRecovery, you will need to create a spool directory that will require approximately 1MB of disk space.

1. Login in as root.

2. Insert the FEMIS tape into the tape drive, and enter the following commands as root:

```
# mkdir /<dir>/spool
# chmod 755 /<dir>/spool
```

3. Spool the installation package from the 8mm tape.

```
# pkgadd -s /<dir>/spool -d /dev/rmt/??
```

where ?? is the device number of the tape drive.

Select FEMISar from the available package list.
4. Run the pkgadd utility to install the FEMISar package.

   # pkgadd -d /<dir>/spool

   Select FEMISar and follow the prompts through the installation.

5. Use pkgchk to verify that FEMISar were installed correctly.

   # pkgchk -n FEMISar

   **Note:** The packages installed successfully if no error output is displayed. Report any errors to PNNL.

6. Remove the spool directory.

   # rm -r /<dir>/spool

7. Logout.

**2.6.10 Configuring AutoRecovery**

To configure FEMIS AutoRecovery, complete the following steps.

1. Login as femis.

2. Edit the AutoRecovery configuration file /opt/local/bin/femis_watch.conf. Example:

   % chmod u+w femis_watch.conf
   % vi /opt/local/bin/femis_watch.conf

   Enable/disable Auto-Carve/Auto-Insert as desired and set appropriate thresholds, if necessary.

   Verify the restart commands are correct for all restartable processes.

   Add additional $Custodians to receive E-mail when a problem is detected.

   Verify the $ENV{FEMIS_HOME} variable points to the FEMIS installation directory.

   Verify the $ENV{ORACLE_HOME} variable points to the Oracle installation directory.

   Modify disk thresholds and default disk names; add disks as necessary.

   Replace the host entries in the @network list with the other servers at your site.
Verify the two lines in the `%oracle_tablespaces` definition match the following:

```
SYSTEM => 100,
TOOLS  => 100,
```

Save and exit the file.

Enter `chmod u-w femis_watch.conf`.

3. Edit the FEMISar lines in the root crontab.

   ```
   % su -
   # crontab -e
   ```

   Change `volXX` in the `LD_LIBRARY_PATH = $LD_LIBRARY_PATH : /volXX/` environment variable to reflect the correct Oracle path.

   Uncomment the FEMISar execution lines.

The FEMIS AutoRecovery should start running at the next scheduled FEMIS AutoRecovery (femis_watch) cron event. To verify it is running, check the log file for recent entries.

   ```
   % tail /var/log/femislog
   ```

2.7 AutoRecovery Web Reporting Application

AutoRecovery monitors the FEMIS server and reports any errors to your System Administrator, using a standard E-mail message. Your System Administrator must log into E-mail and examine the messages to determine if a server has a problem. PNNL developed the AutoRecovery Web Reporting application to provide a more generic way for your System Administrator to examine the status of their systems.

Using the AutoRecovery Web Reporting application, messages can be sent to a central E-mail account. The E-mail is processed by AutoRecovery Web Reporting and displayed by a web server. Your System Administrator can view the status of your server using any browser application. AutoRecovery Web Reporting can be expanded to receive E-mail from each EOC. Using this capability allows all System Administrators to status their EOC server messages without installing a web server at each EOC.

2.7.1 Software Requirements

AutoRecovery Web Reporting requires the following applications:

- FEMIS AutoRecovery v2.2
- PERL v5.004-04
• MailTools v1.13 (a PERL extension included in the FEMIS PERL package)
• Apache Web Server v1.3.12

FEMIS AutoRecovery and PERL are packaged separately. The Apache Web Server, and the AutoRecovery Web Reporting scripts are included in the FEMISarw package.

2.7.2 AutoRecovery Web Reporting

If you are upgrading FEMIS, you must remove the previous version of the AutoRecovery Web Reporting package.

2.7.2.1 Removing the AutoRecovery Web Reporting Package

1. Login as root.

2. # pkgm FEMISarw

   Select y to continue when the following prompt displays: Do you want to remove this package?

   Also select y for this prompt: Removing installed package instance <FEMISarw>. This package contains scripts that will be executed with super-user permission during the process of removing this package. Do you want to continue with the removal of this package [y,n,?,q].

3. Verify that the package was removed successfully.

2.7.2.2 Installing AutoRecovery Web Reporting

Note: This package has dependencies on the Perl 5.004. The Perl package must be installed before you can install AutoRecovery Web Reporting.

To install AutoRecovery Web Reporting, which has been included with FEMIS v1.4.7, complete the following steps.

1. Login as root.

2. Insert the FEMIS application tape into the tape drive.

   To create a temporary spool directory, run the following:

   # mkdir /<dir>/spool
   # chmod 755 /<dir>/spool
Spool the installation package from the 8mm tape using the Solaris software installation utility.

```
# pkgadd -s /<dir>/spool -d /dev/rmt/??
```

where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd utility to install the FEMISarw package.

```
# pkgadd -d /<dir>/spool
```

3. Select the FEMISarw application for installation.

4. Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

5. After installing the FEMISarw package select q to quit.

6. Use pkgchk to verify the package was installed correctly.

```
# pkgchk -n FEMISarw
```

7. Ignore the following or similar errors:

```
ERROR: /etc/init.d/apache
   Permission <0700> expected <0744> actual
```

**Note:** If you only see the above output or your system prompt appears with no output, the package installed successfully.

8. Remove the spool directory.

```
# rm -r /<dir>/spool
```

9. Remove the tape from the drive.

### 2.7.3 Configuring AutoRecovery Web Reporting

To configure AutoRecovery Web Reporting, complete the following steps.

1. Login as root.

Two new users, femisar and www (if they do not already exist), are created with the installation of the FEMISarw package.

2. **Be sure to set the femisar password.** Example: `passwd femisar`.
3. Edit /opt/local/apache/htdocs/index.html. Change YOUR_SYSTEM_NAME_HERE to your servername (e.g., tornado.pnl.gov).

4. Edit /opt/local/apache/conf/httpd.conf. Change the Server Admin variable to reflect the E-mail address of your System Administrator.

5. Edit /opt/local/apache/htdocs/femis/mb/index.pl. Change root@localhost to the System Administrator’s E-mail address (e.g., admin@pnl.gov).

6. Edit /opt/local/apache/home/femisar/bin/mail.pl. Change root@localhost to the System Administrator’s E-mail address (e.g., admin@pnl.gov).

7. Edit all html files in the /opt/local/apache/htdocs/femis/help directory. Change http://tornado.pnl.gov to http://YOURSERVERNAME.YOURDOMAIN. Change the E-mail address from root@localhost to the System Administrator’s E-mail address.

8. Run /opt/local/apache/bin/setup_femisarw. When prompted, enter the name of each server that will send AutoRecovery E-mail messages. The script will create a directory for each server with the appropriate permissions.

9. Start the web server.

```
sh /etc/init.d/apache start
```

10. Test the application with a web browser. The address should be http://YOURSERVERNAME.YOURDOMAIN (e.g., http://tornado.pnl.gov).

11. Edit the /opt/local/bin/femis_watch.conf on each server from which you will receive AutoRecovery E-mail, and add femisar to the Custodian list. (e.g., $Custodian = 'femisar@yoursystem.yourdomain').

AutoRecovery Web Reporting is now available for you to use.

## 2.7.4 Customizing AutoRecovery Web Reporting

To customize AutoRecovery Web Reporting, complete the following sections.

### 2.7.4.1 Setting the $retainFlag Variable

The variable $retainFlag in /opt/local/apache/home/femisar/bin/clean.pl is used to control how old messages are removed from the MessageBase. The string is comprised of three parts. The first part is a single letter that specifies what method to use to remove the messages.

- If the letter is a p (pruned), then messages that are older than the current date minus the specification in the next two parts are removed.
• If the letter is a \( t \) (truncated), messages are removed at a time that is a multiple of the unit specification and modulus of the unit specification. In other words, if the span and unit specification is a \( 1d \) (1 day), then the messages that are older than midnight GMT of the previous day would be removed.

The next two parts are the number of units and the type of the unit. The number must be a positive whole number or 0. The unit code may be one of the following: \( s, m, h, d, \) or \( w \), which stand for seconds, minutes, hours, days, or weeks. These number and type of units could be used in a specification, such as \( t0d \) that would remove all messages before the current day (GMT).

The default is set to \( p24h \).

### 2.7.4.2 Changing the Refresh Rate

To change the refresh rate of the AutoRecovery Web Reporting application, edit 
/\opt/\local/apache/htdocs/femis/mb/index.pl. The default is set to 60 seconds. To change the default value, change content="60" to your preferred refresh rate.

### 2.7.4.3 Accurate System Time

Proper operation of a public web server requires accurate time keeping, since elements of the HTTP protocol are expressed as the time of day.

### 2.7.4.4 Customizing the Apache Web Server

For additional information on customizing the Apache Web Server, see the online manual at http://YOURSERVERNAME/manual or go the Apache Web Page at http://www.apache.org.
3.0 FEMIS GIS Migration and Configuration

This section provides the instructions to migrate/upgrade and configure the FEMIS GIS to v1.4.7. This process can occur without overwriting any customization that has been done for your EOC.

The v1.4.7 migration and configuration of GIS files on the servers should proceed as follows:

- For each server at the site, determine which of the following three situations applies.
  1. The server contains FEMIS v1.4.6 GIS files that have not been customized or altered in any way.
  2. Some customization changes have been made to the v1.4.6 GIS files on the server, but the EOC does not wish to preserve those customizations.
  3. Some customization changes have been made to the v1.4.6 GIS files on the server, and the EOC wishes to preserve those customizations.

- On one of the servers in Group 1, perform a complete GIS server upgrade (Section 3.1, Migrating the FEMIS GIS from v1.4.6 to 1.4.7).

- On each of the remaining servers in Group 1 and all of the servers in Group 2, delete all of the existing GIS files and replace them by copying all of the GIS files from the server on which the initial GIS server upgrade was performed (see previous bulleted item). See Section 3.2, Copying the v1.4.7 GIS Files to the Other Servers, for detailed instructions.

- On each of the servers (if any) in Group 3, perform an individual GIS server upgrade (Section 3.1). This is necessary to preserve customization changes.

  **Note:** As a precaution, you should backup the /home/femis/gis directory, which has v1.4.6 on the server, using `cp -rp /home/femis/gis /home/femis/gis146` before making any changes to the GIS files.

3.1 Migrating the FEMIS GIS from v1.4.6 to v1.4.7

The FEMIS Setup program will not be able to install the GIS to the PCs until the GIS upgrade has been completed. The GIS upgrade will be performed from a PC with FEMIS V1.4.6 installed and the upgraded files will be written to the server.

  **Note:** If possible, select a PC on which the GIS has not been customized for performing this migration process.
1. Install the v1.4.7 PC COTS on one PC. See Section 4.1, Installing the PC COTS, for instructions. For the FEMIS GIS migration from v1.4.6 to v1.4.7 to proceed, the PC that the v1.4.7 FEMIS GIS migration is performed on must have the v1.4.7 PC COTS, a v1.4.7 Oracle database, and a valid C:\WINNT\FEMIS.INI file. If there is not a current C:\WINNT\FEMIS.INI file, see Section 3.1.5.4, Editing the FEMIS.INI File for the GIS Upgrade.

2. Open a telnet window from a PC, and login as user femis.

3. Go to the FEMIS GIS directory.
   
   cd /home/femis/gis

4. Run the chmod_gis.sh script
   
   chmod_gis.sh

5. Exit the telnet window.

6. Map i:\ drive on the PC to the server /home/femis/ directory. Connect to the drive as the user femis.

7. Copy the i:\gis\femisgis_utilities.apr file to the local GIS directory.

### 3.1.1 Upgrading the femisgis.ini Files to v1.4.7

Complete the following steps to upgrade the femisgis.ini files to v1.4.7 from a PC with FEMIS v1.4.6 installed, v1.4.7 COTS, and a valid C:\WINNT\FEMIS.INI file as specified in Step 1 above.

**Note:** The following steps may encounter files permissions on destination files placed on the UNIX server. Adjust permissions accordingly on the UNIX file server to allow file placement to occur.

1. Map i:\ drive on the PC to the /home/femis directory on the server if not done so already. Connect to the drive as the user femis.

2. Open the FEMISGIS_UTILITIES.APR on the PC by double clicking on the file using Windows Explorer. The file is usually located in C:\femis\gis directory but can be on a different drive if the GIS was installed in a different location than the default. This will start ArcView GIS v3.1.1.

3. Select Upgrade INI V146 -> V147 from the Utilities menu.
   
   A file dialog box displays requesting the name of an ini file on the UNIX server.

4. Find and select i:\gis\<site code>_apr\fgis_lg.ini. Click OK.
   
   A file dialog box displays requesting the name of an ini file on the UNIX server.
5. Find and select `i:\gis\<site code>_apr\fgis_md.ini`. Click OK.

A file dialog box will open requesting the name of an ini file on the UNIX server.

6. Find and select `i:\gis\<site code>_apr\fgis_sm.ini`. Click OK.

### 3.1.2 Checking the Upgraded v1.4.7 femisgis.ini Files

1. Map `i:\` drive on the PC to the `/home/femis` directory on the server, if not done so already. Connect to the drive as the user `femis`.

2. Open the `FEMISGIS_UTILITIES.APR` on the PC by double clicking on the file using Windows Explorer. The file is usually located in `C:\femis\gis` directory but can be on a different drive if the GIS was installed in a different location than the default. This will start ArcView GIS v3.1.1.

3. Select `Check INI Themes` from the Utilities menu. A file dialog box displays. Find the Large `femisgis.ini` file (`fgis_lg.ini`) and click OK. This will create a message box and error log file of missing themes from the `femisgis.ini` files in the local GIS directory. Click OK. If there are any missing themes reported, see Section 3.1.5, Troubleshooting the Migration.

   A message box will appear reporting any duplicate theme names or theme legend names in the `femisgis.ini` file. If there are duplicate theme and/or legend names, open a text editor and change the theme name and/or legend name to a unique name. Save the file and repeat Step 3 of above.

4. Repeat Step 3 for the Medium (`fgis_md.ini`) and Small (`fgis_sm.ini`) files.

   **Note:** If there are INI files for each EOC (e.g., Maryland), the `fgis_sm.ini`, `fgis_md.ini`, and `fgis_lg.ini` files must be upgraded for each EOC.

### 3.1.3 Upgrading the Zone Theme

**Note:** The following steps may encounter files permissions on destination files placed on the UNIX server. Adjust permissions accordingly on the UNIX file server to allow file placement to occur.

1. Map `i:\` drive on the PC to the `/home/femis` directory on the server, if not done so already. Connect to the drive as the user `femis`.

2. Copy `i:\gis\femisgis_utilities.apr` to the local GIS directory on the PC from which the upgrades will be performed if not already done so in previous steps.
3. Open the FEMISGIS_UTILITIES.APR on the PC by double clicking on the file using Windows Explorer. The file is usually located in C:\femis\gis directory but can be on a different drive if the GIS was installed in a different location than the default. This will start ArcView GIS v3.1.1.

4. Select Upgrade Zone Theme from the Utilities menu.

5. Select the CSEPP On-Post EOC Code at the database login window, and click OK.

6. Login at the ODBC Login prompt with the Database user name (\Application Schema\a) and password.

7. At the Enter Zone Filename prompt, select the zone theme name. Due to varying naming conventions, the zone theme name and path differs by CSEPP site. To find the zone theme name, check the i:gis<sitecode>_apr\femisgis.ini file Zone entry. The Path field will contain the zone theme name.

8. Verify the table is populated with new fields. The zone theme table will be updated with data from the FEMIS database and the zone theme table fields will be rebuilt. After the database has been queried, and the zone theme table is updated, click on the Tables icon in the femisgis_utilities.apr project and open the new table. The table should be populated with new fields (Shape, Zone_id, Zone, Type, Par_pad, Risk_area, Objectname, Objectttype, Objectid, and Population) and records for each zone. If not, see Section 3.1.5.2, Checking the Zone Theme Upgrade.

3.1.4 Upgrading the General Hazard Zone Theme

**Note:** The following steps may encounter files permissions on destination files placed on the UNIX server. Adjust permissions accordingly on the UNIX file server to allow file placement to occur.

**Note:** Perform the following steps only if a general hazard zone theme has been added to your site.

1. Map i:\ drive on the PC to the /home/femis directory on the server if not done so already. Connect to the drive as the user femis.

2. Copy i:gis\femisgis_utilities.apr to C:\FEMIS\GIS on the PC from which the upgrades will be performed.

3. Open the FEMISGIS_UTILITIES.APR in ArcView GIS v3.1.1.

4. Select Upgrade County Zone Theme from the Utilities menu.

5. Select the EOC Code of the Owner of the General Hazard theme (usually the State EOC that contains the depot) at the database login window, and click OK.
6. Login at the ODBC Login prompt with the Database user name (<Application Schema>a) and password.

7. At the Enter Zone Filename prompt, select the general hazard zone theme name. Due to varying naming conventions, the general hazard zone theme name and path differs by CSEPP site. To find the general hazard zone theme name, check the \gis\<sitecode>_apr\femisgis.ini file county entry. The Path field will contain the general hazard zone theme name.

8. Verify the table is populated with new fields. The general hazard zone table will be updated with data from the FEMIS database. After the database has been queried, and the general hazard zone theme table is updated, click on the Tables icon in the femisgis_utilities.apr project and open the new table. The table should be populated with new fields (Shape, Zone_id, Zone, Type, Par_pad, Risk_area, Objectname, Objecttype, Objectid, Eoc_name, and Population) and records for each zone. If not, see Section 3.1.5.3, Checking the General Hazard Zone Theme Upgrade.

9. Close the femisgisUtilities.apr.

### 3.1.5 Troubleshooting the Migration

**Note:** If you have not encountered any problems with the GIS migration, you should skip this section and proceed to Section 3.2, Copying v1.4.7 GIS Files to Other Servers.

If the GIS Migration from v1.4.6 to v1.4.7 did not run successfully, you may have experienced one of the following errors:

- If there were errors experienced during the migration of the femisgis.ini files to v1.4.7 while performing the procedures in Section 3.1.1, Upgrading the femisgis.ini Files to v1.4.7, then see Section 3.1.5.1, Checking the v1.4.6 femisgis.ini File.

- If there were errors experienced during the migration of the Zone theme to v1.4.7 while performing the procedures in Section 3.1.3, Upgrading the Zone Theme, then see Section 3.1.5.2, Checking the Zone Theme Upgrade.

- If there were errors experienced during the migration of the General Hazard Zone theme to v1.4.7 while performing the procedures in Section 3.1.4, Upgrading the General Hazard Zone Theme, then see Section 3.1.5.3, Checking the General Hazard Zone Theme Upgrade.

### 3.1.5.1 Checking the v1.4.6 femisgis.ini File

The migration of the femisgis.ini files from v1.4.6 to v1.4.7 consists primarily of changes to the data records and minor formatting. Errors in the migration of the v1.4.6 femisgis.ini files will be a result of: 1) the migration scripts cannot find/read the files or 2) the v1.4.6 files are not in the correct format.
Perform the following checks.

- The i: drive is mapped to /home/femis as user femis.

- When prompted, the files selected to be upgraded are

  i:\gis\<sitecode>_apr\fgis_lg.ini
  i:\gis\<sitecode>_apr\fgis_md.ini
  i:\gis\<sitecode>_apr\fgis_sm.ini

- The v1.4.6 files are not read-only.

- The femisgis.ini files are in a valid v1.4.6 format (see next section below).

**File Format for v1.4.6 femisgis.ini**

The first lines of the femisgis.ini file are commented out using a single apostrophe at the beginning of the line (‘). These lines are ignored.

[FEMIS_VERSION] – This portion contains information about the version and size of the file. The version should be 1.4.6, the size should be SMALL, MEDIUM, or LARGE and both should have an equal sign (=) as a delimiter. See the example below and in the example v1.4.6 femisgis.ini file at the end of this section.

  [FEMIS_VERSION]
  FEMIS Version=1.4.6
  FEMISGIS Size designation=MEDIUM

[SITE_CODE] – This portion should be the 4-character CSEPP site code. The delimiter is an equal sign (=). See the example below and in the example v1.4.6 femisgis.ini file at the end of this section.

  [SITE_CODE]
  SiteCode=ANAD

[DEFAULT_HAZARD_THEME] – This portion is the default GIS theme. The theme should be zone. The delimiter is an colon (:). See the example below and in the example v1.4.6 femisgis.ini file at the end of this section.

  [DEFAULT_HAZARD_THEME]
  Theme Name: zone

[PROJECTION_PARAMETERS] – This portion is the projection information for the GIS. The femisgis.ini file must have information for the Central Meridian, Reference Latitude, False Easting, False Northing, Scale, and Spheroid. Each parameter is followed by a colon (:) and then the parameter information. See the example below and in the example v1.4.6 femisgis.ini file at the end of this section.
[PROJECTION_PARAMETERS]
Central Meridian: -87
Reference Latitude: 0
False Easting: 500000
False Northing: 0
Scale: 0.99953
Spheroid: SPHEROID_CLARKE1866

[AREA_OF_INTEREST] – This portion is the extent of the area of interest. Each parameter is followed by a colon (:) and then the parameter information. See the example below and in the example v1.4.6 femisgis.ini file at the end of this section.

[AREA_OF_INTEREST]
origin: -126.00| 23.00
size: 58.00| 27.00

'C. Theme parameters – This portion of the femisgis.ini file contains an explanation of the records in the [STATIC_THEMES] and [DYNAMIC_THEMES] sections. All lines in the Theme Parameters section, including the Theme Parameter heading, must be commented with a single quote character (‘). See the example below and in the example v1.4.6 femisgis.ini file at the end of this section.

'C. Theme parameters
'each line of the input table contains the following theme data in sequence:
'0  "Theme", Theme name in the FEMIS Database Femis Object table. Null "" otherwise.

[STATIC_THEMES] – This portion of the femisgis.ini file contains the theme attributes for each static theme in the GIS. See the Theme Comments section for more information about each parameter. There should be 21 items with 20 pipe character (|) delimiters in each record. The fields in the femisgis.ini file are Theme Name, FEMIS Accessible, Type, Load Flag, Visible Flag, Display Order, Label Field, Object Lookup Category, Default Legend, Classification Field, Min Scale, Max Scale, Legend Name, Customize Flag, Symbol, Color, Size, Back Color, Outline Color, Path, and Alternative Prefix. See the example v1.4.6 femisgis.ini file at the end of this section.

[DYNAMIC_THEMES] – This portion of the femisgis.ini file contains the theme attributes for each dynamic theme in the GIS. See the Theme Comments section for more information about each parameter. There should be 21 items with 20 pipe character (|) delimiters in each record. The fields in the femisgis.ini file are Theme Name, FEMIS Accessible, Type, Load Flag, Visible Flag, Display Order, Label Field, Object Lookup Category, Default Legend, Classification Field, Min Scale, Max Scale, Legend Name, Customize Flag, Symbol, Color, Size, Back Color, Outline Color, Path, and Alternative Prefix. See the example v1.4.6 femisgis.ini file at the end of this section.

3.1.5.2 Checking the Zone Theme Upgrade

The migration of the zone theme from v1.4.6 to v1.4.7 depends on a valid v1.4.6 zone theme and a v1.4.7 Oracle database. Errors in the migration of the v1.4.6 zone theme will be a result of: 1) the migration
scripts cannot find/read the zone theme files, 2) the v1.4.6 zone theme files are not in the correct format, or 3) the FEMIS v1.4.7 database was not found.

Perform the following checks.

- The i:\ drive is mapped to /home/femis as user femis
- When prompted, the file selected to be upgraded is
  
i:\gis\<sitecode>\zone\<zone_theme_name>.shp *
- The v1.4.6 file (<zone theme name>.dbf) is not read-only.
- The zone theme table files are in a valid v1.4.6 format. The v1.4.6 zone theme file should contain the following fields: Shape, Zone_id, Zone, Type, Par_pad, Risk_Area, Objectname, Objecttype, Objectid.
- The zone names (Zone and Objectname records) must have a one-to-one correspondence with the zones in the FEMIS database’s ZONE table. To verify, open the FEMIS Data Manager, select ZONE from the list of tables and click Open.
- There must be a one-to-one correspondence with the number of records in the GIS zone theme and the FEMIS database’s Zone table. The GIS zone theme table may not have more than one record with the same Zone field record or Objectname field record. (For a given record, the Zone field record must match the Objectname field record of the same record.) For example, a zone theme table cannot have two Zones named 3-A; however, if the zone table has a Zone field and an Objectname field, both should contain 3-A.
- Users must log into the FEMIS database as user name <Application Schema>a and password. If a user name <Application Schema> is entered, the migration will not complete successfully.

  Note: Due to varying naming conventions, the Zone theme name differs by CSEPP site. To find the Zone theme name, check the femisgis.ini files Zone entry. The Path field will contain the Zone theme name.

3.1.5.3 Checking the General Hazard Zone Theme Upgrade

  Note: This section only applies to those sites that have added a general hazard zone theme (e.g. county-based general hazard zone.)

The migration of the general hazard zone theme from v1.4.6 to v1.4.7 depends on a valid v1.4.6 general hazard zone theme and a v1.4.7 FEMIS database. Errors in the migration of the v1.4.6 general hazard zone theme will be a result of: 1) the migration scripts cannot find/read the general hazard zone theme
files, 2) the v1.4.6 general hazard zone theme files are not in the correct format, or 3) the FEMIS v1.4.7
database was not found.

Perform the following checks.

- The i:\ drive is mapped to /home/femis as user femis.

- When prompted, the file selected to be upgraded is
  
  i:gis<sitecode>< general hazard path><general hazard zone_theme_name>.shp *

- The v1.4.6 file (<general hazard zone theme name>.dbf) is not read-only.

- The general hazard zone theme files are in a valid v1.4.6 format. The v1.4.6 general hazard zone
  theme file should contain the following fields: Shape, Zone_id, Zone, Type, Par_pad, Risk_Area,
  Objectname, Objecttype, Objectid.

- The general hazard zone names (Zone and Objectname records) must have a one-to-one
  correspondence with the general hazard zones in the FEMIS database’s ZONE table. To verify, open
  the FEMIS Data Manager, select ZONE from the list of tables and click Open.

- There must be a one-to-one correspondence with the number of records in the GIS general hazard
  zone theme and the FEMIS database’s Zone table. The GIS general hazard zone theme table may not
  have more than one record with the same Zone field record or Objectname field record. (For a given
  record, the Zone field record must match the Objectname field record of the same record.) For
  example, a general hazard zone theme table cannot have two general hazard zones named Jackson;
  however, if the general hazard zone table has a Zone field and a Objectname fields, both should
  contain Jackson.

- Users must log into the FEMIS database as user name <Application Schema>a and password. If a
  user name <Application Schema> is entered, the migration will not complete successfully.

  **Note:** Due to varying naming conventions, the general hazard zone theme name and path differs
  by CSEPP site. To find the general hazard zone theme name, check the femisgis.ini files
  Zone entry. The Path field will contain the general hazard zone theme name.

### 3.1.5.4 Editing the FEMIS.INI File for the GIS Upgrade

Since the FEMIS Setup program could not be used to install the GIS, some manual editing of the FEMIS
configuration files may be needed. Edit the %WINDIR%\FEMIS.INI file in a text editor to set the GIS
paths as follows:
Go to the [FemisGis] section and edit the following parameters, if they are not correct. Add the values if they do not exist.

[FemisGIS]
GISTopDirPC=<DRIVE>\FEMIS\GIS\<SITE CODE>
ViewmarkDir=M:\GIS\Viewmark
GISEditScript=<DRIVE>\FEMIS\GIS\<SITE CODE>\FEMISGIS.APR
GISTopDirNFS=X:\GIS
GISTopDirUNIX=/home/femis/gis
GisSize=unknown

where <DRIVE> is the drive specification for the GIS installation, such as C:.

Add or edit the following parameters as needed, in the [FEMIS Misc] section.

[FEMIS Misc]
ExerciseNum=0
Site Code=<site code>
EOC Code=<eoc code>

Add or edit the following parameters as needed, in the [<site code>] section.

[<site code>]
_GISTopDirPC=<DRIVE>\FEMIS\GIS\<SITE CODE>
_ViewmarkDir=M:\GIS\Viewmark
_GISEditScript=<DRIVE>\FEMIS\GIS\<SITE CODE>\FEMISGIS.APR
_GISTopDirNFS=X:\GIS
_GISTopDirUNIX=/home/femis/gis

Save the file and exit.

3.2 Copying v1.4.7 GIS Files to Other Servers

Copy the GIS files from the server on which you performed the first GIS migration/upgrade to all of the other servers that do not have customization changes which need to be preserved.

1. Preserve the old GIS data on each server. Log into the remote server(s) and enter the following commands:

   % cd /home/femis/gis
   % mkdir bkp
   % mv <site code>* bkp
2. Create a tar file of the upgraded GIS. This may take a while.

   % cd /home/femis/gis
   % tar cf - <site code>* | compress > <site code>_gis.tar.Z

3. Use FTP to copy the tar file to the target server.

   %ftp <server name>
   Name: femis
   Password: <femis password>
   ftp> cd /home/femis/gis
   ftp> bin
   ftp> put <site code>_gis.tar.Z
   ftp> bye

where <site code> is your site code (lower case), such as anad.
<server name> is the host name of the server you are copying to.
The asterisk (*) is a literal asterisk for wild card expansion.

**Note:** Alternative methods to FTP may be used to distribute the tar file, especially at larger sites
where the number of FTP transfers would be high. However, these methods involve
opening security doors that may require EOC-to-EOC coordination to accomplish. One
mechanism that can work especially well is the UNIX servers’ automount capability and
the /net file system. These alternative methods require a good consistent network
connection to work well. If this is questionable at a site, use the above described FTP
method.

4. Log on to the server to which you copied the tar file and extract the tar file with the following commands:

   % telnet <server name>
   login: femis
   password: <femis password>
   % cd /home/femis/gis
   % zcat <site code>_gis.tar | tar xf -

5. Repeat Steps 2-4 for all of the servers that do not have customization changes that need to be preserved.

### 3.3 Completing the Installation on This PC

Go to Section 4.4, Configuring the PC, to continue and complete the installation on this PC.
Example of a FEMIS GIS.INI file.

'vegis_lg.ini ("large" femisgis.ini for ANAD) -- 01/19/99 (IEM)

[FEMIS_VERSION]
FEMIS Version=1.4.6
FEMISGIS Size designation=LARGE

[SITE_CODE]
SiteCode=ANAD

[DEFAULT_HAZARD_THEME]
Theme Name: zone

[PROJECTION_PARAMETERS]
Central Meridian: -87
Reference Latitude: 0
False Easting: 500000
False Northing: 0
Scale: 0.99953
Spheroid: SPHEROID_CLARKE1866

[AREA_OF_INTEREST]
origin: -126.00| 23.00
size: 58.00| 27.00

'C. Theme parameters
'each line of the input table contains the following theme data in sequence:
'0  "Theme", Theme name in the FEMIS Database Femis Object table. Null "" otherwise.
'1  "FEMIS Access", Feature themes: Yes or no flag of whether the theme is in the Femis object table Image themes: None or the name of an image catalog to be created. The image catalog should be described in one of the entries of this ini file.
'2  "Type", Theme feature type; it must be one of: Image, ImgCat, point, line, polygon, event.
'16.LoadFlag Load the theme ("Yes"), do not load the theme ("No").
'3  "Status", Theme visibility status when forming the apr.
'17 DisplayOrder #1 is the theme at the top of the table of contents, and is loaded last (on top of all the other themes).
'4  "Label Field", Field name used as the default labeling field.
'5  "Obj Category" Femis theme category; it must be one of the types listed in the _HOME\lookup\obj_type.lut file. Currently: zone, abpc, igloo, facility, tcp, road, siren, known_p. If it is "None", then the theme may not be classified using the look up tables. The classification field should also be set to "simple".
'6 Default legend. Enter "simple" for a simple legend to show up, or "classify" for a classification legend.
'7 "Classification Field", The field name to be used in a classified legend. The classified legend will be loaded provided it exists, otherwise it will be created and then loaded. This may happen when the user wants to toggle the simple/classified legend.
'8 "Min Scale", Below the minimum scale, the theme is not displayed.
'9 "Max Scale", Above the minimum scale, the theme is not displayed.
'10 "Legend Name", Name desired for the legend.
'18 Customize The Customization Flag is meaningful only in the Dynamic themes:"Yes" Yes -- Use the current symbolization parameters in this theme line in the INI file (do not overwrite when dynamic theme is updated). No --> Allow symbol parameters in this line of the INI to be ‘overwritten with values from DB when dynamic theme is updated. N/A is for static themes.
'11 "Symbol", Symbol number to be used in a simple classification.
'12 "Color", Foreground and outline color for theme symbols, if they can be colored.
'13 "Size", Symbol size.
'19 BackGround Color BackGround Color of polygonal symbols
20 Outline Color
Outline Color of polygonal symbols

14 "Path"
Appended to the Home value specified in the femis.ini file for the gis data.

15 "Alternate prefix"
Used as a prefix to the "Path" instead of the Home value. Only the load themes script uses this prefix to locate and read alternate source directory for big files. Any auxiliary files will be written using the Home prefix.

21 Dynamic Theme
True or false flag set by the location of theme in the ini file. (in the static or dynamic theme section)
<table>
<thead>
<tr>
<th>Layer</th>
<th>Type</th>
<th>Visible</th>
<th>Draw Mode</th>
<th>Layer</th>
<th>Color</th>
<th>Object Name</th>
<th>Object Type</th>
<th>Object ID</th>
<th>Object Description</th>
<th>Visible</th>
<th>Weight</th>
<th>Height</th>
<th>Width</th>
<th>X-Coord</th>
<th>Y-Coord</th>
<th>Object ID</th>
<th>Object Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLOOD_ceto</td>
<td>yes</td>
<td>Polygon</td>
<td>yes</td>
<td>off</td>
<td>10</td>
<td>ObjectName</td>
<td>None</td>
<td>simple</td>
<td>None</td>
<td>1000</td>
<td>2000000</td>
<td>CETO Flooded Areas</td>
<td>No</td>
<td>36</td>
<td>28</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>kpoly_cstc</td>
<td>yes</td>
<td>Polygon</td>
<td>yes</td>
<td>off</td>
<td>9</td>
<td>ObjectName</td>
<td>None</td>
<td>simple</td>
<td>None</td>
<td>1000</td>
<td>15000000</td>
<td>CSTC Known Polygons</td>
<td>No</td>
<td>8</td>
<td>44</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>FLOOD_cstc</td>
<td>yes</td>
<td>Polygon</td>
<td>yes</td>
<td>off</td>
<td>8</td>
<td>ObjectName</td>
<td>None</td>
<td>simple</td>
<td>None</td>
<td>1000</td>
<td>2000000</td>
<td>CSTC Flooded Areas</td>
<td>No</td>
<td>36</td>
<td>28</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>kpoly_ctal</td>
<td>yes</td>
<td>Polygon</td>
<td>yes</td>
<td>off</td>
<td>7</td>
<td>ObjectName</td>
<td>None</td>
<td>simple</td>
<td>None</td>
<td>1000</td>
<td>15000000</td>
<td>CTAL Known Polygons</td>
<td>No</td>
<td>8</td>
<td>44</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>FLOOD_ctal</td>
<td>yes</td>
<td>Polygon</td>
<td>yes</td>
<td>off</td>
<td>6</td>
<td>ObjectName</td>
<td>None</td>
<td>simple</td>
<td>None</td>
<td>1000</td>
<td>2000000</td>
<td>CTAL Flooded Areas</td>
<td>No</td>
<td>36</td>
<td>28</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>siren</td>
<td>yes</td>
<td>Point</td>
<td>Yes</td>
<td>off</td>
<td>4</td>
<td>Objectname</td>
<td>None</td>
<td>simple</td>
<td>Objecttype</td>
<td>1000</td>
<td>15000000</td>
<td>Sirens</td>
<td>Yes</td>
<td>25</td>
<td>32</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>known_p</td>
<td>yes</td>
<td>Point</td>
<td>Yes</td>
<td>off</td>
<td>3</td>
<td>Objectname</td>
<td>None</td>
<td>simple</td>
<td>Objecttype</td>
<td>1000</td>
<td>2000000</td>
<td>Known Points</td>
<td>Yes</td>
<td>16</td>
<td>44</td>
<td>12</td>
<td>0</td>
</tr>
<tr>
<td>tcp</td>
<td>yes</td>
<td>Point</td>
<td>Yes</td>
<td>off</td>
<td>2</td>
<td>Objectname</td>
<td>tcp</td>
<td>simple</td>
<td>Objecttype</td>
<td>1000</td>
<td>15000000</td>
<td>Traffic Control Points</td>
<td>Yes</td>
<td>26</td>
<td>51</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>facility</td>
<td>yes</td>
<td>Point</td>
<td>Yes</td>
<td>on</td>
<td>1</td>
<td>Objectname</td>
<td>Facility</td>
<td>classify</td>
<td>Objecttype</td>
<td>1000</td>
<td>0</td>
<td>Facilities</td>
<td>Yes</td>
<td>163</td>
<td>50</td>
<td>4</td>
<td>0</td>
</tr>
</tbody>
</table>
4.0 FEMIS PC Installation

The following sections describe the steps needed to install FEMIS on a PC.

4.1 Installing the PC COTS

The order for installing the COTS on a new FEMIS PC is as follows:

1. Windows NT Workstation v4.0 and Windows NT Service Pack 5
2. Hummingbird NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS Client v3.2
3. Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5
4. ArcView GIS v3.1 and v3.1.1 patch
5. Microsoft Project 98 Service Release 1

Installing the following COTS products is optional.

- E-mail application (if applicable)
- Word processor (if applicable)
- Spreadsheet (if applicable)
- Graphics presentation (if applicable).

At the end of this section, PNNL has provided two checklists that can be used for each PC installation.

- FEMIS PC Installation Checklist
- FEMIS PC Validation Checklist.

**Note:** If you have a previous version of FEMIS installed, verify that your COTS software packages are the same version as those listed in the *FEMIS Bill of Materials (BOM)*. If they are the same, proceed to Section 4.3, Installing the FEMIS Client Software, to install the FEMIS application.

4.1.1 Installing Windows NT v4.0

4.1.1.1 Before Installing Windows NT

Issues you should consider before beginning the Windows NT installation include hardware requirements, multi-boot capabilities, installation tips, and storage device detection.
Hardware Requirements

There are two sets of information, which you must consider regarding hardware requirements for Windows NT. First, you must check the *Windows NT Hardware Compatibility List* (HCL) published by Microsoft. This document covers every type and model of hardware that has been tested for compatibility with Windows NT. The list is updated regularly and can be accessed at Microsoft’s Web site (http://www.microsoft.com/hwtest/hcl/default.htm). Check the HCL to **verify that every major component** of your computer system is compatible with Windows NT. If one or more components are not listed, contact Microsoft or the hardware vendor to see if new drivers or compatibility aids are available. If not, you should think twice before installing Windows NT on your computer.

The second requirement that must be considered is minimum hardware requirements, which can be found in the *FEMIS Bill of Materials (BOM)*. If your computer **does not meet these minimum requirements**, it is unlikely that Windows NT will work acceptably on this system.

Multi-Boot

Windows NT can coexist with other operating systems, including MS-DOS, Windows for Workgroups, and Windows 95/98. The Windows NT installation program can detect these operating systems and include them on the Windows NT bootup menu. However, MS-DOS and 16-bit Windows are only supported if they were installed first, before Windows NT. Installing them afterward is strongly discouraged by Microsoft and can cause unreliable Windows NT operation.

Windows NT Installation Tips

Installing Windows NT can be a very intimidating experience. There are many points where the operator must make a choice, but very little information is available about how to choose or the potential consequences of a choice. Fortunately, this problem is not insurmountable. If you plan ahead and collect the necessary information before you begin, the installation process is much easier. Be sure to select **Custom installation**.

After you select Custom installation for Windows NT v4.0, you will be given the following installation options:

- Set Up Only Components You Select
- Set Up Network
- Set Up Local Printer
- Set Up Applications on the Hard Disk
- Gathering information about your computer
- Installing NT networking
- Finishing Setup.

For modular installation, enable the **Set Up Only Components You Select** and **Set Up Network** options and disable the others so you will be able to install printer support and set up applications later.
Storage Device Detection

During the Hardware Setup phase, the Windows NT installation program displays a list of mass storage devices found on your computer. This list includes SCSI adapters and CD drive devices but does not include IDE components. Do not worry--IDE devices are indeed recognized and will be supported by the installation.

Gathering Configuration Information

Prior to installation obtain the following information from your System Administrator:

- Computer name (for each machine)
- IP address (for each machine)
- Subnet mask
- Default Gateway
- Workgroup
- Domain
- DNS (Domain Name System) service search order
- WINS servers, if applicable
- FEMIS server name
- FEMIS server IP address.

If this information is unavailable from the System Administrator, it can be determined by using the steps below to check a previously installed machine–provided one is available. It is important that you have this information prior to installation. This information allows you to setup your NT Networking.

4.1.1.2 Running the Installation Program

**Note:** Before you install Windows NT from the FEMIS COTS CD, read Section 4.1.1.1, Before Installing Windows NT.

You will need to know the 10-digit CD Key number to enter during the Windows NT installation. The CD Key number is located on your licensed Windows NT installation disk.

The CD drive is usually your D:\ drive and will be referred to as the D:\ drive in the following instructions.

You will need to create a formatted DOS partition within the first 2GB of the primary disk on the system you are installing. Use [tp DOS boot floppy and use the fdisk utility to create the partition. Use the format command to format the drive.**
1. Place the FEMIS COTS CD into the CD drive, and enter \i386\WINNT /B at the C:\ prompt.

   **Note:** Be sure to include /B or you will be prompted to insert three formatted disks.

2. At the D:\ prompt, enter \i386, and the Windows NT Setup window will be displayed. Please wait while Setup copies files to your hard drive.

3. Restart the computer and continue with the Windows NT Setup.

4. Press Enter to continue setting up WINNT per the Welcome window that displays.

5. Press Enter to continue installation. Windows NT Setup displays a list of mass storage devices found on the computer. This list includes SCSI adapters and CD drive devices but does not include IDE components. The <SCSI Adapter> and <CD drive devices> will display. This indicates that Setup has recognized mass storage devices in the computer.

6. Page down and select F8 to agree when the Windows NT Licensing Agreement window displays.

7. Press Enter to continue when the Windows NT Setup displays the computer’s hardware and software components.

8. Install Windows NT on the desired partition

9. Setup will install Windows NT on the partition. Leave the current file system intact (no changes).

10. Setup will install WINNT files on the hard disk. Choose the location where you want these files to be installed, a common location is \WINNT.

11. Setup can also examine the hard disks for corruption.

   - To allow Setup to perform an exhaustive secondary examination, press Enter.
   - To skip this step, press the Esc key.

   Though this is not necessary and takes several minutes, we recommend you complete this step.

12. Restart the computer once this portion of the Setup has completed successfully.

   The Windows NT Setup is gathering information about the computer. Advanced users can customize all available setup options. You will be prompted regarding the next three parts of the Setup: 1) Gathering Info, 2) Installing Windows NT Networking, and 3) Finish Setup.

**Part One of Setup—Gathering Info**

14. Enter the name and organization associated with the computer. Click Next.

15. Enter the 10 digit CD Key. The Windows NT registration number is located on the back of the Windows NT CD cover.

16. Enter the computer name.

17. Enter the Administrator password for the Windows NT Administrator account. Repeat this step to confirm the password.

18. It is recommended that you create an Emergency Repair disks for each computer on which Windows NT v4.0 is being installed.

   - Select Yes to create an Emergency Repair disk
   - Select No if you do not want to create an Emergency Repair disk.

19. Click Next.

20. Click Next to accept the default list of components on the Select Components window that displays.

**Part Two of Setup—Installing Windows NT Networking**


22. Click Next accept the defaults: This computer will participate on a network and Wired to the network.

23. Select Start Search to allow Setup to locate the default network adapter. Once the default network adapter has been located click Next.

24. Select TCP/IP Protocol for the networking protocols that are used on your network. This is the protocol used to connect to the Internet and Wide Area Networks (WANs). Check with your System Administrator to see if any additional protocols should be selected. Click Next.

25. Click Next to accept the default—All Network Services. Install the selected components

   - RPC Configuration
   - NETBIOS Interface
   - Workstation
   - Server

   Click Next.

26. Check with your System Administrator about special settings that may be required for the network adapter card and in addition to host name resolution. If there are none, accept the default values associated. Click Continue.
27. Select use Network Parameters, even if they cannot be verified.

28. Click No to use DHCP on the TCP/IP Setup Window that displays.

29. Enter the IP Address, Subnet Mask, and Default Gateway values specified by your System Administrator.

30. Check with your System Administrator to see if the domain is required for Domain Name System (DNS). Select the DNS tab, and enter the domain, if required. The Hostname will have been entered by default when the computer was named. If necessary, select Add DNS Search Order.

31. Select Add Primary and Secondary WINS Servers, if required, for the Windows Internet Name Services (WINS).

32. Accept the default—Enable LMHOSTS Lookup. Check with your System Administrator to see if this is required.

33. Enable DNS lookups, if required. Check with you System Administrator regarding DNS setup configuration.

34. Check with your System Administrator to see if Routing is required. Click the Routing tab, and enable the IP forwarding. Click Apply and OK.

35. Accept the defaulted network components that will communicate using this protocol. Check with your System Administrator to see which items should be selected. The Show Bindings window will display.

   • Click Next to accept the default—All Services.
   • Click Next again to start the network.

36. Select Workgroup, and enter the value.

Part Three of Setup—Finish Setup


38. Select the appropriate Time Zone, and check Automatically adjust clock for daylight savings time on the Date and Time Properties window that displays. Click Close.

39. Accept the default if the system found a video adapter for the computer. Click OK.
40. Select Test to preview settings from the Display Properties window that displays. The GIS operates optimally with a Color palette set to 65536 colors.

   The new mode will be tested. Click OK and wait 5 seconds to determine whether it works properly. Click Yes and OK.

41. Restart the computer for Windows NT to setup and save the previous choices. Select Windows NT4.0 as your operating system. Press Enter.

4.1.1.3 Installing Windows NT Service Pack 5

Service Pack 5 was the current Service Pack issued by Microsoft and was used during the development and testing of FEMIS 1.4.7. It is recommended this service pack be installed to ensure compatibility.

To install Windows NT Service Pack 5, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login into Windows NT as a user with Administrator privileges.

2. Close any open applications.

3. Click Start → Programs → Windows NT Explorer → D:\NT4SP5\UPDATE. Double-click UPDATE.EXE to run the Update program.

4. Check Accept the Software License Agreement checkbox.

5. Check the other checkbox to backup your current files to uninstall the Service Pack at a later time. This requires more disk space.

6. Click Install to install the Service Pack.

7. Click Restart to restart the computer.

4.1.2 Installing an NFS System

For FEMIS v1.4.7, you may install either NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS Client v3.2 for your NFS System. If you will be using Samba to map server drives on the PC, then no NFS software needs to be installed on the PC.

**CAUTION**

Do not install an NFS system until after you have completely installed Windows NT, including the network setup.
If NFS Maestro v6.0.1 or earlier was previously installed on the PC, it **must be removed** before you install NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS Client v3.2.

Versions of Maestro 6.1 or later can be upgraded.

If you have Maestro v6.2 installed, you only need to install the NFS Maestro v6.2.0.2 patch.

### 4.1.2.1 Identifying the Maestro Version

To know if you will need to upgrade to NFS Maestro v6.2 or only install the v6.2.0.2 patch, complete the following steps.

1. Go to `%WINDIR%\SYSTEM32\DRIVERS`.
2. Right click on HCLNFS.SYS.
4. Check the version of the file in the Version tab.

Another way to verify if you currently have NFS Maestro v6.2, or later, is to see if the HCRPCLIB.DLL file in located in `%WINDIR%\SYSTEM32` directory. It is a new file with NFS Maestro v6.2.

### 4.1.2.2 Uninstalling NFS Maestro v6.0.1 (or earlier)

Complete the following steps to remove NFS Maestro v6.0.1 (or earlier). If NFS Maestro has not been installed on the PC, skip this section.

1. Login to Windows NT as a user with **Administrator** privileges.

   1. Click Start → Programs → NFS Maestro → Uninstall.
   2. Click Yes on the NFS Maestro Client – Uninstall window. The default radio button is set to Remove completely from Systems for all Users.
   3. Click Yes when prompted to remove the registry entries, program groups, and installation directory.
   4. Click Yes “I Agree” on the License Agreement window.
   5. Click Yes to restart the computer.

### 4.1.2.3 Installing NFS Maestro v6.2

To install or upgrade to NFS Maestro v6.2, insert the FEMIS COTS CD into the CD drive, and complete the following steps.
1. Login into Windows NT as Administrator.

2. Click Start → Run → Browse → D:\MSTRO62\SETUP.EXE. Click Open and OK to run the SETUP.EXE program.

3. Select the language you want to use. English is the default. Click OK.

4. Click Next on the Welcome Window.

5. Click Yes on the License Agreement window.

6. Select Custom for installation type. Click Next.

7. Click Yes to Allow All Users of this Machine to See this Installation. Click Next.

8. Specify the Maestro Home directory. Click Next to accept the default C:\PROGRAM FILES\MAESTRO.NT.

9. Specify the Maestro User directory. Click Next to accept the default C:\PROGRAM FILES\MAESTRO.NT\USER.

10. Deselect the Jconfig daemon (Java component) from the list of items to install by clicking on it. Click Next and Finish.

    **Note:** The Jconfig daemon requires Microsoft Java Virtual Machine, which is generally not installed on FEMIS PCs. FEMIS does not require this software or daemon to be installed.

11. Click the Skip on the Site Information window.

12. Click Finished on the Site Information window.

13. Click Next or Skip when prompted to create a shortcut on your desktop–this is optional.

14. Click OK in the Scan for NFS Servers window.

15. Verify the following are in the NFS Maestro Client for Windows NT – Configuration window:

    **General Tab**
    
    1. Enter the name of your FEMIS server in the Default Authentication Server field.
    
    2. Check TCP and DOS-style sharing under Default Links.
3. Under Default Protection for User and Group check R W X (Read, Write, and Execute).

   **Note:** If this PC is running the EMIS client, be sure the Filename Capitalization is set to Lowercase.

**Read/Write Settings Tab**

1. Increase the Default Read and Write sizes to the maximum – 65536.

2. Click Close.

   If you get a message about important user files that differ from previous files, click OK, and ignore the message.

3. Click No when prompted to have setup close all applications and restart the computer.

You are now ready to install the NFS Maestro v6.2.0.2 patch.

**4.1.2.4 Installing NFS Maestro v6.2.0.2 Patch**

Complete the following steps to install the Maestro v6.2.0.2 Patch.

1. Login to Windows NT as a user with Administrator privileges.

2. Click Start → Run → Browse → D:\NFSPATCH\NFS6202_NTIT.EXE. Click Open and OK to run this program.

3. Click Continue in Patch Installer window.

4. Click Next in Welcome window.

5. Click Yes in Software License Agreement window.

6. Click Next in Start Copying Files window.

7. Leave Yes selected to have Setup shutdown and restart computer or select No and manually restart the computer after the installation.

8. Click Finish.
4.1.2.5 Running the Parmset Configuration Program

The Parmset Configuration program will run automatically when you log onto the PC after the installation of NFS Maestro 6.2. This program can be rerun anytime by using Start → Programs → NFS Maestro → Parmset. The system has to have been rebooted since the Maestro installation for the Parmset Configuration program to work correctly.

1. Select Continue and run the Parmset Configuration program after setting the following parameters:

   Remote Host: <servername>
   FileSystem: <serverpath>
   UserName: <femis>
   Password: <password>

   Select TCP.

2. Click OK.

   This program takes from 10 to 15 minutes to run. Accept the best transfer rate. The PC will need to be rebooted for the changes to work correctly.

4.1.2.6 Installing Solstice NFS Client v3.2

For an upgrade or new installation of Solstice NFS Client v3.2 on a PC, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login into Windows NT as Administrator.

2. Click Start → Run → Browse → D:\SOLSTICE\SUNWFILE.EXE. Click Open and OK to run this program on the COTS CD.

3. Enter your Solstice NFS Client v3.2 serial number on the User Information window.

   **Note:** If you are upgrading, your old serial number will display but might not work. If you select Evaluation, your product will expire in 30 days, and FEMIS will not work correctly.

   Click Next.

4. Click Yes to continue on the Registration Confirmation window.

5. Accept the default installation directory on the Choose Destination Location window, and click Next.

   If you are upgrading from Solstice NFS Client v3.1+, click OK for the setup to upgrade your current installation.
6. Select Typical installation on the Setup Type window that displays, and click Next.

7. Click Next to configure the software on the Setup Configuration Wizard window.

8. Click Next to accept the Windows Default Name Service.

9. Click Next to start copying files. If prompted, click Yes to overwrite read only files.

10. Select No, I will restart my computer later. Click Finish.

To properly configure Solstice, complete the steps in the following section, Configuring Solstice NFS Client v3.2.

4.1.2.7 Configuring Solstice NFS Client v3.2

To configure Solstice NFS Client v3.2, complete the following steps:

1. Click Start ➔ Settings ➔ Control Panel ➔ Network ➔ Services tab.

   If this is a new installation, you will need to click Add, select the Solstice NFS Client, and click OK.

2. Select the Solstice NFS Client on the Services tab, and click Properties.


4. Select Read, Write, and Execute for the User and Group on the Default File Creation Permissions section. For Other, only select Read and Execute.

5. Select the Use a Specific Authentication Server, and enter your EOC’s server. Click OK and Close the Network window.

   **Note:** The server needs to be running the Solstice pcnfsd daemon. See Section 2.1.4.4, Installing Sun PC NFS Daemon.

6. Click Yes to restart the computer now.

   **Note:** When the computer restarts and is logged into the network, the Solstice NFS Client will try to validate the user name and password on the authentication server that was entered in Step 6. If the user does not have an account on this server or passwords on the PC and server are not the same, you will be prompted for a user name and password for Solstice NFS Client as well as your NT workstation login.
4.1.3 Installing Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5

If a previous version of Oracle SQL*Net and the ODBC driver have been installed, they should be removed. If applications other than FEMIS are using your previous version of Oracle, check with the vendor for information on compatibility.

Oracle can be setup on a PC using multiple versions of Oracle using separate directories and Oracle homes, which is not discussed in this procedure. Since this procedure calls for the removal of the ODBC driver, any DSN (data source name) using the Oracle 7 driver, other than ones created by the FEMIS install, need to be deleted using the ODBC Data Source Administrator located in the Control Panel. You should document the parameters for these DSNs so they can be recreated using the new Oracle ODBC driver. The FEMIS install will automatically change the DSNs for the site you are installing.

4.1.3.1 Uninstalling Oracle SQL*Net Client v2.3.4 and Oracle7 ODBC Driver

If either FEMIS or Oracle has previously been installed on the PC, you will need to perform this section. If a previous version of Oracle has not been installed on the PC, skip this section.

1. Login to Windows NT as a user with Administrator privileges.

2. Click Start → Programs → Oracle for Windows NT → Oracle Installer.

   The Oracle Installer shows your Oracle Home directory where Products Installed at.

3. Save copies of your TNSNAMES.ORA and SQLNET.ORA located in the <Oracle Home>\NETWORK\ADMIN directory. If you have other files you wish to keep in the Oracle Home directory, save them also.

4. Select all Oracle Products installed that are listed in the right column of the Oracle Installer. You can hold the Shift key down and select the first and last product to select them all.

5. Click the Remove button in the center of the window.

6. Click Yes to confirm removal of products.

7. Click OK in Informational window that the Oracle Installer will not be removed.

8. Click Exit to close the Oracle Installer.

9. Delete the Oracle Home directory.

10. Delete the Oracle for Windows NT program directory. Using Windows NT Explorer, browse to C:\WINNT\PROFILES\ALL USERS\START MENU\PROGRAMS. Locate the Oracle for Windows NT directory and delete it.
11. Click Start → Run. Enter regedit in the Open field, and click OK.

12. Right mouse click on the ORACLE key and select Delete under My Computer\HKEY_LOCAL_MACHINE\SOFTWARE.

   **Note:** Be careful when editing the Windows NT registry. Modifying the wrong items can result in a dysfunctional system.

### 4.1.3.2 Installing Oracle Net8 Client v8.1.5

To install Oracle Net8 Client v8.1.5, insert the FEMIS 147 COTS CD into the CD drive, and complete the following steps.

1. Login to Windows NT as a user with Administrator privileges.

2. Click Start → Run → Browse → D:\ORACLE815\SETUP.EXE. Click Open and OK to run this program.

   The Oracle Universal Installer will start.

   Click Next in the Welcome window.

3. Accept the defaults in the Destination Path in the File Locations window.

   - Destination Name: ORAHOME81
   - Destination Path: C:\ORACLE\ORA81

   **Note:** The Destination Name and Path can vary due to previous Oracle installations.

   Click Next.

4. Click Next to install Oracle8i Client v8.1.5 in the Available Products window.

5. Choose Custom in the Installation Types window. Click Next.

6. Check the following boxes in the Available Products window:

   - Net8 Products 8.1.5.0.0
     - Net8 Client 8.1.5.0.0

   - Oracle Installation Products
     - Oracle Universal Installer 1.6.0.9.0
Uncheck the following boxes:

- Oracle Utilities
- Oracle Configuration Assistant
- Development Tools
- Oracle Java Products

**Note:** These are the minimum required products for FEMIS. If you need additional items, they can be also installed, but they may require additional configuration during setup that is not covered in this document.

Click Next.

7. Click Next in Component Locations window.

8. Ensure only TCP/IP is selected in the Oracle Protocol Support window by holding down the Ctrl key and clicking on items to select or deselect them. Click Next.

9. Click Install in the Summary window.

   After Oracle products are installed, the Configuration Tools window will appear, and the Net8 Configuration Assistant will run.

10. Click Cancel in Net8 Configuration Assistant Welcome window.

11. Click OK in Error window that appears.

12. Click Next in the Configuration Tools window.

13. Click Exit in the End of Installation window, and Yes on the message box that appears.

14. Restore your TNSNAMES.ORA and SQLNET.ORA to ORACLE_HOME\NETWORK\ADMIN directory if you are upgrading from a previous Oracle installation.

### 4.1.3.3 Installing Oracle ODBC Driver v8.1.5.5

Oracle Net8 Client v8.1.5 must be installed before you complete the following steps to install the ODBC Driver 8.1.5.5.

1. Click Start → Programs → Oracle Installation Products → Universal Installer.

2. Click Next in the Welcome window.
3. Click Browse → <COTS drive letter>:\ODBC8155\PRODUCTS.JAR in the Source… Path: field. Click Open. Click Next.

4. Click Yes in the Dependencies window that appears.

5. Click Install in the Summary window.

6. Click Exit in the End of Installation window, and Yes on the message box that appears.

### 4.1.4 Installing ArcView GIS v3.1 and v3.1.1 Patch

**Note:** If you reinstall ArcView GIS after having already installed FEMIS, the correct version of the file DEFAULT.APR will be overwritten by the ArcView GIS installation. Copy the DEFAULT.APR file from your C:\FEMIS directory to the <DRIVE>\ESRI\AV_GIS30\ARCVIEW\ETC directory on the PC. If you cannot find C:\FEMIS\DEFAULT.APR, then the file may be copied from /home/femis/pc/femmisc/ on your server.

ArcView GIS v3.1 must be installed on the computer before you install the v3..1.1 patch, and the patch must be installed for FEMIS to work properly.

If an older version of ArcView GIS is currently on the PC, remove it before installing ArcView GIS v3.1.

**Note:** If more than one version of ArcView GIS is installed on the PC, FEMIS will find the most recently installed version. If you have multiple versions of ArcView GIS installed, check the %WINDIR%\FEMIS.INI file after the FEMIS installation is complete to make sure that the file references the correct installation.

### 4.1.4.1 Installing ArcView GIS v3.1

You will need to have the ArcView GIS license number for this installation. The CD key number is located on the ArcView GIS installation disk.

To Install ArcView GIS v3.1, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login to Windows NT as Administrator.

2. Click Start → Run → Browse → D:\AV3.1\SETUP.EXE. Click Open and OK to run this program.

3. Click Next in the Welcome window.

4. Click Yes in the License Agreement window.
5. Choose Local install for installation type. Click Next.

6. Select Custom and other options you may want to install. Click Next.

   **Note:** If you are upgrading, click Yes to replace current installation.

   If you are attempting to upgrade and you are not prompted to replace the current installation, click Back and verify the install destination has ArcView installed.

7. Deselect the Map data and Launch Seagate Crystal Reports 6.0 setup. Click Next.

   **Note:** Map data and Seagate Crystal Reports are not used by FEMIS but can be installed if desired.

8. Click Next to accept the defaults for Program Folders and Existing Folders. The Start Copying Files window displays.

9. Click Finish to start copying the files.

10. Click OK in the information window.

11. Click Yes and Finish on the Setup Complete window to restart the computer.

12. Re-logon to the computer using the same user account that was used to install ArcView.

13. Click Start \ Program Files \ ESRI \ ArcView GIS version 3.1 \ ArcView GIS version 3.1.

14. Enter the name and organization and the ArcView GIS license number. Click OK, and ArcView GIS will start.

15. Deselect the Show this window when ArcView GIS Starts box on the Welcome to ArcView GIS window. Click Cancel.

16. Click File \ Exit to close The ArcView GIS v3.1 application.

### 4.1.4.2 Installing ArcView GIS v3.1.1 Patch

   **Note:** ArcView GIS v3.1 must be installed before installing ArcView GIS v3.1.1 patch.

To Install ArcView GIS v3.1.1 patch, insert the FEMIS COTS CD into the CD drive, and complete the following steps:
1. Login to Windows NT as Administrator.

2. Click Start → Run → Browse → D:\AV3.1 PATCH\AV31PATCH.EXE. Double-click on the to run this program.

3. Click Yes to continue the installation of ArcView GIS v3.1.1 patch.

4. Click Next to accept the default Local Install.

5. Click Next to accept the default destination location.

6. Click Next in the Review Current Settings window that displays inside the Start Copying Files window.

7. Click Finish and reboot the PC before using ArcView GIS v3.1.

4.1.4.3 Creating the ArcView GIS Icon for All Users

The ArcView installation only installs the ESRI Program folder that contains the ArcView GIS 3.1 icons for the user that installed the software. If you would like more than this user to run ArcView from Program folders, you will need to copy the ESRI Program folder to the other users profile. FEMIS does not require ArcView GIS v3.1.1 be in Program folders. You can copy the Program folder from the installer’s user profile to the All Users profile using the following procedure.

1. Login to Windows NT as a user with Administrator privileges.

2. Click Start → Programs → Windows NT Explorer.

   **Note:** You must use Windows NT Explorer to complete the following steps.

3. Browse to the %WINDIR%\PROFILES\<Installation user>\Start Menu\Programs.

4. Right click on the ESRI folder and select Cut.

5. Browse to the %WINDIR%\PROFILES\All Users\Start Menu.

6. Right click on the Programs folder and select Paste.

4.1.5 Installing Microsoft Project 98 Service Release 1

If a previous version of Microsoft Project has been installed, completely uninstall the previous version before completing this installation.
**Note:** If the Microsoft Project 98 Service Release 1 installation was unsuccessful, it is because the data access drivers on the PC have been corrupted. On the FEMIS COTS CD, use the `mdac_typ.exe` file to replace the current data access drivers, and you should be able to successfully install Microsoft Project. For more assistance call the IEM Help desk or PNNL.

You will need to have the Microsoft Project license number during the installation. The CD key number is located on your licensed Microsoft Project installation disk.

To install Microsoft Project 98 Service Release 1, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login into Windows NT as Administrator.
2. Click Start → Run → Browse → D:\msp98sr1\SETUP.EXE. Click Open and OK to run this program.
3. Select Continue on the Close Any Open Applications window.
4. Enter the name and organization information, if requested. Click OK.
5. Click OK to confirm the name and organization.
6. Enter the Microsoft Project CD key number.
7. Click OK to acknowledge the Product ID.
8. Accept the default destination folders.
9. Click Custom Install.
10. Click Data Access and Change Option. Select the Database Drivers Utility option, and click OK.
11. Click Continue to begin copying files.
12. Click OK when the installation is complete.

### 4.1.6 Installing Other COTS

The following COTS products should be installed using the installation documentation for each product.

**E-mail application** (if desired)
Use the standard product installation notes provided with the software.

**Word processor** (if desired)
Use the standard product installation notes provided with the software.
Spreadsheet (if desired)
Use the standard product installation notes provided with the software.

Graphics Presentation (if desired)
Use the standard product installation notes provided with the software.

4.2 Configuring the FEMIS Setup Program

CAUTION

Configuration is only done once at each EOC. Stop PC installation until all configuration has been performed.

Several other files must be configured for your site or EOC. Most of these files should have been configured during the FEMIS UNIX installation but should be validated before installing the FEMIS application on the PCs.

Note: Directories specified below are from the PC. You will need to use the UNIX version of these directories if you are editing files from the UNIX server.

4.2.1 Connecting the Network Install Drive

To connect the FEMIS network drive to the install directory, complete the following steps. The parts in italics are what should be changed.

1. Obtain the shared name of the FEMIS account home directory from your System Administrator. Example: Samba/Solstice – \<server>\femis. Maestro – \<server>\disk#/femis.

2. Open the Windows NT Explorer.

3. Select Tools → Map Network Drive menu option, and fill in the fields in the Connect Network Drive window as follows.

   Drive: I:\
   Path: \<server>\femis
   Connect as: femis
   Enter <network password> when prompted.

The FEMIS network drive will be displayed in the All Folders pane on the left side of the Windows NT Explorer window. Any available drive letter can be used in place of I:\ for the installation drive. However, this documentation will assume that FEMIS is being installed from the I:\ drive.
4.2.2 Validating the I:\CONFIGD\FSETUP.INI File

The FEMIS Setup program uses a configuration file to determine the defaults for the installation. Validate that the I:\CONFIGD\FSETUP.INI file was correctly configured during the server installation.

The first section of the INI file, the [Setup Defaults] section contains entries that set defaults for the Setup program. Starred items (*) are those that should have been configured by the UNIX installation scripts.

- **Site**
  Default site code. This should be the FEMIS four letter code for your site.

- **EOC**
  Default EOC code. This should be the FEMIS four letter code for your site.

- **DestDir**
  Default installation destination directory for new installations. Re-installations and upgrades will default to the current FEMIS path.

- **Version**
  Gives the version of FEMIS for which this instance of FSETUP.INI was created.

- **DateThisFSETUPCreated**
  Gives the build date for this version of FEMIS.

- **mDriveNetPath**
  Path to the FEMIS M:\ drive that the FEMIS startup script will connect. This does not need to be set if you use an alternate method to map the M:\ drive. Enter this specification only if you desire to have fstartup.exe attach the M:\ resources on the majority of PC installations.

- **LocalStartupScript**
  Full path for a local startup script to be run by the FEMIS startup script. This is optional.

- **EMIS_StartupScript**
  Full path to the EMIS startup script file. The FEMIS startup script file will run this file.

The second section of the INI file, the [Sites] section, is used to fill the Site drop-down list in the Select Site and EOC window in the PC Setup program. You can edit this list to limit the possible selections available in Setup. Each site entry must be formatted as SiteNN=<SITECODE> where NN is a two digit integer and <SITECODE> all uppercase. If you shorten the list of sites to a single entry, the user will be forced to accept that entry when running Setup. If you edit the list, the numbering for the sites must be sequential, starting at 01.

Subsequent sections are lists of EOCs for each site in the [Sites] section. Each site listed in the [Sites] section must have a corresponding [<SITECODE> EOCs] section. These sections are used to fill the EOC drop-down list in the Select Site and EOC window in the PC Setup program when the corresponding site is selected on the same window. The EOC list sections can be edited in the same manner as the Site list. Each EOC entry must be formatted as EocNN=<EOCCODE> where NN is a two digit integer and
<EOCCODE> must be all uppercase. If you shorten the list of EOCs to a single entry, the user will be forced to accept that entry when running Setup. If you edit the list, the numbering for the sites must be sequential, starting at 01. EOC list sections that do not have a corresponding site listed in the [Sites] section will be ignored.

### 4.2.3 Verifying the GIS.INI Files on the Server—Maryland Only

The Maryland GIS has one set of INI files (small, medium, and large) for each EOC. Each of the other sites has one set that is used by all EOCs. Consequently, an extra step is necessary in Maryland to ensure that the correct set of INI files are in place before installing FEMIS on the PCs.

The /home/femis/gis/sbcc_apr directory on the server is where Setup will look for the INI files. This directory has a subdirectory for each EOC that contains the three INI files. Before running Setup on the PCs, log onto the server as the user femis and copy the files from the subdirectory for your EOC. For example, at the MEMA EOC, you would log onto the server and enter the commands

```bash
%cd /home/femis/gis/sbcc_apr
%cp ./mema/* ./
```

### 4.2.4 Validating the I:\CONFIG\TNSNAMES.ORA File

The TNSNAMES.ORA file should be configured with the correct database names, listeners, and IP addresses. This file should be a copy of $TNS_ADMIN/TNSNAMES.ORA on the UNIX server. For each listener on each server, it should contain a section like the following. The parts in *italics* are what should be changed. (See Section 2.3.3.2, Installing the Oracle Software, Step 10 to edit the var/opt/tnsnames.ora file):

```ora
fi_ctoo =
  (DESCRIPTION =
   (ADDRESS_LIST =
    (ADDRESS =
      (COMMUNITY = TCP)
      (PROTOCOL = TCP)
      (HOST = ctoosun.utah.gov)
      (PORT = 1521)
    )
   )
   (CONNECT_DATA =
    (SID = fi_ctoo)
  )
  )
...
```

**Note:** The setup program will not copy the TNSNAMES.ORA file to a PC if that PC already has a TNSNAMES.ORA file. See Section 15.2, FUPDATE.BAT in the *FEMIS System Administration Guide* for more details on how to configure FUPDATE.BAT, if you need to update the TNSNAMES.ORA file on all of the PCs that will be running FEMIS.
4.2.5 Validating the I:\CONFIGD\ADDODBC.BAT File

FEMIS uses the I:\USER\ADDODBC.BAT batch file to add all the necessary ODBC data source names to each PC. Verify that the mapping from EOC code to listener ID is correct for each line.

If any changes are made to this file after FEMIS has been installed on PCs, the I:\USER\FUPDATE.BAT file needs to be updated to propagate the updates to all PCs.

4.2.6 Validating the I:\CONFIGD\AUTOEXNT.BAT File

During the installation process, the I:\CONFIGD\AUTOEXNT.BAT file is copied to the %WINDIR%\SYSTEM32 directory, usually C:\WINNT\SYSTEM32. This file should contain the following commands. The <TEMPLATE_HOSTNAME> should have been changed to the name of the FEMIS UNIX server.

```
net stop NetworkTimeProtocol
%WINDIR%\SYSTEM32\PING -w 60000 TEMPLATE_HOSTNAME
%WINDIR%\SYSTEM32\NTPDATE -b TEMPLATE_HOSTNAME
net start NetworkTimeProtocol
```

The AUTOEXNT.BAT file is invoked at boot up. Its purpose is to synchronize time on the PC while bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to be the same as on the UNIX server. After boot up, the usual NTP algorithms apply.

**Note:** Be sure that the last line shown above is present. This line may be deleted by the UNIX setup script that configures the file with the UNIX server name.

4.2.7 Validating the I:\CONFIGD\NTP.CONF File

During the installation process, the NTP.CONF file is copied to the %WINDIR% directory, usually C:\WINNT.

The NTP configuration file on the PC should contain at a minimum one drift file and one-or-more server directives. The format of the drift file directive is driftfile %WINDIR%\NTP.DRIFT, where %WINDIR% usually is C:\WINNT.

The format of the server directive is server <hostname>, where hostname is the name of the UNIX server from which the PC is to acquire time synchronization. Generally, this is the UNIX computer located on the same Local Area Network (LAN) as the PC. PCs should acquire time synchronization first from the closest UNIX computer and not from some distant host on the WAN or the Internet. Distant hosts can be used as a secondary time synchronization source. To designate the primary NTP host, include the keyword, prefer, in the server directive.
As an example, the following NTP.CONF file is the preferred format for NTP configuration. It lists the local UNIX server as the preferred time server and the other (far away) servers as secondary. In this manner, if the preferred host is inaccessible, one of the secondary servers can provide time synchronization:

```
server    <IP address of UNIX server> prefer
server    <IP addresses of other servers on WAN>
server    <IP address of server on the Internet>
driftfile C:\WINNT\NTP.DRIFT
```

The Network Time Protocol service is very sensitive to the format of this file. Occasionally, in transferring this file from between UNIX and Windows computers, extra carriage return characters will be appended to the end of each line in this file. These extra characters are not detectable in a PC editor, but show up as “^M” characters at the end of each line in a UNIX editor, such as VI. These extra characters at the end of a line with a server directive will prevent the Network Time Protocol service from loading correctly. If the Network Time Protocol service does not appear to be working, this should be checked.

For more details on NTP set up and configuration methods, see Section 11.0, Server Network Time Protocol (NTP) Set Up, in the *FEMIS System Administration Guide*.

### 4.2.8 Validating the I:\USER Directory

Verify the following files are located in I:\USER directory. FEMIS uses these files to create the ODBC Data Source Names (DSNs) that are used to connect to the Oracle relational database. These files are also used to update files on each PC as needed (see Section 15.2, FUPDATE.BAT in the *FEMIS System Administration Guide* for more details on how to configure FUPDATE.BAT).

- ADDODBC.BAT
- FUPDATE.BAT
- ODBCSUB.VBS
- PFEMIS.VBS

### 4.2.9 Configuring the I:\PC\FEMTOOLS\FEMIS.DB File

To configure the servers and routers to match your network configuration, you will need the server names for all EOCs at the site. If you have not previously configured a femis.db file, it will not exist. Your PC needs to be able to resolve the host names of all the servers on the network either through a naming service or HOSTS file.

1. Execute a telnet session to the FEMIS server by clicking Start → Run, and enter telnet <server>. Logon using the femis account.
2. Change the Permissions on the /home/femis(pc/femtools directory and the femis.db file (if it exists) by entering the following:

```bash
chmod 775 /home/femis/pc/femtools
chmod 777 /home/femis/pc/femtools/femis.db
```

Do not close the telnet session window.

**Note:** If the FEMIS.DB file’s attributes are set to read-only, then WS_WATCH.EXE will not be able to save the new configuration you create, but it will not give any indication of an error.

3. Run I:\PC\FEMTOOLS\WS_WATCH on the PC.

4. Select File → Load, browse to I:\PC\FEMTOOLS, select FEMIS.DB, and click Open. If FEMIS.DB does not exist, click Cancel.

If the FEMIS.DB you opened does not resemble your network architecture, close WS_WATCH.EXE, delete I:\PC\FEMTOOLS\FEMIS.DB, and restart WS_WATCH.EXE.

5. Select Edit menu item and modify the grid to match your network. To add a system, select Add → Host. An icon will display. Position the icon where you want it.

6. Click once on the new host, and the host information window displays. Enter the following information.

- **Display Name:** <server name>
- **Address/Name:** <server name>
- **System Type:** <server or router>
- **Type:** TCP/IP

7. Click Accept.

**Note:** Repeat Steps 2 through 4 for all FEMIS servers, network routers, and other systems significant to the network at your location. Use the Edit → Add → Line to show appropriate network connections between items.

8. Add lines between hosts to resemble network connections by selecting Add → Line and right click on the beginning and end of the line position.

9. Delete hosts or lines by selecting Delete → Host/Line. Left click on the host to delete. Right click on the line to delete.

10. Select END_EDIT, File → Save As. Save the file as I:\PC\FEMTOOLS\FEMIS.DB. If it is not saved with this name and location, it will not be installed on the PC during setup.
11. Exit WS_WATCHE.EXE.

12. Return to the telnet session to the FEMIS server. Change the Permissions on the 
/home/femis/pc/femtools directory and the FEMIS.DB file located there by entering the following:

   chmod 555 /home/femis/pc/femtools
   chmod 444 /home/femis/pc/femtools/femis.db
   exit

13. Close the telnet window.

4.2.10 Updating Files on All PCs Using FUPDATE.BAT

FUPDATE.BAT is a utility that can be used to update any file(s) on all FEMIS PCs such as the HOSTS file or GIS data files. View the M:\FUPDATE.BAT file itself for specific instructions on how to configure it to update files on all FEMIS PCs.

When updating GIS files, it is necessary to know the path where the GIS was installed and sometimes the size of the GIS that was installed. These can be determined by adding the following line to FUPDATE.BAT.

   call %FemisTopDir%\GIS\<site_code>_ENV.BAT

This will set two environment variable:

   **GisTopDir** – This is the top level directory for the GIS data. For example, it might be C:\FEMIS\GIS\DCD1 if you were in DCD1 and had installed the GIS on your C:\ drive. This environment variable can be useful for sites where people install the GIS on different drives.

   **GisSize** – This environment variable will contain the relative size of the GIS (SMALL, MEDIUM, or LARGE). This environment variable can be useful if you need to update the FEMISGIS.INI files for a site where not everyone installed the same size GIS data.

See Section 15.2, FUPDATE.BAT in the **FEMIS System Administration Guide** for more details on how to configure FUPDATE.BAT.

4.2.11 Updating the PC HOSTS File

Depending on the DNS and TCP/IP configurations for the local PCs, it may be necessary or desirable to update the HOSTS file on PCs as part of the FEMIS installation. If the PC does not have a HOSTS file and one has been configured on the installation server in the /home/femis/configd directory, the PC Setup program will copy that file to the PC. However, if a HOSTS file already exists on the PC, the PC Setup program will not overwrite it.
If it is decided to update the HOSTS file on all PCs, the update should be done using the FEMIS FUPDATE tool. The FUPDATE tool is run as part of the PC Setup program, so updates will be installed when FEMIS is installed. FUPDATE is also run each time a user logs into a PC, so updates, that are configured after one or more PCs have been installed, will still be copied to those PCs.

**Note:** The setup program will not copy the HOSTS file to a PC if that PC already has a HOSTS file. See Section 4.2.10, Updating Files on All PCs Using FUPDATE.BAT, if you need to update the HOSTS file on all of the PCs that will be running FEMIS.

### 4.3 Installing the FEMIS Client Software

This software is for the PC workstations that are connected to the FEMIS data server and contains the FEMIS client software and a collection of GIS theme files. The installation program for the FEMIS client software assumes the necessary COTS packages have already been installed.

The FEMIS client software is installed over the network from a UNIX server. The client software contains over 120 files representing approximately 50MB of file space.

The FEMIS executable and other FEMIS support files will be loaded to the following locations:

- current `%WINDIR%` directory, usually `C:\WINNT`
- `%WINDIR%\SYSTEM32` directory
- `C:\FEMIS` directory
- Microsoft Project directory.

All files needed by the installation process should have previously been copied from the release tape or CD to the server. The files specified in Section 4.2, Configuring the FEMIS Setup Program, should have been configured or validated before the FEMIS client software is installed.

### 4.3.1 Preparation

To prepare for starting to install FEMIS v1.4.7, complete the following steps:

1. Login to Windows NT as Administrator or to a Windows NT account that has Administrator privileges. Setup will abort if it is run from a Windows NT account that does not have Administrator privileges.

2. Verify that all COTS needed by FEMIS are installed on the PC. At the minimum, the following should be installed (the Setup program will also verify that these are installed). You should also consult the *FEMIS Bill of Materials (BOM)* and verify that the correct versions of the software products are installed.
• Microsoft Windows NT
• Oracle Net8
• Oracle ODBC Driver
• ArcView GIS (ESRI)

Note: FEMIS also requires software to allow the PC to map directories on the FEMIS server to logical drives on the PC. If Samba is being used, no additional software is required on the PC. If an NFS software package such as Hummingbird Maestro or Sun Solstice NFS Client is being used, then the client software needs to be installed on the PC.

4.3.2 Running the Setup Program

The FEMIS Oracle database on the UNIX server must be operational before the setup program is run.

1. Close all programs that are running, especially all FEMIS programs, including KeyPrint.

2. Connect your I:\ drive as specified in Section 4.2.1, Connecting the Network Install Drive, if you have not already done this.

3. Run the I:\PC\SETUP\SETUP.EXE program. The setup will bring up several windows that require your response.

Select Site and EOC: This allows you to select the Site and EOC from drop-down lists. The contents of the lists are controlled by the I:\PC\SETUP\FSETUP.INI file.

Select Components: This allows you to select which FEMIS components will be installed. The GIS and Additional Icons components have options that are accessed by highlighting the component and clicking the Change button.

Select Program Folder: This allows you to specify which folder in the Start menu will be used for the FEMIS icons. The default is FEMIS.

Choose Destination Location: This allows you to specify the drive and directory where FEMIS will be installed. If FEMIS has previously been installed on the PC, the default is the last place where FEMIS was installed. If this is the first time FEMIS has been installed on the PC, the default location is C:\FEMIS.
GIS Data Path: This allows you to select a destination for the GIS files. The default location is C:\FEMIS\GIS<site code>.

Note: You may see improved performance from the FEMIS GIS if you choose to install the GIS on a separate physical disk than the one on which you are installing FEMIS.

Start Copying Files: This displays an information window showing the options that have been selected. Select Next to begin copying files.

The next part of the Setup program will take several minutes to configure the PC. You may receive prompts or setup may wait for confirmation before performing some items. Watch and click OK or press Enter, as needed. These configuration operations will:

- Update the FEMIS.INI for the PC name, FEMIS and GIS directories, and COTS paths.
- Open ArcView to convert the FEMISGIS.INI file to v1.4.7 format (if applicable).
- Open ArcView to regenerate the FEMISGIS.APR file.

Note: When the FEMISGIS.APR is generated, the system checks to see if any private GIS ViewMarks exist in the VIEWMARK.ODB file in the M:\[SITECODE]\[USERCODE]\GIS\VIEWMARKS directory. If a file exists, it is assumed valid and will be used so that no old ViewMarks are lost. If no VIEWMARK.ODB file exists, a new file is generated with only one default ViewMark. This same check process is repeated for the shared ViewMarks.

- Add ODBC information for the FEMIS databases.
- Start the NTP service to synchronize time on the PC with the server.
- Create the C:\WINNT\SYSTEM32\AUTOEXNT.BAT file.
- Set the system to use FEMIS’s own GLOBAL.MPT file with Microsoft Project.
- Remove obsolete files from older FEMIS installations.
- Verify the required COTS packages are installed.
- Add FEMIS environment variables, if needed.

4. Select Yes, I want to restart my computer now. on the Setup Complete window. Click Finish.

5. Log back in as Administrator after the computer restarts.

4.3.3 Updating the FEMISGIS.INI File

If the GIS Upgrade option was selected, perform the following steps after the PC has been rebooted. Otherwise, proceed to Section 4.3.4, Regenerating the FEMIS GIS Dynamic Themes.

1. Map the I:\ drive on the PC to the /home/femis directory on the server. Connect to the drive as the user femis.
2. Open the FEMISGIS_UTILITIES.APR in ArcView GIS v3.1.1.

3. Select Check INI Themes from the Utilities menu. A file dialog box displays. Find the <PC FEMIS GIS DIRECTORY>\<SITECODE>\FEMISGIS.INI file and click OK.

   This will create a message box and error log file of missing themes from the FEMISGIS.INI files in the local GIS directory. See Section 3.1.5, Troubleshooting the Migration, if there are any missing themes reported.

4. Click OK.

   A message box will display reporting any duplicate theme names or theme legend names in the FEMISGIS.INI file. If there are duplicate theme and/or legend names, open a text editor and change the theme name and/or legend name to a unique name. Save the file and repeat Step 3 of above.

5. Close the FEMISGIS(Utilities).APR.

### 4.3.4 Regenerating the FEMIS GIS Dynamic Themes

The FEMIS GIS has both static and dynamic themes. The Setup program installs the files for the static themes. The files for the dynamic themes are generated by the FEMIS application from data stored in the FEMIS relational database. These dynamic theme files need to be regenerated after installing (or reinstalling) FEMIS on a PC.

To regenerate the dynamic GIS themes, complete the following steps:

1. Start FEMIS and log in.

2. Click the Map button on the FEMIS Workbench to start the GIS, and wait for the GIS to load.

3. Click Utility on the menu bar, and select Regenerate Map Layers → Regenerate Point Map Layers.

4. Click the Utility on the menu bar, and select Regenerate Map Layers → Regenerate Polygon Map Layers.

### 4.4 Configuring the PC

#### 4.4.1 Setting Up FEMIS User Accounts on Windows NT and UNIX

For Windows NT to be able to connect to the required FEMIS drives located on the FEMIS server, a UNIX user account on the FEMIS server must be created for each Windows NT user account that will be used to run FEMIS. Each of these UNIX user accounts must have the same username and password as its corresponding Windows NT user account. These are separate from the usernames and passwords that are
used to log into the FEMIS application. The usernames and passwords used to log into the FEMIS application do not need to match the UNIX or Windows NT usernames and passwords.

**Note:** Both of the Windows NT and UNIX user accounts **must have** the same username and password so that network drives can connect correctly. Windows NT and UNIX usernames and passwords **are case sensitive.** For example: JSmith and jsmith **will not** work.

You can set up individual user accounts (such as jsmith) on one or on all of the PCs and the FEMIS server. Positional accounts (such as sheriff) can be set up on one or all of the PCs and the FEMIS server. One global (such as femisuser) can be set up on all of the PCs and the FEMIS server, or some other combination.

**Note:** Setting up and maintaining individual or positional accounts on all of the PCs and the FEMIS server can be time consuming, especially if you have many accounts and many PCs. If the password is changed for an account on one PC, it must be changed on all the others so they can all still connect to the network drives correctly.

### 4.4.1.1 Adding User Accounts to Windows NT

To add a Windows NT user account on a Windows NT PC, log onto the system with an account with Administrator privileges and complete the following steps.

1. **Click Start → Program → Administrative Tools → User.**
2. **Select New User,** and fill in the following fields on the User Manager window:
   - Username:
   - Full Name:
   - Description:
   - Password:
   - Confirm Password:
3. Check with your System Administrator to determine which of the following options should be checked.
   - User must change Password at Next Logon
   - User cannot change Password
   - Password never expires
   - Account disabled

After creating the Windows NT account, verify the following two items.

- The username and password entered are the same as those for this user on the UNIX server.
- The Windows NT account is at least in the Users group under the Groups button.
4.4.1.2 Adding User Accounts to UNIX

Refer to Section 2.1.1.3, Creating Users and Groups, for instructions on adding users to the UNIX server.

4.4.2 Running the FEMIS Startup Files

FEMIS requires that several network drives be connected in order for all items to work correctly. Running the FSTARTUP.EXE program connects these drives, and this program should be run automatically when a user logs into Windows NT. Depending on how your network and PCs are set up, use one of the two methods listed below for the program to run automatically.

**Note:** Most sites should use Method 1 and **only add** the Windows NT user accounts that will actually be running FEMIS and have corresponding accounts on the UNIX server.

If both FEMIS and EMIS are being installed on a single Windows NT account, you will need to edit the FEMIS.INI file. See Section 4.2.2, Validating I:\CONFIGD\FSETUP.INI File, for details. This should be done once on the UNIX server before FEMIS is installed on the PCs.

**Method 1: As a User Login Script**

1. When the Setup program completes, select User Manager in Administrative Tools in the Program Manager or Start menu.

2. For every Windows NT user account that will run FEMIS, select the user in the list. Then select the menu item Properties under User, and click the Profile button on the form that appears. If you use an NT domain to manage user accounts, this should be done on the domain server. Otherwise, this should be done on each PC that is used for FEMIS.

3. In the Logon Script Name field, enter FSTARTUP.EXE.

**Method 2: In Startup Folder**

1. Using Windows NT Explorer, open the C:\WINNT\PROFILES\ALL USERS\START MENU\PROGRAMS\STARTUP folder. From the File menu, select New → Shortcut, and a Create Shortcut dialog box displays. At the Command Line, enter %WINDIR%\SYSTEM32\REPL\IMPORT\SCRIPTS\FSTARTUP.EXE, and click Next. Enter a name for the shortcut, such as FEMIS Startup Script.

2. Follow the steps later to verify that the icon is in the common Startup folder instead of a personal Startup folder.

See Section 4.2.2, Validating I:\CONFIGD\FSETUP.INI File if you wish to customize the startup. You can specify additional drives to be mapped by the FEMIS startup script, and specify local startup scripts to be run after the drives have been mapped.
4.4.3 Verifying the Temporary Directory and Environment Variables

The GIS and other programs need a directory to store temporary files. Use the following steps to verify that this process was completed correctly by the Setup program.

1. Click Start → Settings → Control Panel → System.

2. Select Environment.

3. Verify there is a User Variable named TEMP (usually C:\TEMP). If not, enter TEMP in the Variable field and C:\TEMP in the Value field. Click Set.

4. Verify that a FEMISTOPDIR environment variable exists in the System Variables box. If not, select it and change the value in the Variable and Value text boxes, and click Set. The value of this variable should be set to the directory in which FEMIS was installed.

If you change anything, you must log out of Windows NT and login again for the changes to take effect.

5. Click OK to exit the System Configuration in the Control Panel.

4.4.4 Verifying the Clock Settings and Time Zone Settings

To set the date format preferences so that FEMIS can process the date correctly, complete the following steps.

1. Click Start → Settings → Control Panel → Regional Settings.

2. Select the Date tab in the Regional Settings window.

3. Set your short date style to dd-MMM-yy (Day - Month - Year).

4. Select the Time tab in the Regional Settings window.

5. Verify that you are either using a 24-hour clock (upper case “H” in the Time Style field) or a 12-hour clock (lower case “h” in the Time Style field) set with the AM and PM symbols are set to AM and PM (not case sensitive).

6. Verify the time zone is correct in the Control Panel → Date/Time icon → Time Zone tab.

4.4.5 Verifying the Time Synchronization Services

To verify the time synchronization services, the files and services discussed in the following sections should be verified.
4.4.5.1 Verifying the AUTOEXNT.BAT File

The AUTOEXNT.BAT file is located in the %WINDIR%\SYSTEM32 directory, usually C:\WINNT\SYSTEM32. This file should contain the following commands.

```bash
net stop NetWorkTimeProtocol
%WINDIR%\SYSTEM32\PING -w 60000 TEMPLATE_HOSTNAME
%WINDIR%\SYSTEM32\NTPDATE -b TEMPLATE_HOSTNAME
net start NetWorkTimeProtocol
```

The AUTOEXNT.BAT file is invoked at boot up. Its purpose is to synchronize time on the PC while bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to be the same as on the UNIX server. After boot up, the usual NTP algorithms apply.

**Note:** The batch file AUTOEXNT.BAT starts the Network Time Protocol service. Network Time Protocol **should not be started** automatically by the control panel. See Sections 4.4.5.2, Verify AutoExNT Service and 4.6.3.4 Verify Network Time Protocol (NTP) Service.

4.4.5.2 Verify the AutoExNT Service

To verify that the AutoExNT service was installed and configured correctly, complete the following steps:

1. Click Start → Settings → Control Panel → Services.
2. Select AutoExNT. The Status should be blank, and the Startup should be Automatic.
3. Click Startup. Verify the radio buttons for Automatic, under Startup Type, and System Account, under Log On As, are selected. Also verify the checkbox to Allow Service to Interact with Desktop is checked.
5. Click Close to return to the Control Panel window.

4.4.6 Verifying the Virtual Memory Setting

For FEMIS to run as efficiently as possible, the computer should be set to have at least 250MB (megabytes) of virtual memory. To check the virtual memory setting and increase it, if necessary, complete the following steps while logged in as Administrator.

1. Click Start → Settings → Control Panel → System.
2. Select the Performance tab.
3. Click Change.

4. Increase the Maximum size to 250MB, if necessary, click Set.

5. Click OK, click Close, and select Yes to reboot, if prompted.

### 4.4.7 Creating FEMIS Icons

The FEMIS Setup program creates a shortcut on the All Users’ desktop to the FEMIS folder on the Start menu. If you wish to add more shortcuts to the FEMIS folder on the Windows Start menu, you can simply add the shortcuts to the FEMIS folder on the desktop.

If you wish to have any of the FEMIS icons on the desktop, copy the shortcuts from the FEMIS menu on the desktop to the C:\WINNT\PROFILES\ALL USERS\DESKTOP folder.

If you wish to delete any of the shortcuts, right click on the shortcut to be deleted and select the Delete option. This will only delete the shortcut, not the program to which it points.

**Note:** If an icon or a shortcut is not created in the All Users profile, the FEMIS icon will only show up for the user under whose profile the shortcut was created.

### 4.4.8 Final Steps for the FEMIS PC Installation and Configuration

**Note:** If this is an upgrade installation, you may wish to clean up old icons from the Program Manager. These may include old icons for the FEMIS program and old icons for running the startup batch files in the Startup group.

The following are the final steps for the FEMIS installation.

1. Log out of Windows NT.

2. Log into Windows NT as the appropriate user account. Run FEMIS.

3. Verify the installation of the first PC thoroughly by following Section 4.6, Validating the FEMIS PC Installation, before any more PC installations are started. If you must edit any of the configured files (e.g., ADDODBC.BAT, TNSNAMES.ORA), copy the corrected file back to the server and install again to be sure that it will work correctly.

### 4.5 Configuring FEMIS for All PCs at an EOC

The following validation steps need to be performed one time at each EOC. Since these configuration changes affect values stored in the FEMIS database for the EOC, they will take effect on all of the PCs using the same database.
4.5.1 Verifying the Zone Name Lookup for EMIS PAR

Note: If both of the following two conditions are true, you must complete this section:
1. You are currently installing FEMIS on an onpost PC.
2. EMIS is used onpost at your site.

You can skip this section if you are upgrading from an earlier version of FEMIS, and you performed these steps when that version was installed.

Because EMIS allows users to change zone names at will, there is a possibility that FEMIS and EMIS zone names will not match exactly. It is important, however, for FEMIS to be able to map its zone names to the zone names used in EMIS so that Protective Action Recommendations (PARs) may be shared between the systems. For this reason, a simple utility named FZONES.EXE has been added to the list of system administration software tools available on the PC. This tool allows your FEMIS System Administrator to set up the EMIS zone name aliases so FEMIS will be able to correctly map PAR information sent from EMIS. If EMIS is part of the site configuration, then this utility must be run on the onpost FEMIS at installation and again whenever EMIS changes their zone names.

4.5.2 Using FZONES.EXE Tool

FZONES.EXE is a system tool that runs on the PC. Before you can run this tool, you will need to install at least one PC with system tools.

This tool displays a two-column spreadsheet of zone information. In the first column, there is a read-only list of FEMIS zone names. In the second column, there is a writable copy of the EMIS zone names. When you first start this utility, it will load the values currently in the database for the FEMIS and EMIS zone names. If at any time during the editing process you wish to reload the spreadsheet based on the values in the database, click the Reset Spreadsheet button.

To populate the FEMIS/EMIS zone lookup table, you will need to get a list of all the EMIS zone names for the site. This information may be found on the EMIS server in the following file: /<disk>/emis3run/emisdyn/data/<site code>/emisgis/giszne.dat. The <disk> and <site code> will be site specific. Once you have the EMIS list of zones, the simplest way to populate the lookup table is to run the FZONES utility, and then type the EMIS zone names directly in the spreadsheet next to the corresponding FEMIS zone name. When the spreadsheet is complete, click the Save button.

4.6 Validating the FEMIS PC Installation

To run correctly, FEMIS software relies on many integrated components: the FEMIS database, commercial and government supplied software products, the FEMIS application, and system support services. Therefore, it is important to ensure that the FEMIS system is fully operational. This section will assist your System Administrator to validate that the FEMIS system has been properly installed and is operating correctly.
The FEMIS PC Validation Checklist, provided at the end of this section, includes items that need to be checked to ensure that the FEMIS system is operating properly. The Checklist correlates to the items listed below. These items are tested from the PC to ensure access and integration into the FEMIS application. This checklist provides a method to validate that the server and external communications are properly installed.

If problems are encountered during the validation, refer to Section 16.0, FEMIS Application Error Messages and Troubleshooting, in the *FEMIS System Administration Guide* for suggestions and guidance.

### 4.6.1 One Time at EACH EOC

The following validation steps must be performed one time at each EOC.

#### 4.6.1.1 Verify Default D2PC Case Exists

From the FEMIS Workbench or the Tracking Navigator, click **D2PC**. On the D2PC Interface window, select **Edit** mode, and click **File → Site Defaults → Revert to Site Defaults**.

If a message displays stating there is “no current D2PC case selected” or “no site defaults yet assigned for this site”, then you will need to create a site default D2PC case.

**STOP**

If there is not a site default D2PC case, select a case that runs and make it the default case.

It is imperative that you consult with the Hazard Analyst to make sure the new default case is modified to meet their needs and saved.

Once the EOC has a default case, repeat this verification step.

#### 4.6.1.2 Verify the Evacuation Command Server

To verify the Evacuation Command server is working properly, you will need to import and run an Evacuation case. Evacuation cases are located on the `I:\data\evac` directory where `I:\` is `\<servername>\home\femis`. See the FEMIS Help for guidance on importing and running a case. Make it your current operational case (on the Evac main window, **File → Make Case Current Operational**).

#### 4.6.1.3 Verify FEMIS/EMIS Data Exchange Interface (DEI)

**Note:** The definitive description of this interface can be found in Section 7.0, FEMIS Data Exchange Interface (DEI), in the *FEMIS System Administration Guide*. 
To verify that DEI is operating, click the Status menu in Operations mode and the select Met Condition. If the current meteorological (Met) data appears in the table, then the DEI is probably running.

### 4.6.1.4 Create a Plan for Validation Testing

To create a planning dataset that is shared so it can be used for PC validation, complete the following steps:

1. Click on Utility → Planning Functions → Planning.
2. Choose Create New Shared Dataset from the Dataset drop-down list.
3. Name the new dataset, and click OK. The Tracking Navigator displays.
4. Click on Plan → Select Plan.
5. Select Basic Template from the Select Plan spreadsheet, and click Select.
6. Click the New Data button.

From the Tracking Navigator, you will need to create a Protective Action Decision (PAD) and a Community Condition as part of this validation test.

Complete the following steps to create a PAD for the validation test.

1. Click on the PAD function box and OK to the message box that displays.
2. Select the Edit radio button.
3. Create a new PAD by entering a name in the PAD Name field, and click OK.
4. Click the New Data button.

Complete the following steps to create a Community Condition for the validation test.

1. Click on the Community Function box and OK to the message box that displays.
2. Select the Edit radio button.
3. Create a new Community Condition by selecting Default from the Name drop-down list, rename it, and click OK to create a new Community Condition.
4. Click the New Data button.
Complete the following steps to create a Validation plan.

1. Click on Plan \textarrow{Copy Current Plan}.

2. Enter a name for the new plan, and click OK.

3. Click on Plan \textarrow{Select Plan}

4. Click No to AutoCalc synchronization message that displays.

5. Select the plan name created in Step 2, and click Select.

5. Click the New Data button.

6. Click on Edit under Tasks, and click OK on the message box. Microsoft Project is displayed.

Complete the following steps to add a task in Microsoft Project.

1. Click on an empty row.

2. Click on the Task Details Form button (far left side of the toolbar).

3. Select items from the Agency and Stage drop-down lists, select the Times & Misc tab. Click Save to save the task changes. Click Close on FEMIS Task Details.

4. Click on Save under Tasks on the Tracking Navigator to save this plan, which will be used to Verify Electronic Planning (item 15 on the FEMIS PC Validation Checklist).

5. Click the New Data button.

6. Click on Exit Project under Tasks and click Yes on message window.

\section*{4.6.1.5 Test the GIS on the Printer}

Not all printers display graphics the same. For each printer to which you anticipate printing, use both KeyPrint and the Print option on ArcView GIS to print a GIS map that contains a D2PC case, Threat Area, Risk Area and one or more facilities under each. Review the printout to ensure that it prints graphics in such a way that:

- Risk and No Risk can be differentiated.

- One feature does not totally obscure an underlying feature (e.g., You can still see facilities located in the Threat Area, and the Threat Area does not wipe out the D2PC isopleths.).
4.6.1.6 Verify E-mail

Verify E-mail can be sent to users in all other EOCs.

4.6.1.7 Verify the SEPR Icon Addressee

Verify the addressee in the SEPR (Software Enhancement/Problem Report) icon file is the desired addressee for that EOC. Some EOCs want to compile/review the SEPRs before they send them to PNNL. Check the policy of the EOC and modify the SEPR template as needed. If they want it to go directly to PNNL, use ranata.johnson@pnl.gov (Ranata Johnson’s E-mail address) or blanche.wood@pnl.gov (Blanche Wood’s E-mail address).

4.6.2 Cleanup AFTER Validation

**Note:** Do not perform the following clean up procedures until completing the validation steps in Section 4.6.3, Perform on EVERY PC.

After completing the above validations steps, the following cleanup validation steps need to be performed one time at an EOC, not on every PC.

4.6.2.1 Delete Validation Datasets

Delete the planning dataset created for validation in Section 4.6.1.4, Create a Plan for Validation Testing, as well as any other planning datasets that were created for the purpose of installation or validation.

4.6.2.2 Ensure Exercise #1 Exists

Ensure Exercise #1, or whatever Exercise is recognized by EMIS has been created. This will allow EMIS to communicate with FEMIS in Exercise mode.

4.6.2.3 Remove Extraneous FEMIS User Accounts

Remove extraneous FEMIS user accounts that were created during installation and validation. Be sure to leave the one user account, authorized by your System Administrator that will be used during the Shakedown Test.

4.6.3 Perform on EVERY PC

The following validation steps should be performed on every PC.

**Note:** Login to Windows NT with Administrator privileges.
4.6.3.1 Ensure FEMIS Login Security

If the PC has a femis account under Windows NT, make sure that the password is not set to femis.

4.6.3.2 Verify the PC Configuration

Verify each of the following items to make sure the PC’s configuration is correct.

- Icons left from previous installations of FEMIS but are no longer linked to a program should be removed from the Start → Programs → Femis folder.
- KeyPrint is in the Startup group for all users.
- Virtual memory maximum size is set to at least 250MB.
- The FEMIS startup file is called either in each user’s profile or from the All User Startup folder.
- System Environment variable FEMISTOPDIR is defined and set to the directory where FEMIS is installed.

4.6.3.3 Verify the PC Clock

Verify the PC clock by clicking Start → Settings → Control Panel→ Regional Settings. On the Date tab, verify your date style is dd-MMM-yy (Day - Month - Year). On the Time tab, make sure you are using either are a 24-hour clock (upper case “H” in the Time Style field) or a 12-hour clock (lower case “h” in the Time Style field) with the AM and PM symbol fields set to AM and PM (not case sensitive).

4.6.3.4 Verify the Network Time Protocol (NTP) Service

To verify the Network Time Protocol (NTP) will synchronize with the server for small variations in time when the PC is booted up, complete the following steps:

- Click Start → Programs → Administrative Tools → Event Viewer to the Event View window. Under the Log menu item, select Application. Check for warning or error messages (yellow or red icon) with NTP as the source. Troubleshoot as necessary.
- Verify the Network Time Protocol startup is set to Manual.
- Verify the fifth line of C:\WINNT\SYSTEM32\AUTOEXNT.BAT has been changed to read NTPDATE -b <hostname>, where <hostname> is the name of your UNIX server.
- Change the PC clock to a significantly different time (1 hour or more).
• Restart the PC (Start → Shut Down → Restart the Computer).

• Login and verify that the PC clock has been reset correctly.

• From a DOS prompt, enter the command ntptrace. This should return a list of the servers that are used to synchronize time to the PC. If this does not happen, see Section 4.2.7, Validating the I:\CONFIGD\NTP.CONF File for more information on this file.

  **Note:** Do not use Administrator privileges to perform the rest of the validation steps.

4.6.3.5 Verify Login

For Windows NT v4.0, check to make sure a shortcut to FEMIS exists.

• Validate the ability to access the FEMIS application by double clicking on the FEMIS icon.

• Confirm that the correct default Site/EOC is highlighted.

• Enter a valid usercode and password. The Select Mode window should display.

• If there are Oracle problems with FEMIS from a particular Windows NT machine, check its path (Control Panel → System Environmental Variables). If there is an Oracle directory (i.e., S:\EMISDYN\ORANT\BIN) referenced that is not pointing to where FEMIS installed Oracle (either on the C:\ or D:\ drive), then this portion of the path must be removed. Check with the other software vendors, as appropriate, to be sure this will not cause problems to their software.

• Verify the ability to enter Operations mode.

4.6.3.6 Verify Data Manager

Select Start → Programs → FEMIS → Data Manager to validate the access to the FEMIS Data Administration functionality. If the icon is not available, select Start → Run and enter or browse to C:\FEMIS\FDATAMGR.EXE.

4.6.3.7 Verify the System Administration Utility

Select Utility → System Utilities → System Admin from the main FEMIS menu bar to validate the access to the system administration functionality.
4.6.3.8 Verify D2PC

Complete the following steps to verify D2PC.

- Click D2PC on the Tracking Navigator. Be patient while the initial connection is made to the D2PC application and the FEMIS database. D2PC should come up with a default case and should be ready to run. Select Edit mode.

- Verify the Log Runs checkbox is checked and that you are in Edit mode. From the Run menu, select the Run Model item. You should quickly get a user interface window containing the results of the D2PC run.

- Save the D2PC case.

  Note: On post users may get messages about sending the D2PC case offpost. Click Yes, and close the D2PC window.

4.6.3.9 Verify Notification Server

On the Tracking Navigator, you should see a blinking icon (New Data button) that looks like a package. A magenta bar on the D2PC Function box should also appear. This means that FEMIS data notifications are being sent and passing messages to your PC. Click the New Data button.

4.6.3.10 Verify GIS

Click the Map button from the FEMIS toolbar. The ArcView GIS application should start, and you should see a base map displayed within an ArcView GIS window.

To check the link between FEMIS and the GIS, select Facilities theme on the left side of the GIS window. Click the i+ button on the ArcView GIS toolbar; and then click a facility icon on the map. A view-only facility/resource window should appear.

Do not close the GIS as it will be used in the following steps.

4.6.3.11 Verify Evacuation

If the one-time validation steps have been successfully completed, there should be a current Evacuation case displayed on the Tracking Navigator. Click the Evacuation Function box on the Tracking Navigator. If Evacuation has not been previously executed on this PC, you will get a message telling you to create a network. Under File, select Create Network. It should display on the GIS. If the network was previously created on this PC, you will not get the message nor need to create the network. You can merely observe the network is displayed on the GIS.
4.6.3.12 Verify Electronic Planning (Planning Mode)

To run FEMIS Electronic Planning in the Planning mode, you must have Microsoft Project loaded on your PC and a FEMIS Access Database properly attached. To validate this, click on Utility → Planning Functions… and select the validation dataset created in the one-time steps (see Section 4.6.1.4, Create a Plan for Validation Testing.). Examine the Tracking Navigator window to be sure a Plan has been selected. Click on Edit under Tasks, which is next to the Plan on the FEMIS Tracking Navigator (Planning) window. Microsoft Project will open and display the selected Plan. If you can do this without any errors or error messages, and tasks appear in the grid; then the FEMIS Planning software should work properly.

The Microsoft Project calendar should be set to a 24-hour clock and a 7-day calendar. Select Tools → Change Working Time. Every day is gray, and the working time is 12:00 a.m. to 12:00 a.m.

4.6.3.13 Verify Help

Click Help to activate the online Help to verify the Help subsystem is working properly.

4.6.3.14 Verify Printer

Verify KeyPrint was enabled at log in. Use KeyPrint or the Print Screen button on any FEMIS window to ensure the PC is properly connected to a printer.

4.6.3.15 Verify E-mail

Select the MAIL button from the FEMIS toolbar. This should bring up your E-mail application. Verify that you can send an E-mail message to another PC.

4.6.3.16 Verify SEPR Icon

Send a test SEPR message.

4.6.3.17 Verify FEMIS Tools

Verify on a FEMIS PC with System Tools installed. Click on each of the FEMIS Tools (FEMIS Monitor PC, FEMISMon Watcher, and Network Monitor) to ensure they are operational.
## FEMIS PC Installation Checklist

<table>
<thead>
<tr>
<th>Task</th>
<th>Initials</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 Installing Windows NT 4.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1.3 Installing Windows NT Service Pack 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.2 Installing an NFS System (Maestro and Patch or Solstice)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3 Installing Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.4.1 Installing ArcView GIS v3.1.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.4.2 Installing ArcView GIS v3.1.1 Patch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.5 Installing Microsoft Project 98 Service Release 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.6 Installing Other COTS; Site Specific</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Configuring the FEMIS Setup Program (Once at Each EOC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.11 Updating the PC HOSTS File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Installing the FEMIS Client Software</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.2 Running the FEMIS Startup Files</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.3 Verifying Temporary Directory and Environment Variables</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.4.4 Verifying Clock Settings and Time Zone Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.5 Verifying the Time Synchronization Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.6 Setting Virtual Memory Setting (Maximum to at least 250)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**FEMIS PC Validation Checklist**

<table>
<thead>
<tr>
<th>PC Name:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Validated using NT Login:</td>
<td></td>
</tr>
<tr>
<td><strong>One Time at Each EOC:</strong></td>
<td><strong>Initials</strong></td>
</tr>
<tr>
<td>1</td>
<td>Verify Default D2PC Case Exists</td>
</tr>
<tr>
<td>2</td>
<td>Verify the Evacuation Command Server</td>
</tr>
<tr>
<td>3</td>
<td>Only on the server with the depot database, Verify FEMIS/EMIS Data Exchange Interface (DEI)</td>
</tr>
<tr>
<td>4</td>
<td>Create a Plan for Validation Testing</td>
</tr>
<tr>
<td>5</td>
<td>Test the GIS on the Printer</td>
</tr>
<tr>
<td>6</td>
<td>Verify E-mail</td>
</tr>
<tr>
<td>7</td>
<td>Verify that SEPR Icon Addressee</td>
</tr>
</tbody>
</table>

| **Clean Up AFTER Validation:** |  |
| 1 | Delete Validation Datasets |  |  |
| 2 | Ensure Exercise #1 Exists or Whatever Exercise is Recognized by EMIS |  |  |
| 3 | Remove Extraneous User Accounts |  |  |

| **Perform on Every PC:** |  |
| 1 | Ensure Windows NT Login FEMIS/FEMIS Does Not Exist |  |  |
| 2 | Verify the PC Configuration |  |  |
| 3 | Verify the PC Clock |  |  |
| 4 | Verify Network Time Protocol (NTP) Service |  |  |
| 5 | Verify Link to M:\ Drive |  |  |
| 6 | Verify Login |  |  |
| 7 | Verify COTS Software |  |  |
| 8 | Verify Data Manager |  |  |
| 9 | Verify System Administration |  |  |
| 10 | Verify D2PC |  |  |
| 11 | Verify Notification Server |  |  |
| 12 | Verify GIS |  |  |
| 13 | Verify Evacuation |  |  |
| 14 | Verify Electronic Planning |  |  |
| 15 | Verify Help |  |  |
| 16 | Verify Printer |  |  |
| 17 | Verify E-Mail |  |  |
| 18 | Verify SEPR Icon |  |  |
| 19 | Verify colors are 65,536 |  |  |
| 20 | Verify FEMIS Tools on Appropriate PC(s) |  |  |
5.0 Remote Evacuee Registration and Point to Point Protocol

5.1 Remote Evacuee Registration

The Remote Evacuee Registration (RER) application can be used in shelters where a network connection is not available. It is also suited for use on portable PCs in situations where the user is required to be mobile. Evacuee information can be entered and then uploaded to a site’s database using a standard phone connection and PC modem. Use of the application does not require that the user install the entire FEMIS product line.

To run Remote Evacuee Registration via Dial-Up, your site must have a modem and Point to Point Protocol (PPP) dial-up software and hardware installed as well as properly configured on the server.

5.2 Installing Remote Evacuee Registration

Remote Evacuee Registration can be installed on a PC as an option using the setup program that installs FEMIS. If you also need FEMIS to run on the PC, use the installation instructions in Section 4.0, FEMIS PC Installation. Be sure and check the Remote Evacuee Registration checkbox when selecting components during installation (see Section 4.3.2, Running the Setup Program).

Remote Evacuee Registration needs the following COTS in order for it to be installed and operate properly:

- Windows NT Service Pack 5 — Section 4.1.1.3, Installing Windows NT Service Pack 5
- NFS software or Samba server daemon (to install Remote Evacuee Registration only) — Section 4.1.2, Installing an NFS System
- Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5 — Section 4.1.3, Installing Oracle Net8 Client v8.1.5 and ODBC v8.1.5.5

The FEMIS Oracle database on the UNIX server must be operational before the Setup Program is run.

1. Close all programs that are running.

2. Connect your I: drive as specified in Section 4.2.1, Connecting the Network Install Drive.

3. Run the I:\PC\SETUP\SETUP.EXE program.

4. Select your EOC from the drop-down list, and click Next.
5. Check the Remote Evacuee Registration box.

If you will be installing Remote Evacuee Registration without other FEMIS components (which is an option), deselect those components (FEMIS and GIS are selected by default).

Click Next.

If the FEMIS GIS is not installed, the following prompt will display: Set Default FEMIS Database Cannot find the GIS data for <EOC> Do you want to proceed anyway? Click Yes, and then OK to the warning that follows.

Remote Evacuee Registration needs Dial-Up Networking installed and a Phonebook entry configured for your EOC’s dialup service if you intend to use Dial-Up for evacuee registration.

5.3 Setting Up Dial-Up Networking for Windows NT

Setting up Dial-Up Networking for Windows NT consists of verifying the modem has been installed, configuring the dial-up networking, and connecting via the dial-up network.

5.3.1 Verifying Modem Installation

To verify the modem installation, complete the following steps.

1. Log into Windows NT as Administrator.

2. Click Start ➔ Settings ➔ Control Panel, and double-click the modem icon.

3. Verify the modem is installed.

If no modem is installed, the Install New Modem program will execute. Use the vendor’s recommendation for installing the correct drivers for Windows NT v4.0.

5.3.2 Configuring Dial-Up Networking

Complete the following steps to configure the dial-up network.

1. Log into Windows NT as Administrator.

2. Click Start ➔ Programs ➔ Accessories ➔ Dial-Up Networking.

3. Follow the prompts to install the software from the Windows NT v4.0 CD if the Dial-Up Networking has not been previously installed.
If it has been installed but not configured for use, you will be prompted to add a phone book entry. Click OK.

If you do not get either of these prompts, click the New button on the Dial-Up Networking window.

4. Enter a name for the phonebook entry you will use to connect to the server. Click Next.

The parameters used to configure your phonebook entry need to be provided to you by the administrator of the dial-up server on the network you will connect to.

**Note:** If you do not enter a DNS server, be sure the IP for the FEMIS server and other systems you wish to connect to on its network are in your hosts table located in the `<WINDIR>\SYSTEM32\DRIVERS\ETC\HOSTS` file.

5. Click Finish to save your phonebook entry.

6. Locate an analog phone line that you will connect to your modem.

7. Click the Location button in the Dial-Up Networking window.

8. Click New if you have previously configured dialing locations.

9. Edit the I am dialing from to reflect the location/phone line you are using.

10. Edit all applicable items in this window, and click OK.

### 5.3.3 Connecting Via Dial-Up

Complete the following steps to connect the dial-up network.

1. Login to Windows NT.

2. Click Start → Programs → Accessories → Dial-Up Networking.

3. Select your phonebook entry and dialing from location. Be sure your modem is plugged in, and click Dial.

4. Enter your user name, password, and domain as required by Dial-Up Server, click OK. The modem will then attempt to dial the Dial-Up Server.

If you get an After Dial Terminal Window, enter the required user name and password, and click Done. Contact the Dial-Up Server administrator, if you cannot logon.

To test your connection, bring up a DOS window, enter a `ping <FEMIS server>`, and verify you get a response.
5. Disconnect from the server by right clicking on the Dial-Up Networking Monitor icon in the Task Bar → Hang up → Phonebook entry.

5.4 Verify Remote Evacuee Registration

To test Remote Evacuee Registration via the Dial-Up do the following steps.

1. Start the Remote Evacuee Registration application. Answer No to the question about being on the Network.

2. Select the phonebook entry for the FEMIS server in the Profile drop-down window, and click the Dial & Sync button when the Exchange Server Dial Assistant dialog is displayed.

3. Enter your user name, password, and domain as required by Dial-Up Server, click OK. The modem will then attempt to dial the Dial-Up Server.

   If you get an After Dial Terminal Window, enter the required user name and password, and click Done. Contact the Dial-Up Server administrator, if you cannot logon.

4. Select your EOC on the FEMIS Login window, and enter your FEMIS user name and password. Click OK.

5. Select the mode that you would like to test in: either Operations or Exercise (by selecting one of the available Exercises). Click OK.

   The Auto Download Data from Server dialog is displayed. This application will take advantage of the dialup connection by downloading the contents of the Lookup tables. Downloading the Lookup table contents will only take place if the number of records in the Lookup table on the server and the Lookup table in the local database are different. You will be warned if there is no data for one of the tables on the server.

6. Click Close on the Auto Download window. The Dial-Up connection will automatically disconnect and the FEMIS Remote Evacuee Registration window will close.

7. Exit FEMIS Remote Evacuee Registration.
6.0 Stand-Alone Installation of FEMIS v1.4.7

The following section contains instructions on the installation of a stand-alone Oracle database and the configuration of the FEMIS v1.4.7 application on the stand-alone system. Additional documentation and software that will be required to complete this installation are as follows:

- Oracle8i Server for Windows NT v8.1.6 or Personal Oracle8i v8.1.6.
- FEMIS v1.4.7 COTS CD.

6.1 Stand-Alone PC System Requirements

Since the stand-alone PC will be running an Oracle database as well as the FEMIS application and COTS software, the system hardware should be as robust as possible. The following hardware requirements should be used as minimum requirements:

- IBM compatible PC with Windows NT v4.0 and Service Pack 5
- Pentium 266MHz
- 128MB of RAM
- CD ROM Drive
- Network Adapter or PC Card
- 800X600 pixels and 256 color Display Graphics
- 2GB of free hard disk space.

6.2 Location of Oracle

The Standalone requires that Oracle8i v8.1.6 database software be installed on the PC. Based on the space requirements for Oracle8i and Personal Oracle8i for v8.1.5, the amount of disk space required for a minimal installation of these products is

- ~586MB for Oracle8i or Personal Oracle8i
- ~500MB-900MB for FEMIS data files.

Space requirements for v8.1.6 were not available at this time.

6.3 Stand-Alone PC Installation Process

The following sections provide instructions for installing the Oracle database and configuring the FEMIS v1.4.7 application.
6.3.1 Removing Existing Stand-Alone Database

If you have an existing Oracle7 database installed on the PC, complete the following steps.

1. Delete all shortcuts from the Startup folders. The All User Startup folder is located in %WINDIR%\PROFILES\ALL USERS\START MENU\PROGRAMS.

2. Remove the existing Oracle instance by running the Instance Manager ORACLE_HOME\bin\oradim73.exe. Select instance and click Delete.

6.3.2 Installing PC COTS and FEMIS v1.4.7

Follow the instructions in Section 4.0, FEMIS PC Installation, to install the FEMIS v1.4.7 COTS and the FEMIS application.

Be sure to follow the steps in Section 4.1.3.1 Uninstalling Oracle SQL*Net Client v2.3.4 and Oracle7 ODBC Driver during the installation of the PC COTS and FEMIS v1.4.7. You should not restore your TNSNAMES.ORA and SQLNET.ORA.

Install the Oracle Net8 products at the same location you expect to install Personal Oracle or Oracle8i Server and keep in mind the space requirements required for the software.

6.3.3 Installing Oracle8i Server or Personal Oracle8i

To install Oracle8i Server Enterprise Edition, Oracle8i Server, or Personal Oracle8i, complete the following steps:

1. Insert the Oracle installation CD into the CD drive.

2. Select Install/Deinstall Products in the window that appears or click Start → Run, and enter <CD DRIVE>\SETUP.EXE.

3. Click Next in the Oracle Universal Installer – Welcome window.

4. Verify the destination Name and Path of the Oracle Home directory (typically OraHome81 and C:\ORACLE\ORA81), and click Next.

   **Note:** You should install Oracle to the same Oracle Home Name and Path as the Net8 Client was installed during the COTS installation. This will upgrade the installed v8.1.5 components to v8.1.6.

5. Select Oracle8i or Personal Oracle8i. Click Next.
6. Select Minimal Installation Type, and click Next.

7. Select No in the Select Starter Database window, and click Next.

8. Click Install in the Summary window.

**Note:** You may receive messages the message—Error in writing to file C:\winnt\system32\<filename>.dll—when the install is copying files to the PC. Browse to the location of the file, right click on the file and select properties. Uncheck the Read-only box and click OK. Then return to the message, and click Retry.

9. Click Cancel in the Net8 Configuration Assistant Welcome window that displays after the installation is complete.

10. Click OK in the Error window that follows.

11. Click Next in the Configuration Tools window.

12. Click Exit in the End of Installation window.

### 6.3.4 Configuring Oracle Network Components

Before the database instance can be installed, the Net8 components and Listener need to be configured. Complete the following steps to configure these.

1. Click Start → Programs → Oracle Oracle-OraHome81 → Network Administration → Net8 Assistant.

2. Go to Net8 Configuration → Local, and select Profile.

3. Go to the Naming section, and select the Methods tab. Use only TNSNAMES as Selected Methods. To add or remove selected items, use the < and > buttons.

4. Click the Oracle Names tab, and enter World as Default Domain.

5. Click File on the menu bar, and select Save Network Configuration.

6. Click on File, and select Exit.

7. Click Start → Programs → Oracle Oracle-OraHome81 → Network Administration → Net8 Configuration Assistant.

8. Select Listener Configuration in the Net8 Configuration Assistant: Welcome window, and click Next.

9. Select Add, and click Next.
10. Use the default Listener name, LISTENER, and click Next.

11. In the Select Protocols window, TCP should be the only item in the Selected Protocols field. Use the < and > buttons to add or remove Selected Protocols. Click Next.

12. Use the standard port number of 1521 for the TCP/IP port number. Click Next.

13. Select No for Would you like to configure another listener? Click Next.

14. Click Next for Listener configuration complete!

   You will be returned to the Net8 Configuration Assistant: Welcome window.

15. Click Finish.

### 6.3.5 Building the Database

Complete the following to build the database:

1. Click Start → Programs → Oracle Oracle-OraHome81 → Database Administration → Database Configuration Assistant.

2. Select Create a database, and click Next.

3. Select Custom for type of database to create. Click Next.

4. Select Multipurpose for Primary type of application that will be used. Click Next.

5. Enter 1 for Concurrently connected users, and click Next.

6. Select Dedicated Server Mode for mode in which you want your database to operate by default. Click Next.

7. Deselect the Oracle JServer and verify that only the following items are checked for the Select Options that will be configured for use in your database window.

   Advanced Replication
   SQL*Plus Help

   Click Next.

8. Enter f0.world for the Global Database Name. f0 will be automatically entered for the SID. Accept the default Initialization Filename location. For Compatible Parameter, select 8.1.0. **Do not select** Change Character Set. Click Next.
9. Enter a password in the Password and Confirm fields for the Internal privileged account. Keep track of the password for later use. Click Next.

10. Accept the default locations and parameters for the Control Files if you are installing on a system that has only one physical disk. If you have multiple disks, locate the control files on separate disks, whenever possible. To change the drive location, only change the drive letter and leave the file location path intact. Click Next.

11. Change each to the following for the Size parameter of the tablespaces. Each tablespace that is going to be created by the Oracle Database Configuration Assistant is represented by a tab in this window. Use the default Name, File, Extent and Storage parameters for all tablespaces.

   System - 100MB
   Tools – 3MB <only in Oracle8i Enterprise Edition>
   User – 3MB
   Rollback – 50MB
   Index – 3MB
   Temporary – 20MB

   Click Next.

12. Accept the default location and parameters for the Redo Logs. If you have multiple disks, locate the Redo Logs on the separate disks, whenever possible. To change the drive location, only change the drive letter and leave the file location path intact. Click Next.

13. Accept the defaults Checkpoint Interval and Checkpoint Timeout. Do not check Enable Archive Log. Click Next.

14. Accept the default SGA parameter information, and click Next.

15. Accept the default Trace File Directory locations, and click Next.

16. Check Create database now. Click Finish.

17. Click Yes on the Message box that follows to create the instance. This can take up to 1 hour depending on the speed of your PC.

18. Note the password information for sys and system in the Oracle Database Configuration Assistant Alert that displays after the database has been created. Click OK.
6.3.6 Creating Stand-Alone Working Directory

Complete the following steps to create a working directory to store the export file, scripts, and log files which are needed to create a FEMIS database.

1. Click Start → Programs → Windows NT Explorer.
2. Browse to the base directory where Oracle was installed, usually C:\ORACLE.
3. Select the Oracle directory, click File on the menu bar, and select New → Folder.
4. Enter STANDALONE for name of your working directory.
5. Insert the FEMIS v1.4.7. COTS CD into the CD drive.
6. Copy the contents of the STANDALONE directory from the CD to the STANDALONE directory on the PC.

6.3.7 Creating FEMIS Database Tablespaces

To prepare the database for FEMIS data, additional tablespaces and public rollback segments need to be created.

1. Use Windows NT Explorer to browse to the stand-alone working directory, usually C:\ORACLE\STANDALONE.
2. Use a text editor, such as Notepad, to open the CR_TABLESPACE.SQL file.
3. Modify, if necessary, the path locations for the FMAIN, FINDEX, FSNAPSHOT, and FSNAPLOG DATAFILES to be located in the ORADATA folders created by the instance installation. If you have multiple hard drives on which to install, preferably locate them on drives other than the drive where Oracle was installed. If you had three drives, for example:

   - Oracle installed drive C:\ORACLE\ORA81
   - FMAIN     D:\ORACLE\ORADATA\FI0\FMAIN01.DBF
   - FINDEX    E:\ORACLE\ORADATA\FI0\FINDEX01.DBF
   - FSNAPSHOT D:\ORACLE\ORADATA\FI0\FSNAPSHOT01.DBF
   - FSNAPLOG  E:\ORACLE\ORADATA\FI0\FSNAPLOG01.DBF

4. Ensure the paths specified in the CR_TABLESPACE.SQL exist. If not, create them.
5. Verify you have sufficient disk space for the data files Size parameter in the CR_TABLESPACE.SQL and room for additional growth when FEMIS data is imported.

   **Note:** Disk space requirements will vary depending on the amount of FEMIS data that has been inputted at your site. FMAIN or FSNAPSHOT can exceed 300MB in some installations.

6. Verify at the Command Prompt window that you are located in the stand-alone working directory, C:\ORACLE\STANDALONE.

7. Enter sqlplus system/manager @cr_tablespace.sql at the command prompt.

   The script will take a few minutes to create the data files and rollback segments and will exit to the command prompt when done.

8. Locate the Instance initialization file, INITFI0.ORA, located in the <INSTALL DRIVE>:\ORACLE\ADMIN\FI0\PFILE.

9. Edit the file to match the following. This will uncomment the line for private rollback segments.

   \[ ROLLBACK SEGMENTS = (RBS0, RBS1, RBS2, RBS3, RBS4, RBS5) \]

### 6.4 Importing or Changing FEMIS Data

The stand-alone database can use data from the FEMIS database located on the server using export files it generates. This allows you to use current data or specify a time when certain data you wish to use was in the database but may have been archived. After a stand-alone database has been created, you can use this section to either make the stand-alone current using the latest exports generated by the server or use older FEMIS v1.4.7 database exports to review older data.

#### 6.4.1 Removing Database Data Owners

Complete this step only if you previously imported data into the stand-alone database.

1. Click on Start → Programs → Command Prompt. The Command Prompt window will display.

2. Change directories to the stand-alone working directory you created.

   \[ cd c:\oracle\standalone<enter> \]

3. At the command prompt, enter sqlplus -s system/<password> @dropusers.sql

   This script will take several minutes to complete.
6.4.2 Obtaining FEMIS Database Export

The data needed to create a FEMIS database on the PC is located on the FEMIS server where your EOC’s database resides. You will need to know the password for the oracle account on the server to complete this step. To obtain a FEMIS database export file, complete the following steps:

1. Click on Start → Run. Enter telnet <femis server>.
2. Enter oracle at the login prompt, and press Enter.
3. Enter the oracle user password for the FEMIS server at the password prompt.
4. Enter cd $ORACLE_EXPORT.
5. Enter the command pwd to display your current path and note this for later use.
6. Enter the command ls -l to list the files in the current directory.
7. Determine the FEMIS database export file you wish to use for the database. If you want the most current data, use the file with the latest date.

   Note: The database exports are created nightly by Oracle provided the cron jobs have been enabled. These files remain on the system until the oracle cron deletes the older files. If you wish to use older database exports than those that are present, you will need to restore them from tape backup. The export files are created and named system_<fi#_date>.dmp and then compressed adding the .Z extension on the end. You can verify the export was created successfully by viewing the .log file with the same name.

8. Enter uncompress <export_file.Z> to uncompress the file. This will take a few minutes depending on the size of the export file. The export file will no longer have the .Z extension after it is uncompressed.
9. Enter ls –l to see the size of the export file you have uncompressed.
10. Go back to the PC, and click on Start→Programs→Command Prompt. The Command Prompt window will display.
11. CD to the stand-alone working directory you created (usually C:\ORACLE\STANDALONE).
12. Enter ftp <femis server>.
13. Logon using the oracle user and password.
14. Enter cd <export path>. This is the path you observed from the pwd command in Step 8.

15. Enter bin to establish binary mode.

16. Enter get system_<fi#_date>.dmp. This will take a few minutes depending on size of export file and the speed of your network.

17. Enter quit to return the command prompt after the ftp has successfully finished.

18. Return to the telnet <femis server> window initiated earlier in this section.

19. Enter compress system_<fi#_date>.dmp. This will take a few minutes.

20. Enter exit to close the telnet window when the prompt returns.

6.4.3 Importing FEMIS Data into the Database

To import the FEMIS data into the database, complete the following steps. During the execution of the scripts, ignore the import message “IMP-00015: following statement failed because the object already exists:”.

In the command prompt window, you should be located in the stand-alone working directory (usually C:\ORACLE\STANDALONE).

1. Enter the following at the command line:

   imp system/<password> file=system_<fi#_date>.dmp inctype=system full=y log=system_import.log

   The database configuration assistant assigns the system password to manager. Use this password for your first import. This first import will overwrite the system and sys passwords with the passwords as they exist in the database on the FEMIS server. You should obtain these passwords from the System or Database Administrator to use in further imports.

2. Enter the following at the command line:

   imp system/<password> file=system_<fi#_date>.dmp inctype=restore full=y log=restore_import.log

   This import will take considerably longer than the first import.

   The replication jobs imported from the FEMIS database need to be removed to prevent accidental replication of data from the stand-alone system to the CSEPP site operational servers.

3. Enter the following at the command line:

   sqlplus –s system/<password> @delete_rep_jobs.sql
Note: It is essential that the delete_rep_jobs.sql script runs successfully. If not, the database could potentially try to replicate data with the FEMIS servers at other EOCs or depot.

6.5 Configuring FEMIS Installation for Stand-Alone Database

When FEMIS was installed from the server, your system was configured for connecting to the server. The following procedure describes the changes needed for FEMIS to run in a stand-alone mode.

6.5.1 Creating a Local USER Share

To create a local user share, complete the following steps:

1. Open the Windows Explorer as Administrator.

2. Create a directory %FEMISTOPDIR%\USER, if it does not already exist. By default this is C:\FEMIS\USER, but the actual location will depend upon where FEMIS was installed.

3. Right-click on this directory with your mouse, and select Sharing… from the menu that appears.

4. Select the Shared As: radio button. The Share Name field should have a default value of USER. Do not change the default value.

5. Click the OK button.

6.5.2 Editing SETSTANDALONE.BAT

The SETSTANDALONE.BAT file needs to be edited so that it can redirect the Oracle Data Source Names (DSNs) for each EOC to the stand-alone database residing on the local PC.

1. Open %FEMISTOPDIR%\SETSTANDALONE.BAT using a text editor, such as Notepad, to edit the file.

2. Add calls to ADDODBC.VBS after the line stating “Add calls here:” as documented in the file. You need one such call for each EOC you plan to log into using the stand-alone database. You may want to add a call for each EOC at your site.

3. Save the file and exit.

6.5.3 Running SETSTANDALONE.BAT and SETNETWORKED.BAT

Once it has been configured, the SETSTANDALONE.BAT script file will configure your PC to run FEMIS in stand-alone mode. The configuration changes made to your PC are
• changes the Oracle DSNs to point to the local database listener.

• connects the M:\ drive to the USER share on the local PC.

Note: If you do not have a Network card installed on the PC, you may not be able to map drives even to the local machine. If this occurs, you will need to manually modify your FEMIS.INI and change all references to M:\ to the path of your shared USER directory i.e., C:\FEMIS\USER. You may want to save your old FEMIS.INI to use when a network card is reinstalled.

• sets the RunAsStandAlone entry in the [Notification Service] section of FEMIS.INI to TRUE. This will cause the FEMIS Notification Service to run in stand-alone mode.

Run the SETNETWORKED.BAT script to return a PC to the standard, networked configuration. Running SETNETWORKED.BAT will

• run the FEMIS startup script (%WINDIR%\SYSTEM32\REPL\IMPORT\SCRIPTS\ FSTARTUP.EXE) to reconnect the M:\ drive to the USER share on the FEMIS server, and run the FEMIS update tool (FUPDATE.BAT).

• run the M:\ADDODBC.BAT file to set the Oracle DSNs to connect to the networked database.

• set the RunAsStandAlone entry in the [Notification Service] section of FEMIS.INI to FALSE. This will cause the FEMIS Notification Service to run in networked mode.

Note: If you are going to be changing a PC’s configuration between networked and stand-alone mode, the TNSNAMES.ORA file must be configured for the listener installed on the local PC and the listeners on the networked FEMIS servers. Use the Net8 Assistant to modify this file by adding Service Names for your local configuration using the following parameters:

Net Service Name – fi#.world
Protocol – TCP/IP
Host Name – FEMIS server
Port Number – 1521
(Oracle8i) Service Name – fi#

6.5.4 Correcting D2PC DOS Environment

When the network cable is disconnected from the PC, D2PC cases may take considerably longer to load. To correct this, the DOS environment needs modified for the D2PC.PIF so it will run correctly.

1. Use Windows Explorer to browse to the WINNT\SYSTEM32 directory.
2. Edit the AUTOEXEC.NT file using text editor, such as Notepad, and change the line.

   lh %SystemRoot%/system32/dosx

   to

   REM lh %SystemRoot%/system32/dosx

3. Click on File → Save As, and enter AUTOEXD2.NT for File Name. Click Save, and then close the text editor (Notepad).

4. Browse to the directory where FEMIS is installed. Right click on the D2PC.pif and click Properties (D2PC.pif will have a DOS shortcut icon and may not show the .pif extension).

5. Click on the Windows NT PIF Settings button in the Program folder.

6. Modify the Autoexec filename to point to %SystemRoot%/SYSTEM32/AUTOEXD2.NT. Click OK, and close the D2PC.pif Properties window.

### 6.5.5 Testing the Setup

You should test the stand-alone system by shutting the PC down and removing the system from your network. After restarting the PC, check to see if you can start FEMIS. Data on this PC is completely separate and different from a PC running FEMIS that connects to the operational database at your EOC.

If your system is not connected to the network, and you have Remote Access Service (RAS) installed, you might receive a Dial-Up Networking prompt if Auto-Dial is enabled (It is enabled by default.). See Section 6.6, Remote Access Service, for instructions on disabling Auto-Dial.

### 6.6 Remote Access Service

If you have Remote Access Service (RAS) installed on the PC (used with Remote Evacuee Registration [RER]), you may be prompted to use Dial-Up Networking whenever you attempt to connect to the local database. If you receive this prompt, you can disable this Auto-Dial feature by choosing the following options:

1. Select Yes, Dial when the Dial-Up Networking window displays.

2. Click OK to add an entry, and in the Phonebook entry wizard, click Cancel if you received a prompt that your Phonebook is empty.

4. Select Yes to disable the Auto-Dial feature when you receive the following message: Auto-Dial attempt failed. Do you want to disable auto-dial from this location?

You can turn this feature off before attempting to install the stand-alone database by doing the following:

1. Select an entry to dial from the Phonebook list in Dial-Up Networking.
2. Click on More, and select User Preferences.
3. Clear each location listed in the Enable Auto-Dial by location list on the Dialing tab.
4. Turn on Auto-Dial by reselecting a location in the Enable Auto-Dial by location list.

### 6.7 Verifying the Stand-Alone Installation

To verify that the stand-alone installation is complete and that FEMIS is fully operational, see Section 4.7, Validating the FEMIS PC Installation. The FEMIS PC Validation Checklist (at the end of Section 4.7) includes items that need to be checked to ensure that FEMIS is operating properly.

Because this is a stand-alone installation, the following items on the checklist **do not need to be verified**:

<table>
<thead>
<tr>
<th>One Time at Each EOC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Verify the Evacuation Command Server</td>
</tr>
<tr>
<td>3 Only on the server with the depot database, verify FEMIS/EMIS Data Exchange Interface (DEI)</td>
</tr>
<tr>
<td>6 Verify E-mail</td>
</tr>
<tr>
<td>7 Verify SEPR Icon Addressee</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Perform on Every PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>13 Verify Evacuation</td>
</tr>
<tr>
<td>14 Verify Electronic Planning (Planning Mode)</td>
</tr>
<tr>
<td>17 Verify E-mail</td>
</tr>
<tr>
<td>18 Verify SEPR Icon Addressee</td>
</tr>
<tr>
<td>20 Verify FEMIS Tools on Appropriate PC(s)</td>
</tr>
</tbody>
</table>

If you have a display problem with the D2PC window (cannot see the Edit/View and Close buttons at the bottom of the D2PC window), you will need to change your system display fonts. Click Start → Settings → Control Panel → Display → Settings tab, and change the Font Size field to Small Fonts. Reboot the PC to activate this change.